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Glpi

You’ll find here user documentation for various GLPI plugins.

TUTORIALS 1
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2 TUTORIALS



CHAPTER
ONE

PRESENTATION

Plugins are a way to extend GLPI possibilities without modifying core source code. In a perfect world, plugins should
provided specific features; while core’s may provided features everyone (or almost!) mays find usefull.

Some of the existing plugins are very complex, other are very simple. Some may require you to read their documentation
before using, some does not... Some may provide you configuration possibilities, acces rights management, and so
on.... Or not! There are so many plugins already!

If you’re looking for a feature that does not exists yet in GLPI’s core, take a look at the plugins repository. You can
search for a plugin name or a feature, see what core’s versions are compatible, and so on.

The goal of the present documentation is to centralize documentations, but we cannot pretend all plugins documenta-
tions are hosted here.

Anyways, happy GLPI-ing!



http://glpi-project.org
http://plugins.glpi-project.org/
http://creativecommons.org/licenses/by-nc-nd/4.0/
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4 Chapter 1. Presentation



CHAPTER
TWO

EMPTY

Download  Sources

not relevant  https://github.com/pluginsGLPI/empty

This plugins does... nothing. Really!

This is designed to be a start point for writing plugins, with very minimal defaults usefull scripts, and some advices. If
you’re looking for plugins possibilities, take a look at the example plugin.

2.1 Create a new plugin

An utility script to create a new plugin - plugin. sh is provided. You will call it with a plugin name, a version, an
optionally the path where your want it to be created:

[$ ./plugin.sh MyGreatPlugin 0.0.1 ]

The script will sanityze and lowercase the name you provided, copy the templates files into the new directory, and then
make some replacements.

Using the script without destination parameter, it will create you directory plugin, mygreatplugin just beside its own
directory. Otherwise, it would create the new directory in the specified path:

[$ ./plugin.sh MyGreatPlugin 0.0.1 /path/to/glpi/plugins/ ]

2.2 Update existing plugin

There is no automated way to update an existing plugin, because there would be too many cases to handle. But don’t
worry, procedure is quite simple ;)

Using empty features is as simple as creating a few files:
* composer. json,
e .travis.yml,
¢ Robofile.php,
e .gitignore.

If you do not have yet any composer or travis configuration file, you can just copy the ones from empty plugin. Other-
wise; in you composer. json, just add:



https://github.com/pluginsGLPI/empty
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{
"minimum-stability": "dev",
"prefer-stable": true

}

And then run composer require glpi-project/tools.

In the travis configuration file, just add the CS call:

script:
- vendor/bin/robo --no-interaction code:cs

In the .gitignore file, add the following:

dist/
vendor/
.gh_token
*.min.*

As for the Robo.li configuration file, note that the one embed in the empty plugin is a bit specific, you’ll have to edit it
in order to get things working. See below for more informations.

Finally, as the tools project will provide you some features, you can remove duplicated tools scripts (files such as
release, extract_template.sh, ...) that would be present in your plugin.

2.3 Features

2.3.1 Coding standards

The GLPI PHPCodeSniffer rulesets are provided as vendor/glpi-project/coding-standard/GlpiStandard/.

To check coding standards, just use the Robo.li task code:cs:

[$ ./vendor/bin/robo code:cs

Note: The above command will ignore vendor and run on the current directory.

If you want to adapt ignore list or checked directories, you can just override $csignore and/or $csfiles in the
RoboFile.php of the plugin:

<?php

class RoboFile extends Glpi\Tools\RoboFile

{
protected $csignore = ['/vendor/', '/lib/'];
protected $csfiles = ['./', 'setup.php.tpl']
[...]

}

6 Chapter 2. Empty
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2.3.2 Automated checks

For convenience; a . travis.yml file is also provided, that is setup to:
* check coding standards,
* run on a bunch on different configuration
You still have to enable travis-ci builds from the website in order to activate automated tests.

Of course, the . travis.yml file can be pimped; you can run unit tests, create/update a database, activate notifications,
and so on. Refer to the Travis-CI documentation to know more.

2.3.3 Minifying CSS and JS

Warning: Disabled as of 0.1.13, because libs used from Robo are out of date and connot be replaced.

A convenient script, using Robo.li is provided. The RoboFile.php file is an empty class that extends G1pi\Tools\
RoboFile (provided by glpi-project/tools dependency) in which you can set your own stuff.

That way, you can quite easily update the common file and get your own tasks remaining the same.

To get the required libs installed, you’ll have to get composer installed and then run:

[$ composer install -o

There are three available targets:
e minify that will minify all CSS and JS files (see below),

* minify:css that will minify all css stylesheets files in the css directory of your plugin, creating a .min.css
version along with the original file,

e minify:js that will minify all javascript files in the js directory of your plugin, creating a .min. js version
along with the original file.

Just choose a target, and run something like:

[$ ./vendor/bin/robo minify:css

Note: Remember compiled files should not be commited on your repository sources. It is a release process to minify
files.

Also remember to adapt your scripts so they load your minified versions if available, and the original one otherwise :)

As of GLPI 9.2; you do not have to care about loading minified files when using add_css and add_javascript
hooks! You just need to call not minified script; and GLPI will use the minified version if it exists and if not in DEBUG
mode.

2.3. Features 7


https://docs.travis-ci.com/
http://robo.li
http://getcomposer.org
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2.3.4 Translations

GLPI and its plugins use gettext for internationnalization. Several steps are required before that can work:

1 translatable strings must be extracted from source files, a POT file will be created or updated accordingly, 2 PO files
must be created or updated from the POT file, 3 PO files must be translated, 4 MO files must be compiled from the latest
PO.

In the vendor/bin directory, you’ll find a extract_template.sh script. This is designed to extract translatable
strings from your source code (see first point above).

Once it has been ran, a locale/mygreatplugin.pot file will be created/updated.

For the second and third step, you’ll have to make a choice. You can use gettext tools to update your PO files and
translate them using a dedicated tool, like poedit; or you can use an online translation system like Transifex or Zanata.
GLPI core and many of existing plugins are translated using Transifex right now.

Once you get your updated PO files, you’ll have to compile them to MO files. You can run it manually, the release script
will compile them again anywways; see the compiling MO files section.

2.3.5 Release script

A release script is provided in vendor/bin/plugin-release. This is a “simple” Python script; you should just have
Python installed on your system (this is installed by default on most linux distributions).

Warning: Note that the release script is only compatible if you use semantic versionning!

Using just the defaults, the script will try to retrieve the latest tag in your git repository, add third party dependencies
and create a Release on the github project:

$ ./vendor/bin/plugin-release

Do you want to build version 1.9.57 [Yes/no] y
Building glpi-order-1.9.5...

Archiving GIT tag 1.9.5

Adding vendor libraries

$ 1s dist

glpi-order-1.9.5.tar.bz2 glpi-order-1.9.5.tar.bz2.asc

Requirements

You will need a python interpreter installed as well as the following modules:
¢ termcolor,
e gitdb,

 github (to check for existing versions in also in drafts, and to create github releases), unless you use the
--nogithub option

If you want to get help on the script, try to run . /vendor/bin/plugin-release -h.

8 Chapter 2. Empty



https://poedit.net/
http://transifex.com/
http://zanata.org/
http://python.org
https://pypi.python.org/pypi/termcolor
https://github.com/gitpython-developers/gitdb
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Process

The release process will achieve the following tasks for you:
¢ check if the version constant is the same as the tag you’ve requested;
* check if the version in the website XML file is the same as the tag you’ve requested;

* check if a release already exists, locally, and remotely (assuming your project is hosted in the pluginsGLPI
organization and the release is public);

* make a git archive of the paths that are not excluded (.git, tools, tests,...);
« if any, install composer dependencies;

« if any, compile you MO files;

« if any, compile you CSS stylesheets and your Javascript files (using Robo.li);

* create a release archive with all that; that will be available in the dist directory;

* use GPG to sign the archive.

Note: The standard release process will not work on your files directly, it will make a copy in the dist/src directory
before. The only exception is the MO compiling option.

In order to check if all is OK before doing real release; create your tag and run ./vendor/bin/plugin-release
-C before pushing your tag. That way, you’ll be able to fix potential issues and re-create your tag locally (remember
published tags should never be removed).

Compiling MO files

The release process will automatically compile every PO file it will found in your locales directory. But you probably
want the sources to contain the latests MO files, for testing purposes. The release script provide the --compile-mo (or
-m) to achieve that:

[$ ./vendor/bin/plugin-release --compile-mo

Warning: The above command will work on your plugins files directly; not on a copy as does other commands.

Pre-releases
Per default, the release script will work only on existing tags. Any pre-release should have its own tag; but you may
want to create a release archive without any tags in some circumstances.
In order to tell the release script what it should archive, you’ll have to specify several parameters:
e ——commit (or -c) giving the commit hash,
e --release (or -r) giving the release version (usually, it will be the next release version),
e --extra (or -e) to specify an extra string (such as alpha, beta, rcl, etc...)

As an example with the order plugin:

2.3. Features 9
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$ ./vendor/bin/plugin-release --commit 632d515d4ac® --release 1.9.5 --extra alphal
$ 1s dist
glpi-order-1.9.5-alphal-20161103-632d515d4a.tar.bz2

Signing releases

Signing releases with a GPG key would permit users to check download integrity before installing. You’ll need a GPG
key publically available to users; the sign option is activated per default, you can deactivate using the --nosign (or
-S) option.

A file containing the signature with the same name as the archive with a .asc extension will be created in the dist
directory.

GitHub release

The release script will create a release on your GitHub repository, as a draft, unless you use --nogithub (or -g) option.

Note: Unfortunately, I was not able to get the newly created archive uploaded to this new release... Maybe that could
be fixed in the future.

In order to use this feature, you will need the github installed; and you will need an access token. Access token is valid
per user, and gives accesss to all his repositories.

You’ll have to go to your github account settings page, in the personnal access token tab. Click on generate new token,
give the description you want, and make sure you’ll check the public_repo box only (no need to check anything else,
you can create several access token if you need).

The token will be displayed only once; store it in the . gh_token file in your plugin directory; and that’s all!
Excluding files

You can create a .ignore-release file at the root of your plugin and list here files and directories you want to
explicitely exclude from the release archive. Write one expression per line

.+\.png
screenshots/

Some files will automatically be excluded:
o .git¥,
e .gh_token
o tx/
* tools/
* tests/
e .atoum.php
e .travis.yml
* _circleci/

e .ignore-release

10 Chapter 2. Empty
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» composer.lock

* Robofile.php

2.3. Features

11


http://creativecommons.org/licenses/by-nc-nd/4.0/

GLPI plugins Documentation

12 Chapter 2. Empty



CHAPTER
THREE

EXAMPLE

Download  Sources

not relevant  https://github.com/pluginsGLPI/example

An example plugin... This is designed to show you various possibilities that are offered to plugins from GLPI core.

As this plugin does nothing in reality, there is no documentation for it. You would like to refer to plugins presentation,
plugins developer manual or even empty plugin to get started.

@) ev-ric-ro |
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CHAPTER
FOUR

CENTREON

Download Sources

https://github.com/pluginsGLPI/centreon/releases  https://github.com/pluginsGLPI/centreon

4.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

4.2 Features

Centreon is a network, system, applicative supervision and monitoring tool. Centreon plugin allows you to see general
information about hosts and their services on your GLPI interface, as long as the items are both in GLPI and Centreon.

You can perform 3 main actions :
* Acknowledge a problem
* Schedule a downtime
e Trigger a host check,

and you can also see the timeline of the host.

15
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4.3 Installation

* Uncompress the archive
* Move the centreon folder to <GLPI_ROOT>/plugins directory

» Navigate to the Configuration > Plugins page,

Install and activate the plugin.

4.4 Usage

You need to configure the plugin before using it. To do so, go to the Setup > Plugins > Centreon page. You will need
to fill the following fields :

* Centreon URL : The URL of your Centreon interface, following by the number of the port, and the API version
to use

* Centreon Username : The username of your Centreon account

¢ Centreon Password : The password of your Centreon account

G L P I © Home / @ Setup / 1 General o | [EiEsmcnnis

=> Find menu General setup

Centreon APl URL

Assets < Default values

https://youruritocentreon.com:443/centreon/api/v22.10/
Assistance Assets

Centreon username
Management Assistance

username
Tools Management

Administration Logs purge Centreon password

Setup System

© Dropdowns Security

< Components Performance s
L Notifications API

© Service levels

Impact analysis

# General GLPI Network ® CONNECTION OK

@ Fields unicity — == You are connected to Centreon API !
& Automatic actions Centreon settings

€ Authentication Debug

B Receivers -

Then, it will create automatically a new SQL table named glpi_plugin_centreon_hosts. This table will contain
all the hosts that are both in GLPI and Centreon. A new tab is created on the host page, so you can see the information
about the host.

16 Chapter 4. Centreon
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2 Computer - ~glpi < RooT n
Computer
Host Information €  Scneck  @oountime
Impact analysis
Operating systems General
Components omatus ame auns raon fp—— ekt eck p—
Vokanes E 0357-glpi —glpi.privatel glpi- ~glpi.privatel.glpi- 2023-12- 2023-12- 2457
network.cloud network.cloud 11714:56:21+01:00 11T15:01:21+01:00
Software
Services  Timeline
Connections
Network ports
Services OO O
Sockets
Remote management
e 0K mysql-mariadb 0K  cpu oK cron
. OK: Mumber of current processes rumning: 1 B OK: 4 CPU(s) average usage 1s 27.50 % 10 7m OK: Number of current processes running: 1 ™
Documents
Vituaization oK disklo Ok Espace disque 0K fail2ban
dntiices OK: ALl devices [Read I/0 : 2.21 KB/s, Write I/0 3w 6d OK: A1l storages are ok oM 3u OK: Number of current processes running: 1 ™ 2d
125.76 KB/s, Read IOPs : @.56, Write IOPs : 10.82]
Knowledge base - Server overall [R+ I/0 : 127.97 KB/s, R+d IOPs :
10:50] 5 ATL devicesinreiok
Tickets
Problems
OK Ipi-agent OK  memor OK  snmj
Changes glpi-ag Y P
o A OK: Number of current processes running: 1 M OK: Ram Total: 14,30 GB Used (-buffers/cache): 6.79 7N 24 OK: Mumber of current processes running: 1 m a2
= g computer - Il-gi0i & RooT n
Computer
Host Information €  ©chesk  @oowntime
Impact analysis
Operating systems General
Components s ane s raon casT e r— ——
Volsnes i 0357-glpi ~glpi.privateT.glpi- 2023-12- 2023-12- 24x7
network.cloud network.cloud 11T14:56:21+01:00 11715:01:21+01:00
Software
Services Timeline
Connections
Network ports Timeline
Sockets
Remote management
81964 Friday,November 24,2023 9:01:23 N ~glpi.privatel.gipi-network cloud: rta 5.367ms, lost 0% up 1
Management
78245 Tuesday,November 14,2023 2:00:58 2 ~glpi.privatel.glpi-network.cloud: rta 10.936ms, lost 0% up 3
Contracts.
78167 Tuesday,November 14,2023 2:00:08 CRITICAL - -glpi.privatel.glpi-network.cloud: rta nan, lost 100% DOWN 2
Documents
77943 Tuesday,November 14,2023 1:59:08 CRITICAL - 1-glpi.privatel.gipi-network.cloud: rta nan, lost 100% DOWN 1

Virtualization
Antiviruses
Knowledge base

Tickets

Problems
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CHAPTER
FIVE

CREDIT

Download Sources

https://github.com/pluginsGLPI/credit/releases  https://github.com/pluginsGLPI/credit

5.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

5.2 Install the plugin

* Go to the marketplace. Download and install the plugin “Credit”.

Credit ©

This plugin allows you to declare =
and follow (by entity) the

consumptions of different credit
vouchers directly from the Ticket

form.

£ cPLv3
& i T A TECLIB'
13 1131
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5.3 Setting up the plugin

5.3.1 Creating a credit type

¢ From Setup > Dropdowns,

¢ click on Credits then Credit types.

Credit vouchers P

©

8 Credit vouchers types

¢ Click on add.

 Enter a name representing the type of credit granted

a4 B

-
COMPLETE NAME ENTITY

Client1 Entité racine
Client1 > Followup Entité racine
Client1 > Solution Entité racine

Client1 > Task Entité racine

20 rows [ page Showing 1to 4 of 4 rows

5.3.2 Add credit to customer entity(ies)

Example : We will create 3 types of credit:
* For a new follow-up
* For a new task
* For a new solution

You can create a single type of credit which will group together the 3, it depends on the management of
each case.

* In Administration > Entities, select the entity that will receive the credits.
* Go to the Credit section

¢ In the section Add a credit, enter a name for the new credit

* Define the type of credit created earlier

¢ The start and end dates of the credit

e Activate it,

20 Chapter 5. Credit
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* Make it available or not in the child entities (note that if you are in the parent entity, it will be accessible to all

entities)
* The quantity of credit sold

¢ The authorisation to overconsume or not

* Click on add
« < @ < Entity - Client 1 i Actions v 212 > »
Entity
Default options for entity
Entities
Address By default consume a voucher for followups No ~ By default consume a voucher for tasks No By default consume a voucher for solutions No ~
Advanced information Default for followups e - Default fortasks Default for solutons - -
Notifications Update
Assistance
Assets Add a credit voucher

Ul customization Name* New Followup

Users 4

Active  Yes ~ Child entities | Yes ~

Quantity sold 10 ~

Allow overconsumption  No

Type | Clientl > Followup v i+

Start date 01-12-2023

Enddate 31-12-2023

Rules 1
Documents

Notes

Knowledge base
Historical 2

Credit vouchers

All

No credit voucher

Here, we’ll do the same for the 3 types of credit (followup, task and solution)

It is therefore possible to enter different values (number of credits, validity, overconsumption, etc.) for each credit:

Name Type

New solution Client1 > Solution

Client1 > Task

New task

New Followup Client1 > Followup

Active Startdate

Yes

Yes

01-08-2023

01-11-2023

01-12-2023

End date

31-12-2023

31-12-2023

31-12-2023

Quantity Quantity

sold

15

5

0

Child
entities

Quantity Allow q
- . Entity
consumed remaining overconsumption
Entité
racine
15 No > Yes
Client
1

Entité
racine

5 No > Yes
Client
1

Entité
racine

10 No > Yes
Client
1

5.3.3 Define default values

* In Administration > Entities, select the entity that will receive the credits

* Go to the Credit section
* In the Default options for entity section

* Select the type of credit by action

Click on Update

5.3. Setting up the plugin
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Default options for entity
By default consume a voucher for followups Yes By default consume a voucher for tasks Yes ~ By default consume a voucher for solutions Yes

Default for followups New Followup ~ Default for tasks New task ~ Default for solutions. New Followup ~

Update

Warning: “Caution Indicating credit types does not allow automatic settlement. It pre-selects the credit but it
must be settled by the technician.

5.4 Counting credits

When a ticket is created, you can choose whether or not to deduct the corresponding credits.
In our example, we have chosen to deduct each action.

* If we are doing a follow-up, we can deduct the credit assigned by default:

* The same for a task:

* And for a solution :

In the Credit section of the ticket you can see a summary of credits spent and remaining

5.5 Modify a credit on a ticket

5.5.1 Increase or decrease a granted credit

You can modify credits on a ticket if a readjustment is necessary.
* From the ticket in question, go to the credit section
¢ Select the credit you wish to adjust
* Click on Actions
¢ Click on Update
¢ Click on Quantity consumed then add the desired quantity
¢ Click on Send

Note:

See how to proceed
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Paragraph v B T A v 2~ sss

Hello Joe,

your reguest has been processed and we will get back to you as soon
as possible to carry out an intervention on your workstation.

Best regards

Your IT Team|

File(s) (20 Mio max) 1
Drag and drop your file here, or

Choisir des fichiers Aucun fichier n'a été sélectionné

Credit vouchers
Consume a voucher ?

Yes
Voucher name

New Followup

Quantity consumed

T

+ Add

X
] + i *T
(=] .desk~ 1 T
i}
v 1

5.5. Modify a credit on a ticket

23



GLPI plugins Documentation

Credit vouchers
Consume a voucher ?

Yes -

Paragraph e

Chaoisir des fichiers

Voucher name
MNew task
Quantity consumed

1+«

+ Add

B I A

I

Intervention at John's workstation

File(s) (20 Mio max) i

Drag and drop your file here, or

Aucun fichier na été sélectionng

X
] ————— . i *+
=
‘ - w 1 +
= Todo ~
&
i
(] S =
&  Admin - |
st ——— v | i+
St g 19.202310:55:0
date
Period
1h00 ~
::
Remin
MNone -
der
« i
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Paragraph

John,

Your incident is now resolved
You can recpen y\}\!_% ticket if you need to

Best regards

Your IT Team
WAAAS

Aucun fichier n'a été sélectionné

5.5. Modify a credit on a ticket
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Consumed credits for this ticket

Voucher name Voucher type Date consumed User Q
New Followup Client1 > Followup 08-12-2023 Admin 1
New task Client1 > Task 08-12-2023 Admin 1
New Followup Client1 > Followup 08-12-2023 Admin 1

Voucher name Voucher type Date consumed User Q

Active credit vouchers for ticket entity

uantit uantit uantit Allow Child
Name Type Active Startdate End date o vy Q ol " o N .y R Entity ..
g over entities
Entité
i i racine
New solution Client1 > Solution Yes 01-08-2023 31-12-2023 15 15 No N Yes
Client 1
Entité
racine
New task Client1 > Task Yes 01-11-2023 31-12-2023 5 1 4 No S Yes
Client1
Entité
racine
New Followup Client1 > Followup Yes 01-12-2023 31-12-2023 10 2 8 No N Yes
Client 1

5.5.2 Delete deducted credits

* From the ticket in question, go to the Credit section
¢ Select the credit you wish to delete

* Click on Actions

* Click on Delete permanently

¢ Click on Send

Note:

See how to proceed

Credits will be automatically reallocated in the credit bank

5.6 Including an expired credit

If the credit has expired, it will not be proposed in the list of available credits. You will not be able to deduct it. You
will need to change the end date of the credit to be able to use it again.
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5.7 Notification of expired credits

An automatic action is available to notify you when a credit has expired.

* From Setup > Automatic actions, modify the creditexpired action to suit your needs.

¢ Click on Save

B & Automatic action - creditexpired
Automatic action
Name
Statistics Deseription
Logs 39

Run frequency
Historical 1

Status
All
Run mode
Run period

Number of days this action logs are stored

Notice (in days)

Credit - creditexpired

Expiration date

Each day ~

Scheduled ~

CLl~

Ov > 24~

30 ~

i Actions v

Comments

Last run Never

Next run As soon as possible | Execute

1M

B save

You can of course customise the notification to suit your needs (Setup > Notifications > Notifications > credit expired)

5.8 FAQ

If you have any questions about using the plugin, please consult our FAQ

5.7. Notification of expired credits
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CHAPTER
SIX

DATAINJECTION

Download Sources

https://github.com/pluginsGLPI/datainjection/releases  https://github.com/pluginsGLPI/datainjection

6.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended

10.0.x 8.1 8.2
Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud
6.2 Plugin installation

* Go to the marketplace. Download and install the plugin Data Injection

. % Data Injection ©
*\  This plugin allows data import 2
into GLPI using CSV files.
ET GPL w2+
2\ Walid Nouh, Dévi Balpe, Remi Collet, Nel...
1% 2134
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6.3 Rights management

Once the plugin has been installed via the marketplace, you can configure rights according to profile:

* From Administration > Profiles, select the profile in question

* Go to Data injection

For each user profile, you can grant the following rights:

* Model management : Read / Update / Create / Purge

e Import file : Read

6.4 Configuration

You can find the plugin configuration at Tools > Data injection The extension is presented in the form of a wizard,
each operation is broken down into steps and it is possible to return to the previous step to correct a choice.

6.4.1 Managing or using a model

The first step allows you to choose the operation to be carried out, depending on your rights.

 Use an existing template in the drop-down menu

* Manage templates to :

Create a new template

Modify an existing template

Delete an existing template

Use an existing template

6.4.2 Creating a template

The first step is to create a template if none exists.

¢ From Tools > Data injection
* Click on Template
* Click on Add

2t Home / & Tools / B Data injection / X Injection of t... @

Use an existing model

No model currently available. You can start the model creation by hitting the button: Models

30
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Defining the model

This step allows you to define the main options for the extension:
e Name: the name that will be visible from the drop-down list
* Visibility: defines whether it will be visible to other users or not

» Entity and sub-entity: the template can be visible in the creation entity only (sub-entity set to no) or in the entity
and all sub-entity (sub-entity set to yes).

* Comment: a comment for the template.

* Type of data to import: the type of data present in the file to be imported. A file only consists of data of the
same type.

* Allow lines creation: tells the plugin to create objects if the line does not correspond to an existing element in
the database.

* Allow update rows: tells the plugin to modify existing objects using the data in the file.

* Header’s presence: tells the plugin whether the headings present in the file (location, type of equipment, models,
etc.) should be created. Creation will also be limited by the rights of the template user.

» Update existing fields: the extension whether the data in the file can replace fields already filled in.
* Date format: the date format is contained in the CSV file. If the format is incorrect, the date cannot be imported.

¢ Decimal number format: the format used for the numbers in the CSV file. If the format is incorrect, the numbers
cannot be imported.

After validation of the model, the following fields are added:

* Presence of a header: indicates whether the first line of the CSV file is a header line, so that you can see the
contents of the columns to identify the contents of the columns

* File delimiter: field separator (by default a semicolon)

File to be injected
* From the File to inject tab, you need to choose a file on your computer with exactly the same structure as the

data already imported.

¢ Then define the encoding (ISO8859-1 for Windows files, UTF-8 for Linux files. Automatic detection can be
used to determine the encoding, but will slow down file processing. We strongly recommend that you always
work in UTF-8.)

Once the file has been validated, you will be taken to the Mappings tab

Mappings

This stage is essential. It defines, for each column in the file, the corresponding field in the database. The columns are
identified by the content of the header line (presence defined in the previous step) or by their position (starting from 0).
A separator error (in the previous step) will result in an incorrect split. The View file button is used to preview the first
lines of the file and check their content and the interpretation made by the plugin.

For each column, you can choose
* Do not retrieve data from this column (leave the Choose a table option)

¢ Choose a table: the data type defined in step 2 or the financial information
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* Choose a field: which will be populated by the import

* Link field: to indicate that this column will be used to check the existence of the data in the database and to
choose between creating a new object or update. Candidate fields are, for example, the Serial number, the
Name or the Inventory number

Warning: It is mandatory to define at least 1 linking field. If a field is checked, it must be entered in your csv file
used for importing.

« <@ Model - Import PC o e [T : scions | 2 > »

Model See the file
File to inject Header of the file Tables Fields Link field
Mappings B
Name Computers v Name = (m]
Historical 2
Al Entity Computers » Child entities + (m]
Status Computers v Status (Status of items) + O
Manufacturer Computers ~ Manufacturer « (m]
Serial number Computers ~ Serial number ~
Type Computers ~ Type (Computer type) + (m]
Model Computers v Model (Computer model) « a
Operating System - Name Item operating systems Name (Operating system) =
Location Computers ~ Location ~ O
Components - Processor Computers » Processor ¥ a
Agent - Last contact e Choose a table--—---- -t | Choose a field------- v
User Computers » User « (]

Save

Note: It is possible to define Comments or Notes as the destination for several columns in the file. Each column
will be added to the field on a different line. This step is particularly important and a wrong choice could damage the
inventory data. It is therefore advisable to test the import on a test database or to and reserve this function for advanced
users.

6.4.3 Additional information
This step is used to define the fields that can/should be populated by the user when a file is injected. For each field, the
same value will be used for each line of the file and will take precedence over the contents of the file.
 Table: the data type defined in step Matching
¢ Field: will be populated by the import
* Mandatory information: whether model user input is mandatory or optional
Example of use :
* Purchase date when importing a delivery note

» Comments to define a criterion that can be used in the search engine (e.g. IMPORT ON 31/10)
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Model validation

From the Validation tab, you can confirm the registration. It is still possible to return to the previous steps to check and
correct certain options.

Model - Import PC < Rootentity ‘ i Actions v

Model
© Validation

File to inject
Validate the model
Mappings
Additional Information
Validation

Historical 2

Al

Warning: If you are working with a sub-entity, you must select the desired entity before importing.

Note: Some fields in your CSV file will need to be filled in as Booleans. This is the case, for example, with double-
choice fields, such as: “Ports” (serial/parallel/USB) for printers. Instead of entering Yes | No in your CSV, enter 1 | 0
as appropriate. If these values are not changed, you will see an error in the report indicating that the wrong type of data
has been entered.

6.5 Using a template

6.5.1 Choosing a template

* From Tools > Data injection, select the template you require from the drop-down list
* Then enter the path to the CSV file to be injected

¢ Specify the Encoding of the file if you know it. If not, leave on Automatic detection
¢ Click on Proceed with import

Confirmation before import

A popup will ask you to confirm or not the import of the selected file.

6.6 Import result

From this last stage, by clicking on the coloured circle, you can view a report on the import and, in particular, locate
any errors

6.5. Using a template 33



GLPI plugins Documentation

Use an existing model

Model Import PC

Complementary information (Choose a file)

Download file sample

File to inject
Choose a file Choisir un fichier | glpil.csv

File encoding Automatic detection «

Launch the import Cancel

Data injection report - GLPI - Profil 1 — Microsoft Edge

ne glpi-network.cloud

i Array of successful injections

Line Data Import Injection type Object Identifier
\../ 2 Data to insert are correct Update 150
i Global report Number of lines processed : 1
Data Import Injection type Counter
\/ Data to insert are correct Update 1
Close
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6.7 Complete the operation

A popup window will ask you whether or not you want to confirm the import of the selected file. Once the progress
bar is full, click on Finish

Model: Import PC

Import progress

Injection’s results

(Dinjection successful

€

Finish

6.8 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
SEVEN

ESCALADE

Download Sources

https://github.com/pluginsGLPI/escalade/releases  https://github.com/pluginsGLPI/escalade

7.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

7.2 Install the plugin

* Go to the marketplace. Download and install the plugin Escalade.

y Escalade ©
A This plugin simplifies the ticket 5

escalation to different groups Q
£ cPLv2+
2\ Alexandre Delaunay, TECLIB'
i+ 292
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7.3 Assign a ticket

Tip: Escalade vs business rules We advise you to use business rules to allocate tickets or escalations. This allows
you to manage more flexibly when changing category, urgency, etc.

Note: Escalade allows tickets to be escalated only to groups, and not to live users.

When the plugin is activated, a new option is available from the ticket interface :

(O Answer [ Task ~ Solution © Document oy Validation aF

7.4 Set plugin parameters

» From the plugin, click on the spanner and choose the various options that interest you:
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Action

Effect

Remove old assign group on new group assign

show group assign history visually

Assign ticket to initial group on solve ticket

Escalation history in tasks
Remove technician(s) on escalation

Ticket status can be changed after escalation

Assign the technical manager on ticket category

change

Assign the technical group on ticket category change

Clone tickets

Close cloned tickets at the same time

Use the technician’s group

Remove requester(s) on escalation

Display delete button

Activate filtering on allocation groups

Deletes or not the existing groups when you assign a new
one

(valid only if previous option is set to yes)
Previous groups will be visible when a new
group is escalated

Assigned to

&2 Technicien 2 L]

o3 .
4 M Groupe 1

(valid only if previous option is set to yes) Reassigns
ticket to initial group if a group is deleted

Keep or not the history of escalations in the tasks
Technician(s) will be deleted when a new technician is
added to the ticket

Modify the status of the ticket after the escalation. A “do
not modify” option is also available.

If a technical manager is declared in an ITIL category,
they will be automatically assigned and will receive a
notification.

If a technical group is declared for an ITIL category, it
will be automatically assigned and the members of the
group will receive a notification

Possibility of cloning tickets from the helpdesk interface
.. figure:: images/Escalade-4.png

Close all cloned tickets when one of them is closed

If a technician is assigned, their group will also be as-
signed. You can choose to take account of the assign-
ment when the ticket is created and/or modified. You
can also choose to select the first or last group to which
the user is assigned

Remove requester(s) in the event of an escalation. Please
note that no history is kept, as is the case for assigning a

group
Displays the option of deleting ac-
tors from the ticket (ability to re-

fine which user/group/supplier by re-
questor/watcher/technician)

2 Actors [E)) ~

Requester

®!C' Parigian Cleta & 1 +
Observer

®r::' lgor & 1 &
Assigned to

@F’- Joe A 1 *

Enables filtering and whether or not escalation to other
groups is possible. See next chapter for more informa-
tion

7.4, Set plugin parameters
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7.4.1 Setting up filtering

Filtering allows you to define which group is able to escalate tickets to other groups. For example, we don’t want N1

support to be able to escalate to N3 directly. The escalation to N2 must be mandatory.

* From Administration > Groups, select one of the groups

* In Escalade, add the groups to which this one will be able to escalate tickets.

Warning: This option can be useful, but it requires all groups to be set up. If, for example, the technician N1
group can escalate tickets to the technician N2 group, you need to ensure that the technician N2 group can escalate
tickets to the technician N3 group and also to the N1 group, so that a ticket can be escalated if necessary.

Example :

¢ Joe user is added to group Groupe 1

8 Userfuoe| ®m &

« < B8

User
Associate to a group

Authorizations

Groups. 1
s
Used items Group
=
Created tickets 1 T

roup

Problems (o)

Manager

Dynamic

Dynamic

No

Manager

Manager

Delegatee

No

i Actions v 1420 > »

Delegatee

Delegatee

* Groupe 1 is configured to allow ticket escalation only to Groupe 2

il

& < B

2\ Group - Groupe 1

Child groups

Group Escalade

Used items

Managed items

Users 1
Motifications

Created tickets
Problems
Changes

MNotes

Historical 1

Escalation

All

Add

* Joe user can only reassign ticket to Groupe 2 because it’s assign to Groupe 1
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Ticket
Statistics
Approvals
Knowledge

Items

Costs

Project tasks

Problems

ges

Created: © 3 minutes agoby A Admin  Lastupdate: @ 2 minutes agoby & Admin

Pb Printer

Not possible to print, error message not available

Croated: ® 2 minutes ago by & Admin a

Escalation o the group Groupe 1

Bloriy Medium M
Location | ---—- vimw

Approval Not subject to approval

2 Actors [B)

Requester
= 8 Parisian Cleta & 2 +
Observer
Assigned to
1 xR Groupe1 3 +

A BIOT Romain
2 Guern Amaury

& igor

& newtech newtech I

Root entity '

« For other users not assign to Groupe 1, they can’t reassign group to ticket (groups are not proposed

in the list of assignation)

Ticket
Statistics
Approvals
Knowledge base
Items

Costs.

Projects

Project tasks

Problems

Created: ® 01-02-2024 11:48by R Admin Last update: ® 01-02-2024 11:48by & Admin

Pb Printer

Not possible to print, error message not available

Created: © 01-02-2024 11:48 by & Admin 8

Escalation to the group Groupe 1.

Priority Medium =
Location | -—--—- . im

Approval  Not subject to approval

2 Actors [B)

Requester

x & Porisian Cleta & 2

Observer

Assigned to

x 8 Joc 4 M
A Charlotte
€ 8 Joe
9
9
9

Igor

* You can bypass this behavior per user

7.4. Set plugin parameters
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2 User - Charlotte = &
User .
Bypass filtering on the groups assignment

Authorizations 2
Update

Groups

Settings

Used items

Managed items

Created tickets 5

Problems

Changes

Documents

Reservations

Synchronization

Links

Certificates

Historical 2

Escalation

All

7.5 Ticket’s search engine

Plugin add three new search option

----- b Characteristics - Status a is v Mot solved -

Documents

Number of documents

I Actions Plugins

D TTL pumber of escalations

Number of escalations between two groups !

» Group concerning by escalation
Ex : get all tickets actually escalated to group Groupe 1

¢ Number of escalation
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Ex : get all tickets with more than ten escalation
* Number of escalation between two groups

Ex : get all tickets with more than 2 escalations between two groups

7.6 Central page

New dashlet to display ticket solved to close and assign to you group

Dashboard Personal View  Group View  Global View  RSSfeeds Forms = All

TICKETS TO CLOSE (ESCALATED) o
REQUESTER ASS0CIATED ELEMENT DESCRIPTION
ID: 8 Admin 1 General Pb printer (0 - 1)

New dashlet to display not solved ticket where your groups was not actually assign but was in the past

Dashboard Personal View  Group View  Global View RSSfeeds Forms A

TICKETS TO FOLLOW (ESCALATED) o

REQUESTER ASSOCIATED ELEMENT DESCRIPTION

1D: 97 General Pb with monitor (0 - 0)

7.7 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
EIGHT

FIELDS

Fields plugin allows to add additional fields on various items GLPI manages: tickets, computers, users, ...

Download Sources

https://github.com/pluginsGLPI/fields/releases  https://github.com/pluginsGLPI/fields

8.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

8.2 Features

¢ Add containers block on various items,

Add fields into blocks,

* Display blocks in an existing tab or in their own tab,
* Many fields types available,
* Fields can be flagged as required,

* Manage profiles ACLs per container,
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8.3 Install the Plugin

* Uncompress the archive.
* Move the fields directory to the <GLPI_ROOT>/plugins directory

» Navigate to the Configuration > Plugins page,

Install and activate the plugin.

8.4 Usage

The plugin will create required tables in the database and some files on disk (into <GLPI_ROOT>/files/_plugins/

fields) automatically. Those files and tables will be updated along with the plugin.
Plugin usage is quite simple:

¢ create a block linked with some items,

* create fields in this block.

You will access the plugin configuration from the Setup > Aditionnal fields menu.
8.4.1 Adding a new block

New item - Block

Label : Block as tab

% Assets - Computers
Type : Addtab Associated item type

» Administration - Users
Active : es

Add

Label: the label of the block that will appears on items forms,
* Type: type of display, one of:

— Add tab: will add a new tab on the item form containing the block,

— Insertion in the form: will add the block at the end of the main item form,

— Insertion in the form of a specific tab: will add the block at the end of a specific tab of the item.
* Associated item type: a list of items types on which the block will be added,

e Active: whether the block is active or not.

Note: You can add only one block of the type Insertion in the form for an associated item type.

Inserting a block in a specific tab is only possible for one item:
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Label :

Type :

Active

New item - Block
In a specific tab

...1in the form of a specific tab (before save button) +  Associated item type : Assets - Computers v

Tab: Operating System -

Add

Once a block have been created, it is possible to change its label or is active flag, but not its type or associated items

list.

Profiles

You can refine profiles access on the block using the Profiles tab from the block. You will be able to choose either No
access, Read or Write for every existing profile.

Self-Service

Observer

Admin

Super-Admin

Haotliner

Technician

Supervisor

Read-Only

Profiles

Write s

MNo access
Read

Write =

Write

Write

Write

Write «

Save

8.4. Usage
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8.4.2 Adding a new field

Mew item - Field

Label : A field in the block
Type Text (single ling) Default values :
Active ; Yes w Mandatory field : Yes
Read only : Mo v
Add
Add a new field

Mo field for this block

* Label: the label of the block that will appears on items forms,
* Type field type, one of:

Header: an header label, for visual distinction,

Text (single line): a single line (input/@type="text") of text,

Text (multiples lines): a multiline (textarea) text,
— Number: a single number (no text allowed),

Dropdown: a configurable dropdown list, values are configured from the main GLPI dropdown configura-
tion you can find in Setup > Dropdowns menu,

Yes/No: a dropdown list with only Yes and No values,

Date: a standalone date with a date picker,

Date & time: a date field with a date picker and a time dropdown field (step is configured from GLPI core),

Users: list of users.

e Active: whether the block is active or not,
* Read only: flag this field as read only,
* Default values: default field values,

* Mandatory field: flag this field as mandatory.

Warning: Of course, you will need to pay attention playing with the various options... For example, if you flag
a field as mandatory and as read only, and if you do not provide a default value, form validation will fail.

Another example: you should not set a text default value for a number field... That kind of things ;)

Once fields have been created, you can reorder or edit them from the Fields tab of the block:
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Label

A field in the block

Dioes this work?

Which date?

Make your choice

The user

An inactive field

Add a new field

Type Default values
Text (single line)
Yes/MNo
Date
Dropdown
Users

Text (multiples lines)

And see what it should look like on a User item for example:

User

Authorizations

Groups

Settings

Used items

Managed items

Created tickets

Problems

Changes

Documents

Reservations

Synchronization

External links

Historical

Block as tab

All

A field in the block : *
Which date? : [

Theuser:

Mandatory field

Yes

No

No

No

No

No

v | @

Save

Active

Yes

Yes

Yes

Yes

Yes

Does this work?

Make your choice ;

Read only

No

No

No

No

No

No

8.4. Usage
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8.5 Search

All fields that have been added are available in the attached items search forms.

8.6 Simplified Interface

Only blocks attached to tickets and with the type Insertion in the form will be displayed in the simplified interface of
ticket creation. Of course, it will also take care of current profile rights!

8.7 Translations

New in version 1.4.0.

Plugin itself is translated using the transifex services; but you aslo can translate the label values for blocs and fields;
the process is identical on both those ones:

On the block form, choose the Translations tab:

Block Add a new translation
Fields =
\ Actions
Profiles . .
List of translations
Translation 1)
Language Label
All
English My block

T Actions

AJAXDEBUG Display only tab for debug
On block creation, a new translation with current language and value set as label will be created; you can add as many
translations as you want.
New item - Translation

Language : Frangais w
Label Maon bloc

Add

Dropdown values can be translated using the core’s dropdown configuration.

Warning: As of GLPI 9.1.1; some issues on the core side prevent dropdown plugin values to be translated; the
possibility has been deactivated in the plugin. It will be enabled again once the core has been fixed.
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8.8 Entities

If you are using entities in your GLPI instance, a block will be displayed only if the entity it is attached to is compatible
with the one of the item it applies to.

When you create or edit a block in multi entities mode, you’ll have to choose if the block will be available in children
entities:

New item - Block Root entity Child entities Mo « (D

As an example, let’s say our entities have the following structure:
* root
- A
* C
-B

The following table will tell you in wich cases the block is displayed or not:

Block entity  Recursive block ltem entity Block displayed

A Yes or No A Yes
A Yes or No B No
A Yes C Yes
A No C No

8.9 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
NINE

FORM CREATOR

Download Sources

https://github.com/pluginsGLPI/formcreator/releases  https://github.com/pluginsGLPI/formcreator

FormCreator is a plugin which allow creation of custom forms of easy access.

9.1

Features

Direct access to forms self-service interface in main menu,

Highlighting forms in homepages,

Access to forms controlled: public access, identified user access, restricted access to some profiles,
Simple and customizable forms,

Forms organized by categories, entities and languages,

Questions of any type of presentation: Textareas, lists, LDAP, files, etc,

Questions organised in sections. Choice of the display order,

Possibility to display a question based on certain criteria (response to a further question),

A sharp control on responses from forms: text, numbers, size of fields, email, mandatory fields, regular expres-
sions, etc,

Creation of one or more tickets from form answers,

Adding a description per fields, per sections, per forms, entities or languages,
Formatting the ticket set: answers to questions displayed, tickets templates,
Preview form created directly in the configuration,

Translation of forms to serve them in several languages.

You can take an look to the full changelog from plugin sources.
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9.2 Install the Plugin

* Uncompress the archive.
* Move the formcreator directory to the <GLPI_ROOT>/plugins directory

» Navigate to the Configuration > Plugins page,

Install and activate the plugin.

Warning: The plugin’s directory must have the same name as the plugin:
* Good: glpi/plugins/formcreator
* Bad: glpi/plugins/formcreator-master
» Bad: glpi/plugins/formcreator-0.90-1.3.2

Only one directory must contains the plugin’s files of a single plugin in the GLPI plugins directory. Don’t rename
the plugin’s directory for backup, move it!

9.3 Service catalog

The service catalog is a replacement for the GLPI’s simplified interface.
It is enabled on a per entity basis and exists in two flavors

* simplified

* extended

To enable it, edit an entity, open the Forms tab and set the field Helpdesk mode to Service catalog simplified or Service
catalog extended. This setting handles inheritance from parent entity to children entities.

Users using the simplified interface will benefit a new interface allowing them to:
¢ browse forms and FAQ with the unified interface
* follow the process of their requests
* book assets
* view their feeds
Users using the extended interface have a more complete view on their requests.

Forms with Direct access on homepage enabled will appear in the interface. Users may search by browsing the cate-
gories on the left of the screen, and may also search for forms with a natural language search engine.

By default FAQ items in the Knowledge Base also show with forms. The only prerequisite is to associate form categories
to knowledge base categories (in Setup > Dropdowns : Forms > Form categories).

It is possible th have a distinct display of FAQ in Administration > Entities > Forms. When Distinct menu entry is
selected the service catalog shows a new menu entry on the left. FAQ are browsable by category and key words.

Note: All entity settings for Formcreator propagate to sub entities by default. The administrator may change the
settings in a sub entities to break inheritance.
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9.3.1 Overview
The service catalog shows several counters on the top left corner. Those counters show all requests involving the current
user as a author, requester, observer, assigned or validator.
The requests displayed here are
* tickets created without Formcreator
* tickets generated by forms havung only one target tickets
 form answers when the form has no target ticket
 form answers when the form has several target tickets
The request are spread over 4 counters
* processing
* pending
* to validate

e closed

Note: New requests are not included in the counters.

9.3.2 RSS feeds

When users are allowed to view RSS feds, the service catalog shows a menu entry on the left to access them. RSS feeds
administration is done in GLPI as usual.

9.3.3 Reservations

Users may book an asset with GLPI’s reservation system, avaialble in the left menu of the service catalog.

9.4 Forms configuration

9.4.1 Form creation

Note: The right to create forms is enabled to the profiles having the right to update entities in GLPI. Refer to the
documentation of GLPI to know how to setup this right.

Note: Forms must be created in the entities where they are intended to be available. A form may be available in its
entity and all sub entities if the field Child entities is set to Yes.

1. Navigate to Administration > Forms.
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@ Administration v {@ Setup ~ < Find menu

ADMINISTRATION

5 Users B. Profiles

22 Groups (5 Motification queue
= Entities B Logs

M Rules > Inventory

M Dictionaries # Forms

1. Click on the button to add a form +

Following fields must be populated:

Name: Name of the form.

Active: A form is inactive by default. You need to explicitly activate it when it is ready to use.

It is recommended to fill the Category field:

In the simplified interface, categories allow to tidy forms by Blocks.

If you want to use the service catalog you must use form categories.

Note:

Form categories are plugin’s dropdowns. You can add form categories directly when editing a form using the

+ next to category field. You can do the same from Configuration > Dropdowns > Form category.

Direct access on homepage: Direct access to the form from the GLPI’s simplified interface.
Description: displays in the list forms.

Language: by default a form is set to the language of its creator. The form will be available only to users using
the same language as the form. Choose All languages to make the form available to users without language
restriction.

Header: displays when the form is displayed.

Need to be validate: If Yes a list of validators is displayed. This is a list of GLPI users (with the right Validate an
incident or Validate a request (in its profile) on a compatible entity with the form’s entity. The list of validators
is a multiple choice list. If no validator is selected all of them are submitted when the form is being used.

Default form in service catalog: if Yes the form will display in the service catalog without being filtered by the
current category or keywords.

When all fields are filled, click on the add button at the bottom of the page.

Note:

Deleting a form is possible only if there are no associated answers. To delete a form, delete all its answers first

from the Form answers tab.
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9.4.2 Sections

After clicking on the tab Question the following page displays:
+ Add a section

You must create a first section. Sections are intended to organize questions in the form.

E New Item - Section

Name *
Condition to show the section

Always displayed v
+ Add

It is possible to setup conditions to show the whole section, based on the answers provided to questions located in other
sections of the form.

9.4.3 Questions

Click on the link Add a question in a section of your choice.

0 section 1 W

+ Add a question

The following page displays:
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E New Item - Question

Name * Section  section * i

Types  --- v

Description

Condition to show the question

Always displayed -

+ Add

A question is made of:
* atitle: this is the label of the question in the form.
e atype: see list below.
* asection: the section containing the question. You can move a question to an other section with this field.

 adescription: it is displayed under the question in the form. Use it as a hint for the requester, telling him which
content is expected.

* adropdown list Show field to enable a condition

Condition to show the question

Hidden unless A\

AND ~ section - checkboxes question = - [+] -]

It submits the following choices:
 Always visible: the field is always displays
* Hidden unless: The question is hidden except if answers to other questions matches a condition.
 Displayed unless: The question is displayed except if the answers to other questions matches a condition.

Conditions may be multiple. To add or remove a condition two buttons are available:
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Condition to show the question

Hidden unless -

AND ~ section - actors question « = v [+] (-]

& Save

Note: List of pictograms

* The circle allows you to make a question mandatory
@
, or optional

O

* Arrow up and arrow down allow you to reorder questions in a section.
* Clicking on a question allow you to edit it.
* Two stacked squares allows you to duplicate a question or a whole section.

* The recycle bin allows you to delete a question or a whole section.

Questions are organized on a 4 columns array. You can resize width of questions, reorder them using drag and drop
and put up to 4 questions on the same row.

9.4.4 Types of question

There are about twenty types of questions available. Depending on the chosen type, you need to provide additional
information.

Note:
* Required: Yes/No. When running the form a red star shows next to label of questions requiring an input.
* Default values: its content depends on the type of the question.
* Range Min/Max: Restricts the value to the given range when running the form.

* Additional validation (Regular expression): You may set a custom regex with a regular expression. Use it
when other restriction methods cannot satisfy your needs. Don’t forget to specify the delimiters of the regex.
You may add any modifier after the closing delimiter.
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Actors

pign

pign

This field allows you to choose one or several users:
¢ in GLPI, available in Administration > Users

* not in GLPI, by typing an email address

Checkboxes (multiple choices)

Choice 1
Choice 2
Choice 3
Choice 4

E Question - checkboxes question

Name * checkboxes question Section  section i
Types  Checkboxes v

Required No ~

Default Values Values Choice 1
Choice 2
Choice 3
A ~ .
Description

checkboxes description

Min Max
Condition to show the question

Always displayed -

& Save

Add a line per value in Values. Default values may be set in Default values, one per line. If this field is empty, no
checkbox will be ticked.
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Date / Datetime / Time

datetime question

datetime description

2 O
¢ July v 2022 N

Wk Sun Mon Tue Wed Thu Fri Sat
() »

3 4 5 6 7 8 9

10 1 12 13 14 15 6

17 18 19 20 21 22 23

24 25 26 27 28 29 30

31

12 : 00 : oo P
‘ MNow ‘
This field allows to select a date, a datetime or a time from a mini calendar.

Description

This field only displays information. Use it to give more details about a question.

Dropdown

This field allows the user to choose a value among those available in a dropdown from GLPI (in Configuration >
Dropdowns).
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Dropdown = Common - Locations -

Blacklisted Mail Content
Assistance

ITIL categories

Task categories

Task Templates

Email

The answer to this type of field must be a syntactically valid email address.

File

file question

file description

File(s) (2 MB max) 1
Drag & drop your file here, or

Sélect. fichiers ~ Aucun fichier choisi

This field allows the requester to upload a file.

Float

This field must be a float value. Note you may use a regular expression to tighter restrict the answer.

GLPI Object

This field allows you to build a dropdown from a GLPI object among those available in the menus:
* Assets
» Assistance
* Management
* Tools

¢ Administration
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Hidden field

This field is hidden and allows to retrieve an arbitrary value when generating the target (ticket or change).

Note: This type of questions never shows on a form.

Hostname

This field is invisible. It allows to get the hostname of the computer used by the requester, assuming the DNS is able
to properly resolve it from its IP address

Integer

This field must be an integer value. Note you may use a regular expression to tighter restrict the answer.

IP Address

This field is hidden and collects the IP address of the form requester. It does not show in the form.

LDAP select

This field allows you to create a dropdown list with objects from a LDAP directory:

E Question - LDAP question

Name * LDAP question Section  section v i
Types  LDAP Select v LDAP Directories  forumsys v i
Required MNo ~ Show empty No ~
Filter (& (uid="*) ) Attribute | (AD)User ID + i+
Description
LDAP description

Condition to show the question

Always displayed -

B) Save

Note: This type of questions cannot be used to fill actors of a target.
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Multiselect (multiple choice)

This field allows you to create a dropdown list with ability to select multiple items. Values are added one per line in
the field Values. You may set default values, one per line in Default values*. If no default value is set then no item will
be selected by default.

Request type

This field is a dropdown with “Incident” or “Request” choices. It can be used to set the request type of a ticket being
generated by the form.

Radio buttons (one choice only)

radio question

radios description

Choice 1
Choice 2
Choice 3

E Question - radio question

Name * radio question Section  section v i
Type  Radios -

Required No ~

Default Values Values Choice 1
Choice 2
Choice 3
4
Description

radios description

Condition to show the question

Always displayed v

B Save

Add a line per value in Values. A default value may be set in Default value. If this field is empty, no radio will be
selected.
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Select (one choice only)

This field allows you to create a dropdown list and set its items. Items are added one per line in Values. Default value
may be set in Default value. If there is no default, no item is selected by default.

Tags

This is a hidden field to add a tag to the form for future processing.

Note: This type of field is only available when the plugin Tag is installed and enabled.

Text

This field allows you to input a single line of text.

Text area

This field allows you to input several lines of text.

Urgency

This field allows you to select an urgency defined in GLPI.

9.4.5 Conditions

Conditions are expressions involving questions and sections which are evaluated in order to determine

« if a question is displayed

« if a section is displayed

* if the submit button of a form is displayed

* if a target (see below) must be generated
Auvailable operators in an assertion are:

* equals

* not equals

* less than

* greater than

* less than or equal

* greater than or equal

* is visible

* is not visible

* matches a regular expression

The condition expression can be used with the following rules:
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* Hidden unless: the item is hidden or not generated except when the expression is true

 Displayed unless: the item is displayed or generated except when the expression is true

9.4.6 Access types

Three values are available:
* Public access: Anonymous users may access the form; you may use it in an intranet.
 Private access: Users having a GLPI account may access the form.
* Restricted access: Only users having the specified profiles may access the form.

When a form is set to Public access it is possible to enable a simple captcha. This captcha should prevent spamming
if a form is accessible from internet.

Note: Captchas are not enabled by default on anonymous forms. Administrators need to enabled them explicitly
depending on how the form may be accessible from an hostile network such Internet.

9.4.7 Targets

There are three types of targets for a form:
* tickets
* changes
* problems
It is possible to generate any number of targets from a single form. Mixing types of targets is also possible.

To create a target click on the link Add a target

Form

Targets Type Actions
Validators
+ Add a target
Questions 24
Access types
Targets
Preview

Form answer properties
Form answers

Form languages

Historical a

The following window is then displayed:
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Ajouter une cible
Nom * Type* e b

Ajouter

Choose a target name and type, then validate. The new target is created and is available for tuning.

9.4.8 Preview

This tab allows you to view how the form will be rendered and test it without activating it.

Note: Submitting answers from the preview will be actually saved, and will generate targets if the form is not configured
with validation.

9.4.9 Form answers

This tab shows all answers saved for the form.

Note: To delete a form, all its answers must be deleted first. A warning shows at the bottom of the main tab of a form
as a reminder.

9.4.10 Categories

Menu : Setup > Dropdowns : Forms > Form categories

Form categories allow you to arrange your forms list. Forms are displayed when they belong to the selected category
or any sub category. When a form does not have any category, it is displayed when no category is selected or when the
user selects “view all”.

You can add or edit categories generally from the Setup menu : Setup > Dropdowns.
You can also add new categories directly from the form page like all GLPI dropdowns.

They are defined by entities and can be translated since GLPI 0.85 like all other dropdowns.

Note: Dropdowns translation must be enabled on GLPI general configuration page Setup > General, General setup >
Translate dropdowns = Yes

Note: Categories may be associated to Knowledge base categories. This link is necessary to allow FAQ entries to
show along your forms.
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Configuration

& Home / & Setup /| € Dropdowns / B Form categories @ Q

_____ v Items Seen ~ contains v

omSearch v ®

COMPLETE NAME
Computer problems

Human resources

20 rows [ page Showing 1to 2 of 2 rows

Render

 Find menu

@ Home Q
Categories My 5 last forms (requester)
Welcome to our ForCreator users page. © Newarrival
Computer problems You can select a specific form from below to easily create a ticket on a specific subject. 2022-06-24 10:04
Human resources All my forms (requester)
What are you looking for? Q
Seeall © %0 My 5 last forms (validator)

No form waiting for validation
Network problem New user Software request
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9.4.11 Questions

After the creation of a form, create fields for the user to fill out.

E New [tem - Question

Name * Section  section * i

Type - =

Description

Condition to show the question

Always displayed v

+ Add

The name of the questions will appear on the left and the field type selected on the right.

The Description will be under the input field.

Additional options may be displayed depending on the currently selected question type.

If validation of the input is desired, it can be implemented following PHP Regular Expressions.

If you want to show or hide questions depending on the answers of other questions, use the show fields area when editing
a question. In the version 2.5.0 you may use more complex expressions checking for the content of several questions,
and use logic operator OR and AND. The precedence of boolean operators applies, meaning that AND has precedence
over OR.

9.4.12 Translation

In some cases a form should be available in several languages. Choose first in which language a form should be created.
This language should be english (US or UK) or the language that most of target users understand. This is the fallback
language if no alternative is found.

This language is also used as reference in the translation process. Then be sure that the chosen language is readable by
the user who will translate the form.

To translate a form open the tab Form languages, then create all languages you need to provide to users.
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ools © Administration v & Setup

@ Home / © Administration / & Forms [(@searen ][ty usts (@] Q

(5] mn

Validators

— o New Item - Form language

Access types
Name * English (US) +
Targets 2
Preview
Comment
Form answer properties
Form answers
Form languages PV
Historical 8
Al
Language
Deutsch
Frangais
&

Language

Choose a language added to the form and click it to begin or resume translation, then select the tab Translations. Click
the button New translation and a popup dialog will open and show a string to translate. Type the translation, and click
save or validate with Enter on your keyboard.

Add translations

Section

B Save

If another string must be translated, it will show immediately. If no more string needs to be translated, a message will
show instead.
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Add translations

Mo more string to translate

B Save

When you close the dialog the list of translated strings is refreshed. You can edit a translation by clicking on it, delete
one or several translations with the checkboxes on the left of the list and the Delete button**. You can also filter the
list with the filter input box.

B3 Management v & Tools © Administration v & Setup

@ Home / © Administration Q
=]
Form language - fr_FR
Translations
Al + New translation Filter list
Original string Translation
translatable form Formulaire traduisible
Delete
(cc) R

9.5 Targets

Targets are objects generated by FormCreator submission. If a form requires validation, the targets are delayed until
approbation.

Note: Targets are currently tickets only.

A target ticket defines the ticket generated by the form. You may have several targets per form.

Open the tab Destination and create a target with a name and a type (currently ticket only).
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9.5.1 Target ticket

A target ticket generates a ticket.

00ls © Administration v

© Home | © Administaton /& Forms (R @ s | e | [8][2 ][] o
=]
S
Properties
Actors
etor Name * ticket
Condition
Target ticket
Al
Ticket title * ticket
Description
#HEULLFORM##
B Save
List of Available Tags
Question Title Answer Section
Fullform - ##FULLFORM#

The ticket is build from scratch or from a ticket template available in GLPI. You may
* customize the name of the target ticket to distinguish it from possible other targets,
* customize the title and description of the ticket using questions and answers,

* set tne destination entity of the generated ticket,

* set a time to resomve (formerly due date),

* set the type of ticket (request or incident),

¢ set the associated elements,

* set the category,

* set the urgency,

¢ set the location,

* assign tags to the ticket if the plugin Tags is available,
* link the generated ticket to other tickets

* define actors of the ticket.

* define conditions to meet to generate the target ticket

Note: Setting an urgency, a category or a location (specific or from a question) overrides the urgency defined in a
ticket template (if any)
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Destination entity

Many choices are avaialble:

Current active entity: the entity of the requester who fills a form,
Default requester’s entity: the default entity defined for the user who fills the form,

First dynamic requester’s entity (alphabetical): sorts all dynamic entities of the requester alphabetically and
selects the first one,

Last dynamic requester’s entity (alphabetical): sorts all dynamic entities of the requester alphabetically and
selects the last one,

The form’s entity: the entity where is located the form being filled by the requester,

Default entity of the validator: the default entity of the validator who validates the request,

Specific entity: an entity set by the form’s designer,

Default entity of a user type question answer: the default entity of a user choosen by the requester in a question.

From a GLPI object > Entity type question answer: the entity choosen by the requester from a question.

Note:

Default requester’s entity may be not set, then there is a risk to generate tickets in the root entity.

Note:

Default entity of the validator may be not set, then there is a risk to generate tickets in the root entity.

Note:
entity.

Dynamic requester’s entity requires user synchronization, then there is a risk to generate tickets in the root

Ticket template

Sets predefined setings for the ticket from a template. All settings defined in the target ticket will override the values
found in the template.

Request type

Sets the type of the generated ticket

Default or from a template: value set by GLPI when no type is set, or from a template, if any and if this template
defiines a type

Specific type: either request or incident,

Equals to the answer to the question: the value is set from a request type question.
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Associated elements

Sets associated elements to the generated ticket

None : self explanatory, Specific asset: an asset set by the designer of the form, Equals to the answer to a question: an
asset set by the requester, from a question Last valid answer: an asset set by the requester, from the last visible question
eligible for this purpose

Category

Sets the category of the generated ticket

» Category fro template or none: sets the category from a template if any and if this template has a predefined
category. None in all other cases,

 Specific category: a category set by the form’s designer,
» Equals to the answer to a question: a category choosen by the requester,

* lastr valid answer: a category from the last visible question of type category,

Urgency

» Urgency fro template or none: sets the urgency from a template if any and if this template has a predefined
urgency. None in all other cases,

 Specific urgency: an urgency set by the form’s designer
» Equals to the answer to a question: a category choosen by the requester,

Location

* Location from template or none: sets the location from a template if any and if this template has a predefined
location. None in all other cases,

* Specific location: a location set by the form’s designer

» Equals to the answer to a question: a category choosen by the requester,

Condition to show the target

The form’s designer may restrict creation of the ticket depending on conditions.

9.5.2 Target change

A target change generates a change
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© Administration v
@ Home | © Administration / @ Forms [N [ sewen [ & v | (@[ )[4 a
=]
Target change
Target change - change % Actions v

Properties
Actors
or Name *  change
Condition
Target change
Al
Changetitle *  change

Description  ##FULLFORM##

Impacts.

Control List
Deployment Plan
Backup Plan

Checklist

@ Save

The change is built from scratch. You may

 customize the title, description, imapct, control list, deployment path, backup plan and checklist fields using
questions and answers,

* set the urgency from a value or a question

* choose the entity of the change among many policies
* set the time to resolve

¢ define the actors of the change

* set the category of the change

* define conditions to meet to generate the target ticket

9.5.3 Target description templating
Target ticket and target change both have description template. By default the template uses the tag ##FULLFORM##.
This tag is a default template where all questions and sections are displayed in the same order as the form.
Each question has 2 tags
» ##question_x## which is replaced by the label of the question. X is the ID of the question.
 ##answer_x## which is replaced by the answer to a question. X is the ID of the matching question.

Questions of type dropdown support more complex expression like ##answer_x.name##. x still means the ID of a
question. the word after the dot is the name of a property available in the search options of the itemtype of the dropdown
question.

As an example, consider a dropdown question which shows locations. The itemtype set by the form designer is “Loca-
tion”. The designer can render in the target many fields of the location selected by the requester, such address, postcode,
state, building, and many other data. To find them, the admin may rely on the list available in the search filters for a
location.
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9.6 Issues lifecycle

9.6.1 Abstract

The service catalog relies mostly on a list of issues (or assitance request). Issues are created and maintained upon events
related to tickets and form answers.

When a ticket is created from GLPI, then a new issue is created in the database. When this ticket is being updated, the
issue is updated to reflect all relevant changes.

Form answers are created when a requester fills a form and submits it. When a form answer is created a new issue is
created as well. As a form answer may or may not trigger the creation of tickets, issues behave differently depending
on this quantity of generated tickets.

9.6.2 Ticket created from GLPI

When a ticket is created from GLPI, the issue reflects most useful information from this ticket.

9.6.3 Form answer without any generated ticket

When a form answer did not generate a ticket, or when the form answer generating tickets is waiting for validation,
then the issue reflects the form answer.

9.6.4 Form answer with a single generated ticket

When a form answer trigered the creation of one and only one ticket, then the issue reflects this ticket. This is also true
when the approval of a form answer triggers the creation of a single ticket.

9.6.5 Form answer with several generated tickets

When a form answer generated several tickets, then the issue reflects a list of those tickets. Each ticket is viewable by
the requester, if he is granted to view it.

9.6.6 Status

Computation of status

Issues follow the lifecycle of tickets or form answers, depending on which object it reflects.

When an issue reflects a single ticket, its status takes into account the validation status of a ticket, if any. The validation
status of the ticket takes precedence when the ticket is not solved and waiting for approval or has been refused. For all
other cases, the issue shows the regular ticket status.

You may refer to the following table to have a quick view of how the status is computed:
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Validation Status
NONE WAITING REFUSED ACCEPTED

Ticket INCOMING T
Status  ASSIGNED T
PLANNED T
WAITING T
T

T

SOLVED
CLOSED

HiEl <K <E
HH << <<
4

e T = status picked from Ticket
* V = status picked from Validation

When an issue reflects several tickets then the status of each ticket is computed from the above description, and the least
advanced status is used. If an issue reflects 3 tickets having statuses Waiting, Resolved and Closed, then the choosen
status is Waiting. This means that an issue is closed oly when all its tickets are closed.

searching issues by status
The search engine shows many statuses. Some are shortcuts to search several statuses at once, like tickets, some are
specific to the statuses of form answers.
* new: new issues
* processing (assigned): processing issues
* processing (planned): planned issues
» waiting: issues waiting for information from requester or waiting for validation by a valdiator
* solved: issues solved or refused by a validator
* closed: issues closed or accepted by a validator (this happens when no ticket has been generated after validation)
* not solved: all statuses but solved or closed
* not closed: all statuses but closed
* solved + closed: issues solved or closed
e all: any status
* accepted: issues accepted by a validator

* refused: isses refused by a validator
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9.7 Exporting and importing forms

9.7.1 Abstract

Formcreator allows exporting and importing forms between instances of GLPIL

This feature is designed to let administrators develop forms on a testing environment and copy them on a production
environment.

When a form is being imported the plugin searches for a matchng form in the database. This is done with the help of
a random identifier created when a new form is instanciated. Each sub object (sections, questions, conditions, targets)
also have a random identifier. This helps the plugin to find a matching item and update it if necessary. Thanks to this
mechanism Formcreator is able to update a form when it is imported more than once.

9.7.2 Limitations

A form may contain relations to objects of GLPI itself (mostly users, groups, categories, entities). There is currently no
reliable way to maintain relations between forms and GLPI’s objects or assets accross instances. It is therefore highly
recommended to develop forms on a testing environemnt with a reasonably recent copy of the production database.

The export / import feature does not support importing forms accros different versions of Formcreator. The version
2.10 shows a warning if it detects a attempt of importing forms from a previous version. In version 2.11 such imports
are not allowed.

9.7.3 Exporting forms

1. Navigate to Administration > Forms

2. Use massive actions to export one or more forms. Clicking on the Post button will start the download of a JSON
formated file. This file contains all forms selected for the export.

Actions
& Home / ©@ Administratio Q
Action  ——-—- a
o Unlock ltems
----- v | ltems Seer
Add to Transfer List
| & rule | [+ group || =3 Search | % ® Add a note
Duplicate
Transfer
5 ©a & o
NAME * ACTIVE FORM CATEGORY LANGUAGE HOMEPAGE ACCESS
|:| form with all question types [ ] All languages No Private access
50 ~ | rows | page Showing 1to 1 of 1rows
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9.7.4 Importing forms

1. Navigate to Administration > Forms

2. Use the toolbar to import forms.

100 % - + | Réinitialiser
GLF. —

& Home / & Administration / @ Forms E Q

————— v ltems Seen~ contains ~  all

s o o

5 ©Q & 0

NAME ACTIVE FORM CATEGORY LANGUAGE HOMEPAGE ACCESS
form with all question types All languages No Private access
50 rows / page Showing 1to 1 of 1rows

3. Select one or more JSON files created with the same version of Formcreator and validate.

& Home /| @ Administration / (% Forms E Q

Import forms

File(s) (2 MB max) 1
Drag & drop your file here, or

Choisir un fichier =~ Aucun fichier choisi

Send

1. Depending on the complexity and the quantity of forms the process may be slow. Please be patient.

2. Carefully check the messages when the import completes. You may get warnings and errors.

9.7. Exporting and importing forms 79



GLPI plugins Documentation

9.7.5 Import behavior

Entities

When Formcreator imports a form, it checks that the entity of the form exists and the user has right to update entities.
If not, the form is ignored and trigger a warning.

Form categories

Form categories are created if they don’t exist yet.

Users and groups

The users and groups found in target actors must exist. If not, the import of the form will stop with an error, leading to
an incomplete form. Other forms will be imported.

[CD) &v-ric-n |
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CHAPTER
TEN

GENERIC OBJECT

Download

Sources

https://github.com/pluginsGLPI/genericobject/releases

https://github.com/pluginsGLPI/genericobject

10.1 Requirements (on-premise)

GLPI Version

Minimum PHP Recommended

10.0.x

8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

10.2 Features

This plugin allows you to add new inventory objects types, integrated into GLPI framework.

It supports following GLPI features:

entity and sub-entities management;
search;

templates;

history;

helpdesk integration;

CSV file injection plugin integration;
Item uninstallation plugin integration;

order management plugin integration.
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10.3 Example of usage

Objective: Manage your car fleet like the rest of your IT Assets.
» Create a new type of inventory object car.
¢ Add the accurate fields for a car, like: name, serial number, inventory number, type, model, color, state, etc.
» Describe the behaviour of a car: visible in subentity, retain history, etc.
* Adjust the rights on cars.
* Activate the cars object.

* Manage your collection of cars in GLPI.

10.4 Install the Plugin

* Uncompress the archive.
* Move the genericobject directory to the <GLPI_ROOT>/plugins directory
* Navigate to the Configuration > Plugins page

* Install and activate the plugin

10.5 Usage

10.5.1 Create a new object type

This is the first step.
* Click on the + button in the plugin configuration form.
 Create the new type of inventory object:
— name: mandatory, lowercase, and must be composed of letters only;
— label: by default, the same as the name.
 Validate.
* Activate the new item type to use it.

Example: Create a new type of inventory object car.

10.5.2 Edit labels
For each type, a language file is available in <GLPI_ROOT>/files/_plugins/genericobject/locales/
itemtype/
The plugin creates :
* alanguage file for the current language

* alanguage file for the default GLPI language
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Note: If the current and default languages are the same, only one file is created.

To change the label of the itemtype, for the english language, edit the file:

<?php
// <GLPI_ROOT>/files/_plugins/genericobject/locales/<itemtype>/<itemtype>.en_GB.php
$LANG[ 'genericobject']['<itemtype>'][1] = "<type's label>";

You can also define labels globally in <GLPI_ROOT>/files/_plugins/genericobject/locales/fields.
<lang>.php files:

<?php
// <GLPI_ROOT>/files/_plugins/genericobject/locales/<itemtype>/<itemtype>.en_GB.php
$LANG[ 'genericobject']['fields']['<itemtype>'] = "<type's label>";

10.5.3 Setup behaviour

Example: Describe the behaviour of a car: visible in subentity, retain history, etc.

The new type will be managed the same way as the usual GLPI types (computer, monitor, network device, etc.)

Note: All objects are at least assigned to an entity

The Behaviour tab allows you to define:
* child-entities: allows the type to be recursive;
* Helpdesk: allows an object to be associated to a ticket;
* Trash: use GLPI’s trash functionnality;
* Notes: use GLPI’s note functionnality;
* History: allow history for this type;
o Templates: allows template management;
e Documents: allows documents to be attached to an object of this type;
* Loans: allows objects to be loaned;
* Contracts: link an object to one or more contracts;
* Network connections: allow ports to be used and management for this type;
» CSV file injection plugin: allows this type to be available for use in the plugin;
e [tem uninstallation plugin: allows this type to be uninstalled;

* Order management plugin: allows this type to be linked to an order;
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10.5.4 Add Fields

Example: Add the accurate fields for a car, like: name, serial number, inventory number, type, model, color, state,

etc.

Navigate to the Fields tab.

The plugin comes with several ready to use fields:

Name

Type

Model

Serial number
Inventory number
Item’s user
Group

Status

Comments

Notes

Location

Other
Manufacturer
URL

Creation date
Expiration date
Category

Visible in Helpdesk
Technician in charge of the hardware
Domain

Contact

Contact number

: Using some behaviour will automatically add some fields to the object:

network connection => location
loans => location
helpdesk => is visible in Helpdesk

notes => notepad
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Helpdesk integration

To use an object in the helpdesk, use following setup:
¢ In Behaviour tab : use helpdesk must be set to Yes.
* if the User field is defined, it allows item to be visible in the My Items list (as item whose owner is the user).

* if the Group field is defined, it allows item to be visible in the My Items list too (as item belonging to a group in
which the user belongs to).

* if Helpdesk visible field is set and if the value is set to No in the object, then the object won’t be visible at all in
the helpdesk.

10.5.5 Add new fields

Note: New fields will be available for all object’s types.

¢ Create a new file named <GLPI_ROOT>/files/_plugins/genericobject/fields/<type>.constant.
php

For example, for a car type the constant file will be <GLPI_ROOT>/files/_plugins/genericobject/fields/
car.constant.php.

Please note that the file’s first line must be the following, otherwise the new fields won’t appear in the list:

<?php
global $GO_FIELDS, $LANG;

¢ Add the new fields definitions.

10.5.6 Add a simple dropdown field

<?php

$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']['name']
< '"]["<type's name>"][2];

$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']J['field'] 'color';
$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']['input_type'] = 'dropdown';

$LANG[ 'genericobject

Note: The language variable must be defined in the language file (see explaination above).

* Add a dropdown field that is assigned to an entity:

<?php

$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']['name']
< ']["<type's name>"][2];

$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']['field'] 'color';

$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']['input_type'] = 'dropdown';

//Does the dropdown take care of entities ? (true/false)

$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']['entities_id'] = true;

//Can values be recursive ? (true/false, only taking in account if entities_id is set to.

(continues on next page)

$LANG[ 'genericobject
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(continued from previous page)
—true)
$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']J['is_recursive'] = true;

10.5.7 Add a tree dropdown field

<?php

$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']['name'] = $LANG['genericobject
< ']["<type's name>"][2];

$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']['field'] = "@olleir" ¢

$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']['input_type'] = 'dropdown';
//Is it a tree-dropdown, or a simple one ? (true/false)
$GO_FIELDS[ 'plugin_genericobject_mytypecolors_id']J['is_tree'] = true;

Note: You can use at the same time the following parameters : entities_id, is_recursive, is_tree.

10.5.8 Add a dropdown field that is based on a GLPI-core object (user, location...)

<?php
$GO_FIELDS['users_id_passengers_id']['name'] = 'Passenger';
$GO_FIELDS[ 'users_id_passengers_id']['input_type'] = 'dropdown';

Note: Name between brackets ([]) MUST begin with users_id in order to be recognized as a field based on GLPI
users’ list.

See file <GLPI_ROOT>/files/_plugins/genericobject/fields/field.constant.php to get a complete list
of available fields.

10.5.9 Add a global dropdown

A global dropdown can be used in all itemtypes. A good example would be :

<?php

$GO_FIELDS['categories_id']['name'] $LANG['common'][36];
$GO_FIELDS['categories_id']['input_type'] 'dropdown' ;
$GO_FIELDS['categories_id']['dropdown_type'] = 'global';

A specific category table will be created for each itemtype. The table name and field name will the computed this way:
e table : glpi_plugin_genericobject_<itemtypename>_category

e field name : plugin_genericobject_<itemtype>categories_id
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10.5.10 Add an integer field

<?php

$GO_FIELDS['testinteger']['name'] = 'testinteger';
$GO_FIELDS['testinteger']['input_type'] = 'integer';
$GO_FIELDS['testinteger']['min'] = 10; //not mandatory, by default 0
$GO_FIELDS['testinteger']['max'] = 40; //not mandatory, by default 100
$GO_FIELDS[ 'testinteger']['step'] = 3; //not mandatory, by default 1
10.5.11 Add a text field

<?php

$GO_FIELDS[ 'mytextfield']['name'] = 'My text field';

$GO_FIELDS[ 'mytextfield']['input_type'] = 'text';

Changed in version 2.1.2: By adding the following argument, you can tell the plugin that this field can be automatically
generated when using a template:

<?php
$GO_FIELDS[ 'mytextfield']['autoname'] = true;

10.5.12 Add a Yes/No field

<?php
$GO_FIELDS[ 'mybooleanfield']['name'] 'My boolean field';
$GO_FIELDS[ 'mybooleanfield']['input_type'] = 'bool';

10.5.13 Add a date field

<?php

$GO_FIELDS['creationdate']['name'] = $LANG['genericobject']['fields'][30];
$GO_FIELDS['creationdate']['input_type'] = 'date';

10.5.14 Add a date & time field

<?php

$GO_FIELDS['creationdate']['name'] = $LANG['genericobject']['fields'][30];
$GO_FIELDS['creationdate']['input_type'] = 'datetime';

Note: If you don’t want a field to be modified using massive actions, add the following line to its definition:

<?php
$GO_FIELDS['myfield']['massiveaction'] = false;
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10.6 Add global fields

To make your fields accessible to all itemtypes:
¢ Create a file named <GLPI_ROOT>/files/_plugins/genericobject/fields/field.constant.php

* Put your definitions in this file.

10.7 Setup Rights

You can define access rights for each object’s type, for each profile. Available options are:
* right on the type: no access, read, write.
* right to associate this type of object to tickets: yes, no.

To associate the rights you can either:
* Use the Rights tab in the itemtype form.

* Navigate to Administration > Profiles and administer the rights for each profile.

10.8 Use the new field

Activate the new type, it’s now ready to be used.

The new type is available for users in the Plugins > Objects management menu.

10.9 Use case of Generic Object as a CMMS

10.9.1 Purpose of this documentation
Showing a complete usage of Generic Object as a CMMS (Computerized Maintenance Management System) in
biomedical environment.
At the end of this use case, you will have :
* adedicated Biomed entity (under Root entity)
* containing Biomedical objects (in Assets menu)
 with built-in and user-defined fields

* manages by users with Admin_biomed profile
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10.9.2 Steps

Following steps assume you have a Super-Admin authorization :
¢ Installing Generic Object on GLPI (validated with genericobject >= 0.85-1.0 and GLPI >= 0.90)
* Generic Object configuration
* GLPI configuration
« Start using Generic Object and GLPI

10.9.3 Installing Generic Object on GLPI

See Install the Plugin section.

10.9.4 Generic Object configuration
Create your type of object

See Create a new object type section and use biomedical as internal identifier. Label will be set automatically to
Biomedical (with an uppercase B).

After a logoff/login, you will see Biomedical menu in Assets.

Define Biomedical’s new fields

These fields will be usable only by Biomedical’s objects :

e Create a new file named : <GLPI_ROOT>/files/_plugins/genericobject/fields/biomedical.
constant.php

* Add following content :

<?php
global $GO_FIELDS, S$LANG;

// CODE CNEH
$GO_FIELDS[ 'plugin_genericobject_cnehcodes_id'] [ 'name"'] = $LANG['genericobject'][
— '"PluginGenericobjectBiomedical '] [1];

$GO_FIELDS[ 'plugin_genericobject_cnehcodes_id']['field'] = 'cnehcode';
$GO_FIELDS[ 'plugin_genericobject_cnehcodes_id']['input_type'] = 'dropdown';
// REFORME (yes or no)

$GO_FIELDS['reformed']['name'] = $LANG['genericobject'][

— '"PluginGenericobjectBiomedical '] [2];

$GO_FIELDS['reformed']['input_type'] = 'bool';

// CLASSE CE (3 choix possibles 1,2a ou 2b)

$GO_FIELDS[ 'plugin_genericobject_classeces_id'] [ 'name"'] = $LANG['genericobject'][
« '"PluginGenericobjectBiomedical '] [3];
$GO_FIELDS['plugin_genericobject_classeces_id']['field'] = 'classce';
$GO_FIELDS[ 'plugin_genericobject_classeces_id']['input_type'] = 'dropdown';

(continues on next page)
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(continued from previous page)
// UF (Unité Fonctionnelle)
$GO_FIELDS[ 'plugin_genericobject_ufs_id']['name']
- 'PluginGenericobjectBiomedical'] [4];
$GO_FIELDS[ 'plugin_genericobject_ufs_id']['field'] = 'uf';
$GO_FIELDS[ 'plugin_genericobject_ufs_id']['input_type'] 'dropdown' ;

$LANG[ 'genericobject'][

// PRESTATAIRE BIOMED

$GO_FIELDS[ 'plugin_genericobject_prestataires_id']['name']
— '] ['PluginGenericobjectBiomedical'][5];

$GO_FIELDS[ 'plugin_genericobject_prestataires_id']J['field'] = 'prestataire biomed';
$GO_FIELDS[ 'plugin_genericobject_prestataires_id']['input_type'] = 'dropdown';

$LANG[ 'genericobject

// TYPE D'EQUIPEMENT BIOMED

$GO_FIELDS[ 'plugin_genericobject_typedequipementbiomeds_id']['name"']
- 'genericobject']['PluginGenericobjectBiomedical'][6];

$GO_FIELDS[ 'plugin_genericobject_typedequipementbiomeds_id']['field'] = "type d
< "equipement biomed";

$GO_FIELDS[ 'plugin_genericobject_typedequipementbiomeds_id']['input_type']

$LANG[

'dropdown’ ;

// Criticite

$GO_FIELDS[ 'plugin_genericobject_criticites_id']['name']
« '"PluginGenericobjectBiomedical '] [7];
$GO_FIELDS['plugin_genericobject_criticites_id']['field'] 'criticite';
$GO_FIELDS[ 'plugin_genericobject_criticites_id']['input_type'] = 'dropdown';

$LANG[ 'genericobject'] [

// Numéro marquage CE
$GO_FIELDS[ 'plugin_genericobject_marquageces_id']['name"'] = $LANG['genericobject'][
« '"PluginGenericobjectBiomedical '] [8];

$GO_FIELDS[ 'plugin_genericobject_marquageces_id']['field']
$GO_FIELDS[ 'plugin_genericobject_marquageces_id']['input_type']

'marquagece’ ;
'dropdown' ;

// Classe électrique

$GO_FIELDS[ 'plugin_genericobject_classeelecs_id']['name'] = $LANG['genericobject'][
— '"PluginGenericobjectBiomedical '] [9];

$GO_FIELDS[ 'plugin_genericobject_classeelecs_id']['field']
$GO_FIELDS[ 'plugin_genericobject_classeelecs_id']['input_type']
7>

'classeelec';
'dropdown' ;

Warning: Trailing s_id is mandatory in [plugin_genericobject_field*s_id*] because the GLPI frame-
work requires foreign key fields to end with s_id. In database, glpi_plugin_genericobject_fields is table
name and id, its foreign key. See GLPI developer documentation.
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Define fields labels

See Edit labels section.

e Edit your locales file, for example : <GLPI_ROOT>/files/_plugins/genericobject/locales/
biomedical/biomedical.fr_FR.php

* Add following content at the end of file :

<?php

// Fields

$LANG[ 'genericobject'] ['PluginGenericobjectBiomedical'][1]="Code CNEH";

$LANG[ 'genericobject']['PluginGenericobjectBiomedical'][2]="Réformé";

$LANG[ 'genericobject']['PluginGenericobjectBiomedical'][3]="Classe CE";

$LANG[ 'genericobject']['PluginGenericobjectBiomedical'][4]="UF";

$LANG[ 'genericobject']['PluginGenericobjectBiomedical'][5]="Prestataire Biomed";
$LANG[ 'genericobject']['PluginGenericobjectBiomedical'][6]="Type d'équipement biomed";
$LANG[ 'genericobject']['PluginGenericobjectBiomedical'][7]="Criticité";

$LANG[ 'genericobject']['PluginGenericobjectBiomedical'][8]="Marquage CE";

$LANG[ 'genericobject'] [ 'PluginGenericobjectBiomedical'][9]="Classe électrique";

Define behaviours

In Plugins > Objects management menu, on Main tab, select :
* [tem in the dustbin
* Historical
e Financial and administratives information
* Documents
e Global search
* Assistance
o Templates
e Contracts
e Global search

This will add ready to use fields to your type of object.

Add fields to your type of object

In Plugins > Objects management menu, on Fields tab, you can now add fields to Biomedical type of object :
* ready to use fields (GLPI’s built-in fields)

* new fields (defined in Define Biomedical’s new fields section)
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10.9.5 GLPI configuration

Define Admin_biomed profile

1. Clone Admin profile
2. Set following rights in Admin_biomed profile :
e Administration > Profiles > Admin_biomed > Assets tab > Unselect all

* Administration > Profiles > Admin_biomed > Assistance tab > Association > Associable items to a ticket
> Biomedical

* Administration > Profiles > Admin_biomed > Management tab > Select all

* Administration > Profiles > Admin_biomed > Objects management tab > Biomedical > Select all

Note: With these settings, Admin_biomed users only see Biomedical in Assets menu.

Define Biomed entity and authorizations rules

1. Create Biomed entity under Root entity in Administration > Entities

2. Configure authorizations rules to assign Admin_biomed profile to Biomed entity users.

10.9.6 Start using Generic Object and GLPI

As Admin_biomed user, you can create your first object in Assets > Biomedical.

In order to gain time, define values in Setup > Dropdowns > Objects management for new fields.

10.10 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
ELEVEN

NEWS

Download Sources

https://github.com/pluginsGLPI/news/releases  https://github.com/pluginsGLPI/news

11.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

11.2 Features

This plugin allows to display alerts messages on GLPI homepage and / or login page.
* Create alert with rich text as for notes.
* Choice of begin/end publication date.
* Manage alerts by entity.

* Target : display alerts by profile / group / user.

11.3 Install the Plugin

* Uncompress the archive.
* Move the news directory to the <GLPI_ROOT>/plugins directory

* Navigate to the Configuration > Plugins page,

Install and activate the plugin.
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11.4 Usage

The plugin will create required tables in the database automatically. Those tables will be updated along with the plugin.

Plugin usage is quite simple:
 configure alerts

You will access the plugin configuration from the Tools > Alerts.

11.5 Create alerts

* Name : display as talert title

* Active : is active or not

* Description : content of alert

* Visibility start / end : period of Visibility

* Type : type of alert (General, Information, Warning, Problem)
* Can close alert : User can close alert ?

» Show on login page : display or not alert on login page

» Show on helpdesk page : display or not alert on helpdesk page

* Sub-entity : display or not on sub-entity

New Item - Alerts Root entity Sub-entities No « |1
MName
Active No
Formats~ B J A ~HA -~ £ E E H- &£ & o H
Description
Visibility Start Date C [x] Visibility End Date C [x]
Type (to add an icon before -
alerttiley T v Can close alert Yes ¥
Show on login page Mo v Show on helpdesk page Mo
Add
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11.6 Targets

You can define target by type
* Group : for all users of group
* Profil : for all users with profile

e User : for specifi user

alert (Root entity)
Alerts AddaTarget: - <
Targets B
¢ U [Astions.
Historical f
Type Recipient

Al

Groups groupe 1

Profies Salt-Serviee

Users gl gpi

4 Actions

11.7 Display on login page

Glpi

& Mot de passe

% Se souvenir d

Mot de passe oublié 7

Alert

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Mauris iaculis, ex vitae fringilla dapibus, quam felis auctor
orci, vehicula venenatis lectus elit non leo. Aenean elementum turpis turpis. Quisque sit amet ultrices lectus. Nulla
dictum libero a enim lobortis posuere. Maecenas pharetra consequat eleifend. Praesent ac velit eu augue sollicitudin
placerat. Pellentesque blandit, erat nec condimentum pretium, eros dui pulvinar ante, luctus faucibus diam elit sed
dolor. Quisque id risus non purus rutrum ormare sit amet non lacus. Sed fermentum bibendum ultrices.

Proin odio turpis, scelerisque vitae fermentum eu, hendrerit vitae enim. Etiam luctus faucibus arcu, vitae sodales
nulla. Etiam at posuere lorem. Vestibulum cursus lorem quis orci lobortis, eget tempus massa fermentum. Phasellus.
mattis laoreet placerat. Maecenas elit purus, condimentum id nis| sit amet, dictum feugiat purus. Suspendisse diam
odio, ultrices id libero in, porta varius magna. Cras sit amet nisi in metus tincidunt tempor vel ac metus. Nunc massa

nisl, pulvinar vitae lobortis a, tincidunt a nisl. Phasellus non faucibus ex. Duis aliquet libero tincidunt pellentesque.
cidunt. Curabitur lacus diam, sodales vitae pretium a, bibendum quis sapien. Pellentesque nec arcu leo. In luctus
dictum dictum. Phasellus convallis libero sed luctus pellentesque. Interdum et malesuada fames ac ante ipsum primis
in us.

R p—
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11.8 Display on helpdesk page

? K & Qowow o

B cosnws ?

Assets Assistance Management
Root entity (tree structure) Super-Admin

Home

A

Personal View  Group\View  GlobalView  RSS Feeds

Alert x

Lorem ipsum dolor sit amet, consectetur adipiscing elit. Mauris iaculis, ex vitae fringilla dapibus, quam felis auctor orci, vehicula venenatis lectus
n leo. pis turpis. Nulla dictum liber a enim lobortis posuere. Maecenas pharetra
er0s dui pulvinar ante,

st nor
) placerat. 3
i i lacus,

Proin odio turpis, scelerisque vitae fermentum eu, hends
lobortis, eget tempt a

vl ac metus. Nunc massa nisl, pulvinar vitae Ioborts a, tincidunt a nisl. Phasellus non faucibus ex. Duis aliquet libero tincidunt pellentesque
a les vitae pretium a, bibendum quis sapien. Pellentesque nec arcu leo. I luctus dictum dictum. Phasellus

tincidunt. Curabitur lacus diam,
‘convalis libero sed luctus pellentesque. Interdum et malesuada fames ac ante ipsum primis in faucibus.

luctus
reri vitae enim. Etiam luctus faucibus arcu, vitae sodales nulla. Etiam at posuere lorem.

id nis! sit amet, dictum feugiat purus.

GLP1 0.4.5 Copyright (C) 2015-2010 Teclib' and contributors.
Fusioninventory 9.4+2.3 - Copyleft ® 2010-2019 by Fusioninventory Team

11.9 FAQ

If you have any questions about using the plugin, please consult our FAQ

Chapter 11. News

96


https://faq.teclib.com/04_Plugins/News/
http://creativecommons.org/licenses/by-nc-nd/4.0/

CHAPTER
TWELVE

OAUTH IMAP

Download Sources

https://github.com/pluginsGLPI/oauthimap/releases  https://github.com/pluginsGLPI/oauthimap

Note: Microsoft is gradually removing the TLS 1.0 and 1.1 protocols for all Microsoft 365 applications. In order to
keep your collector running, you need to add the Oauth IMAP plugin, which is available in the marketplace.

Tip: The Oauth tokens for the collector, retrieved during authentication with Azure by the OauthIMAP plugin, are
“offline” tokens that delegate authorisation to a third-party application (GLPI). These tokens provide a renewal code
that will be used by the application to renew them automatically without user intervention. You will therefore not be
asked to re-authenticate after the 1st authorisation request.

12.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

12.2 Supported mail services

OAuth IMAP support :
* Gmail : https://developers.google.com/gmail/imap/xoauth2-protocol ?hl=fr

 Entra : https://learn.microsoft.com/fr-fr/power-platform/admin/connect- gmail-oauth2
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12.3 Install the plugin

* Go to the marketplace. Download Oauth IMAP and enable it

/@™ Oauth IMAP ©
EF GPL v2+ 3]
2 TECLIB'
§2 1.4 2

Open the Azure Portal for your tenant

In the search box type registration

then select App registrations

I £ regi

All Services (20) Resources i

Azure Active Directory (30}

Services

a2 App registrations

Here are the configuration steps including configuration phases on the Entra side.

12.4 Register your Entra application

12.4.1 Create the application

* Click on New registration

 Enter the desired name, select the type of account supported then enter the redirection URL (present in the
configuration of the plugin from your GLPI interface: https://XXXXXXXXXXXXXX/marketplace/oauthimap/
front/authorization.callback.php) specifying the Web option

* Then click on Register.
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New registration

Register an application

* Name

The user-facing display name for this application (this can be changed later),

[ autH map officesss | 7

Supported account types

Whe can use this application or access this API?

\é) Accounts in this organizational directory only (TECLIB only - Single tenant)
O Accounts in any organizational directory (Any Azure AD directary - Multitenant)
O Accounts in any organizational directory (Any Azure AD directory - Multitenant) and personal Microsoft accounts (e.g. Skype, Xbox)

O Personal Microsoft accounts only

Help me choose...

Redirect URI (optional)

we'll return the authentication response to this URI after successfully authenticating the user. Providing this now is optional and it can be
changed later, but a value is required for most authentication scenarios.

I Web W Il https:/ /marketplace/oauthimap/f. I

Register an app you're working on here. Integrate gallery apps and other apps from outside your organization by adding from Enterprise applications.

12.4.2 Add a secret

¢ In the Certificates and secrets tab
¢ Click on Client secrets

¢ Then New client secret

Certificates & secrets

Certificates (0) | Client secrets (0) Federated credentials (0)

A secret string that the application uses to prove its identity when requesting a token. Also can be referred to as application password.

- New client secret |

Description Expires Value (& Secret ID

No client secrets have been created for this application.

* Enter a description and then an expiration date

* A secret value is then generated. Keep this value well because once you have left this page, it will no longer be
recoverable

 Return to the Overview tab and copy the following values and the secret seen above
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Description

Auth IMAP

Expires Value @

11/2/2024 -Bd8Q~HrbiuYXbxhsTkhO25)BJtzfL4dfP.. D

 Essentials

Display name
Application (client) ID
Object ID

Directory (tenant) ID

Supported account types :

AUTH IMAP Office365

:|£3767743-3406-4dfb-9¢c5e-300cbde1488d

, 466228e5-c787-4dca-b753-473%bd68362¢

3cZaetl . B T B Bl L, . L

Multiple organizations

12.5 Setup GLPI

* Now go back to your GLPI interface Setup > Application Aouth IMAP and indicate the information collected
previously :
Name = Oauth IMAP Comments
Active  Yes Qauth provider Bl Azure - 9

Client ID f3767743-3406-4dfb-9¢c5e-300chde1488d Client secrat -BdBO~HrbiuYXbXhSTkhO2S B tzfLAdPWIfb_N
Tenant ID 3c2a)
Callback url | https:yf ‘marketplace/oauthir »
+ Add
e Click Add

¢ Now in the Oauth authorization tab, click Create an authorization

¢ When you click on Create authorization, you will be redirected to the Microsoft services sign-in page

* Enter the email address and password of the account that will be used for the collector

* You will also need to accept the necessary permissions related to the plugin.
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12.6 FAQ

Oauth IMAP application

Historical

QOauth authorization

All

If you have any questions about using the plugin, please consult our FAQ

12.6. FAQ
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m Microsoft

collecteur-mail@

Autorisations demandeées

AUTH IMAP Office365
Eon vériﬁél

Cette application n'est pas publiée par Microsoft.

Cette application souhaite :

v Conserver ['accés aux données auxquelles vous lui avez
donné acceés

v Afficher votre profil de base

v Read and write access to your mail.

Accepter ces autonsations signifie que vous autonsez cette
application & utiliser vos données comme indiqué dans les
conditions d'utilisation du service et la déclaration de
confidentialite. L'éditeur n'a pas fourni de liens vers ses
conditions pour vous permettre de les consulter. Vous pouvez
modifier ces autorisations 3 l'adresse
https://myapps.microsoft.com. Afficher les détails

Cette application semble-t-elle suspecte 7 Signaler ici

EMAIL

collecteur-mail@ #Diagnose  BUpdate = MDelete
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THIRTEEN

ORDER

Download Sources

https://github.com/pluginsGLPI/order/releases  https://github.com/pluginsGLPI/order

13.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

13.2 Features

This plugin supports the following aspects of order management :
* Definition and management of a catalogue of product references
* Order management (with approval workflow)
* Budgets management

* Management of invoices associated with orders

13.3 Install the Plugin

* Uncompress the archive.
* Move the order directory to the <GLPI_ROOT>/plugins directory

* Navigate to the Configuration > Plugins page,

Install and activate the plugin.
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13.4 Configuration

You will access the plugin configuration from the Setup > Plugins > Orders managment.

When the plugin is installed and enabled, the following options are available:

Plugin configuration

Default VAT No VAT v | i@
Use validation process No
Order generation in ODT No
Activate suppliers quality satisfaction No ~
Display order's suppliers infermations No
Color to be displayed when order due date is overtaken _
Copy order documents when a new item is created No
Default heading when adding a document to an order — v i
Author group (Default values) — v  i©
Recipient group (Default values) — v  i©
Recipient (Default values) * 1
Do not display expired budgets No
Transmit budget change to linked assets No
Display account section on order form No
Set account section as mandatory on order form No
Use free references No -
Rename documents added in order No -

Default VAT: indicates the amount of VAT that will be proposed by default in the plugin

Use the validation process: indicates whether the full validation circuit should be used, or whether anyone can
validate applications.

Purchase order generation: indicates if the tab allowing the generation of a purchase order in ODT format is
displayed or not.

Enable supplier quality: indicates whether the tab for judging supplier satisfaction is displayed once the order is
delivered.

Display purchase order vendor information: Shows whether or not the tab for storing the reference and vendor
purchase order number is displayed.

Colour when the estimated delivery date is exceeded: colour of display in the search engine of an undelivered
order for which the estimated delivery date is exceeded

Copy order documents when a new item is created : Copy order documents to generated item
Default heading when adding a document to an order : define default heading

Author group (Default values) : Define default author

Recipient group (Default values) : Define defaut Recipient group

Recipient (Default values) : Define default Recipient

Do not display expired budgets : yes or no

Transmit budget change to linked assets : yes or no
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* Display account section on order form : yes or no
 Set account section as mandatory on order form : yes or no
* Use free references : yes or no

* Rename documents added in order :yes or no

13.4.1 Automatic actions when delivery ltem

Automatic actions when delivery

Item
Display analytic nature on item form No
Set analytic nature as mandatory on item form No
Enable automatic generation No +
Default state — ¥ 10
Add order location to item No -
Add billing details to item No

Generation does not apply to contracts, cartridges and consumables. In order to activate this feature, change the option
Activate automatic generation to yes and validate. During the generation, the material will be created with some
randomly generated information:

¢ Default name
¢ Default Serial Number
 Default inventory number

* If a template is associated with the part number, and in this template the name and serial number are generated,
then the settings defined above for these 2 fields do not apply.

The default status will be set when the material is created. The positioning of the status during the creation of the
material can lead to a date filling of the financial information. See the Entity Inventory tab.

13.4.2 Order lifecycle

You can define your own status for order lifecycle

Order lifecycle

State before validation — v | 10
Waiting for validation state S ]+
Validated order state — v | 10
Order being delivered state S ]+
Order delivered state — v | 10
Order paied state S ]+
Canceled order state — v | 10
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13.5 Creation of a reference catalogue

You will access the reference catalogue from the Management > Orders > Products references.

B o 2 k kGO0 o

Administration

Home Management  Orders  Product reference + Q £ Root entity (tre
Galaxy S10 (Root entity) n
Product reference Root entity Child entities No ~

Name Galaxy 510

Hem type Phones Type SmartPhone
Model swo v |ie Template name
Lastupdate  2020-01:27 1019

Last update on 2020-01-27 10:19

Save

Put in trashbin

The creation of product references is the prerequisite for order management. Any product to be ordered must be
referenced in the plugin catalog. When creating a product reference, the following fields must be filled in:

» Sub-entities: indicates if the reference will be visible in the current entity only or in the sub-entities as well.
* Name: name of the reference, as it will be displayed when managing an order (required)

¢ Manufacturer: the manufacturer of the product (not the supplier)

* Type of equipment: indicates what type of equipment we are dealing with

* Type: the type of the product

e Model: the model of the product

» Template: the GLPI template of the product if one already exists.

* comments: additional information on the reference

* Once the reference is created, it is then necessary to indicate from which supplier(s) the product is available, as
well as the price associated with it.

It is also possible to :
¢ Add related documents

* View history

13.6 Creating an order

You will access orders from the Management > Orders > Orders.
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B eos 2 Kk ik o0 &

Assets Assistance Administration

Management  Orders ~ Orders + Q == &£ Root entity {tree structure)

Phone Device (Root entity) n

Order
Orderitem o Order Rootentity  Child entities No v i
Validation Order name* Phone Device Date of oder 20200127

- Order number: DFGASES4DUI0

Order status:

2018.2020
Tickets
Documents 000
B

e o Estimated due date:
elvery date: 20200127
Historical
Last update on 2020.01.27 10:22
Al
Actor Cost

Price tax ree: s650.20
Auor opi Author group: Price tax ree wih posiage  5659.20
Recipient Recipient roup: Price ATI 679104

var 11384

Last update on 2020-01-27 10:22

GLP19.4.5 Copyright (C) 20152010 Teclil and contributors
Fusioninventory 9.4+2.3 - Copyleft 3 2010-2019 by Fusioninventory Team

Once the reference catalogue has been created, it is now possible to add material orders. The fields to be filled in are :

Sub-entities: indicates if the order is visible in the sub-entities

Order name

Order number (required)

Date of order (required)

Budget: The budget to which the purchase order is posted.

Vendor purchase order number: Indicates the internal number for the purchase order at the vendor.
Payment terms: free field (can contain for example 30 days end of month, 60 days end of month, etc)
Billing number

Supplier: the supplier with whom the order is placed. Only the catalogue references from this supplier may be
added to the order.

Place of delivery of the order: indicates the place where the equipment will be delivered. This option has value
only in the entity in which the order is created.

Description: description of the order
Status: Indicates the current status of the purchase order in the release run.

Estimated delivery date: indicates the indicative date by which the supplier must deliver the order.

It is also possible to :

Define author and recipient
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13.6.1 Adding articles

B o ?2 % & Qo0 O

Assets Assistance Administration

Home Management Orders ‘orders + Q = &£ Root entity (tree structure)

Phone Device (Root entity) 1n

Order

Add to the order from the catalog
Orderitem

Type Product reference Quantity Unit price tax free VAT Discount (%)

Validation X A . -
o Prones v GalaxyS10-ASHI3TGSA8: v 7 8 NoVAT v | §O 0 3 Add

Bl

Tickets

Documents

Notes.

Historical s

Al

GLP1 0.5 Copyright (€) 20152010 Teclis' and contributors
Fusioninventory 8.4+2.3 - Copyleft @ 2010-2019 by Fusioninventory Team

In the Details tab, it is now possible to add products to the order.
* Select the type of material to add to the order
* Select product number
¢ Indicate the quantity to order
» Change the unit price if it is not the price indicated in the product reference.

¢ Indicate the percentage discount on products

* You can then validate the addition of these products to the order.

Assets Assistance Administration
Home Management  Orders  Orders + Q = &£ Root entity (tree structure)
Phone Device (Root entity) n
o i = Quantity Assets Manufacturer Reference Type Model  Manufacturer reference Unit price tax free  Discount (%)
Orderitem ; 7 Phowes  SamsungEkctoncsColtd  GalayS10  Smatthone 510 786,00 000
Validation [ Check Uncheck  pelete permanently
Bil D Reference Unit price tax free VAT Discount (%) Discounted price tax free Price ATI Status.
Tickets 9 Galaxy S10 786.00 000 786.00 786.00 Waiting for delivery
Documents 10§ GalaxyS10 786.00 000 786.00 786.00 Waiting for delivery
o 1§ GalaxyS10 786.00 000 786.00 786.00 Waiting for delivery
12i Galaxy S10 786.00 0.00 786.00 78600 Wiaiting for delivery
Historical » .
Bi Gamxysio 78600 000 78600 78600 Waiting for ceivery
Al 14i Galaxy S10 786.00 000 786.00 78600 Waiting for delivery
15§ Galaxy S10 786.00 0.00 786.00 786.00 Waiting for delivery

A\ Check, Uncheck pelete permanently

Note: it is possible to modify the price and the discount of a set of materials when the order is being edited. To do this,
simply double-click on one of these 2 fields, modify its value and then validate the change.
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13.6.2 Validation workflow

B o ? K % Qo O

Home. Management  Orders  Orders + Q = &£ Root entity (tree structure)

Phone Device (Root entity) n

Validation process.
Validate order

Cancel ask for validation

The plugin has a validation workflow that works as follows:
¢ Creating the order: status In progress
* Request for order release: status Pending approval
* Order confirmed: the order then goes to the status In process of delivery.
¢ Order completely received: automatic switch to Delivered status
* Cancelled purchase order: Change to status Cancelled

The definition of the persons having the right to make a validation request, to validate or to cancel an order is done in
the edition of the profiles.

13.6.3 Receiving the order
Once the order has been confirmed, the equipment can begin to be received. To do this, you must go to the Receiving
Equipment(s) tab. Each product is identified by a line with the following information:

* Product reference

¢ Number of equipment(s) received

* Number of material(s) related to inventory items in GLPI

 Unit price of the product (excl. VAT)

* Unit price of the product (incl. VAT)

* Price per unit awarded (excl. VAT)

By clicking on the + icon on the left of the line, it is possible to access the details of the products ordered.
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B e 2 % 3k &0 o

Assets Assistance ‘Administration
Home Management  Orders  Orders + Q == &~ Root entity (tree structure)
Phone Device (Root entity) n
Order
° Assets Manufacturer Product reference Delivered items.

Order tem , Prones Samsung Electronis Co Lid Galaxy 510 017
Validation [ Actions
Hem delivered

~ b Reference Status. livery y y
Bil

s Galaxy 10 Waiing fordefivery
Tickets

v i Galaxy S10 Waitng or delvery
Eranio Vv ui Galaxy 10 Waiting for defivery
Notes v i Galaxy 10 Waiting fordetvery

13i Galaxy 510 Waiting for deliver

Historical 1 v ' v 9 v

[VARTH Galaxy 10 Waiting or delivery
Al

v si Galaxy S10 Waitng or delvery

13.6.4 Receiving material

It is possible to receive the material that has been ordered, from the moment the order is validated. You have to go
to the tab Reception of material(s). One line is displayed for each product reference ordered. This line contains the
following information:

¢ Product reference

* Received equipment(s): indicates the number of equipment received out of the total number of equipment ordered
for this product.

* Related equipment(s): number of goods received related to inventory items in GLPI

* Price per unit (excl. VAT)

* Unit price (incl. VAT)

¢ Price per unit awarded (excl. VAT)
In order to proceed to the reception of products, just click on the + icon on the left of the line.
There are 2 ways to receive material :

* Reception of materials selected from the list of products ordered but not yet received

* Receipt of materials in bulk: in this case we will indicate how many products are received (without first selecting
from the list).

B eos 2 Kk ik Qo0 &

Assets Assistance Administration
Home. Management  Orders ~ Orders + Q == &£ Root entity (tree structure)
Phone Device (Root entity) n
Order
® Assets Manufacturer Product reference Delivered items,
Order tem . Prones Samsung Electronics Co Ltd Galaxy S10 017
Validation Actions
Hem delivered Actions £
v D Reference
Bil . Action| Take fem delvery
v s Galaxy S10
Tickets .
v woi Galaxy 10 Delivery date
[E— v i Galaxy 10 2020-01-29
Notes. Vv o2i Galaxy 510 Delivery form
v s Galaxy S10
Historical = X Delivery status
v i Galaxy 510 )
Al — v iO'post
v =i Galaxy S10

spyright (C) 20152010 Teclb’ and contributors
opyleft @ 2010.2010 by Fusiontnventory Team

In both cases, it is necessary to return the delivery note associated with the reception of the material. Alternatively, a
status of the received objects can be indicated (e.g. Conforming, Non-conforming, etc). Once received, it is possible
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to :
* Generate a material in GLPI from the received product

* Link the product received to existing GLPI equipment

13.6.5 Generate the material

[y o ? % Sk Qo &

Assets Assistance Administration

Home  Mansgement  orders  Orders 4+ Q s= £ Root entity (tree

Phone Device (Root entity) n

Order
° Assets Manufacturer Product reference.
Orderitem 7 Phanes ‘Samsung Electronics Co Lid Galaxy $10(7)

Actions

| Actions x

Associated items 2

Action|  Generate fem +
Bil
Generate item
Tickets

LKL K g

Product Template
Documents 10 eference Name Serial number Inventory number = Entity. Location Group Status
o 13 .
“ Galay Rootentiy v | 10 — v]i0 — v|io | - +lio
= si0
Historical e
14
an Galaxy Rootentty v | i©® — v]io — v i0 [ — v|ie
s10
e
Galay Rootentiy v | 10 — v]i0 — v|io | - v |io
s10
e e
Galay Rootentiy v | 10 — -] i0 — v|io | - v |io
s10
e
Galaxy Rootenty v i@ | 7|10 — v|io | - v |io
s10
e
Galaxy Rootentiy v | 10 e io °
Si0
e
Galaxy Rootentiy v | 10 e io °

s10

Post

In order to generate materials from received products, simply select from the list those for which this operation is to be
performed. Then select the Generate associated material option. A screen will appear. Each line represents a received
product, and the following information must be given:

* Name of the material generated in GLPI
e Serial code
* Asset number

Note:

« If there is a template associated with the reference of the generated product, and if the latter is created in the
same entity as the reference, then the inventory object in GLPI will be created from this template.

* The financial information of the order will be carried in the newly created inventory object.
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13.6.6 Link to an inventory item

By o ? % 5 Qo O

Assets Assistance Administration
Home. Management  Orders  Orders + Q == & Root entity (tree structure)
Phone Device (Root entity) n
Order
® Assets Manufacturer Product reference
Order tem ; Phones ‘Samsung Electronics CoLid Galaxy 510 7)
Validation & |ctions
tem efivered
v D Reference Status Delivery date Associated items Serial number
Rssociated items
Vv e Galaxy S10 ey 20200120 No ssoted em
Bil
Actions x
Ticket
e e— Action|  Linkto an existing fem =
Notes prone v | iJPO%
Historical @
A

iLP19.4.5 Copyright (€) 2015-2019 Teclib'as
- 9.442.3 - Copyleft @ 2010-2019 by Fusioninventory

Team

It is possible not to generate a received product, but to link it to material already present in GLPI. To do this, you must

select the option Link to an existing material. A drop-down list will appear and will present all the materials present
in GLPI which :

* Are in the entity of the order (or in a sub-entity if the order is visible in the sub-entities)
¢ With the same type of equipment

* With the same type of equipment

* Identical

Once linked to a product, the material in GLPI will receive the financial information from the order.

13.7 Rights management

?2 % x Qo &

Assets Assistance Management
Wome  Admimistration  Profiles - 4 Q Root entity (tree structure)
K < Super-Admin o8 > bl
Profie
Orders
Assets
cdite Generate
Assistance Resd  Updste  Order Order  Takeitem Cancel order Selectunselect
Rewd  Updme  Creme Dol Pume [ UM DWe e oo T Gner o Sy
Life cycles validation
" Orders v vV vV v v v v v v v
anagement
Product
Toois s v
Adminstraton sits v v v v v
Selectunselect
Setp 5 v v v Vv v
Use
Save
File injection
orders
Tree view
tem's Lifeoycle
a
GLP19.4.5 Copyright (C) 2015.2010 Tecit' and contributors
Fusioninventory 9.442.3 - Copyleft @ 2010.2019 by Fusionlaventory Tearm

The plugin rights management allows to define, by profile, if the user has the right to :
* Manage commands
¢ Manage product references

* Manage invoices

112 Chapter 13. Order



GLPI plugins Documentation

e Confirm an order
¢ Cancel an order

* Modify a validated order

13.8 FAQ

If you have any questions about using the plugin, please consult our FAQ
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PDF

14.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud.

14.2 Install the plugin

* Go to the marketplace. Download and install the plugin PDF

Print to pdf

1l

>
217

14.3 Set up the plugin

e From Setup > General > Print to pdf, select :

— your preferred currency

— Any text that will be displayed on the PDF.

115



GLPI plugins Documentation

General setup
Choose your international currency EUR - Euro (€) ~
Default values
Assets

Assistance Text to add at the end of the PDF generation

Management

Logs purge
System B save
Security

API

Impact analysis

Historical

Print to pdf

All

14.4 Using the plugin

Note: Printing a contract and its related elements

* From Management > Contracts, select the contract you require
¢ From the Print pdf tab
¢ Click on Print

« < 20 Contract - Maintenant 10/5 & Entité racine m‘ i Actions v 212

Contract
Choose the tables to print in pdf: Contracts
Costs 1 .
© Contract Hcosts[{) Oitems () O bocuments OlLinks
Suppliers Notes () O Knowledge base O Tickets [ O Historical [EX)
Items. 1 Check all / Uncheck all Display (number of items) 20+ = Portrait
Documents
Links
Notes 1

Knowledge base

Tickets 21
Historical 21
All

(G2 &v-nc-H |
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G lpi Contracts - Maintenant 10/5 (Entité racine)

D1 Last update: 02-11-2022 08:37
Name: Maintenant 10/5 Status: Actif
Contract type: Maintenance GLPI Number:
Start date: 03-10-2022 Initial contract peried: 12 months -> 03-10-2023
Notice: 2 months -> 03-08-2023 Account number: 123456
Contract renewal period. 12 months Invoice period: 12 months
Renewal: Tacit Max number of items: 1
Commenis:
Cost
Name Begin date End date Budget Cost
Contract 01-08-2023 05-04-2024 Service client €15,000.00
Total cost €15,000.00
Note: 1
Contract by default
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FIFTEEN

SCCM

Download Sources

https://github.com/pluginsGLPI/sccm/releases  https://github.com/pluginsGLPI/sccm

15.1 Requirements for latest version

This plugin requires :
e PHP 7.2 or higher
GLPI>=94

¢ Fusionlnventory plugin for GLPI
SCCM >= 1802

* PHP curl_init and sqlsrv_connect
* Microsoft System Center Configuration Manager

¢ Microsoft Drivers for PHP for Microsoft SQL Server

Note: This plugin is available without a GLPI-Network subscription. It is not available in Cloud

15.2 Features

Plugin to synchronize computers from SCCM (version 1802) to GLPI (version 9.3 and 9.4). It uses the “FusionInventory
for GLPI” plugin and the power of its internal engine.
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15.3 Workflow

This plugin add two automatic actions : “SCCMCollect” et “SCCMPush”
The automatic action “SCCMCollect” queries the SCCM server with MsSQL queries.
This same action builds an XML foreach computer (in FusionInventory format).

The automatic action “SCCMPush” injects XML files into GLPI over HTTP(s) (via cURL and FusionInventory)
to display computer in GLPIL.

15.4 Schematic diagram

W2 LPI

Plugin SCCM

PC1
\

Requétes MSSQL / Injection fichier XML
format Fusioninventory

PC2
e \ B |
g L Plugin Fusioninventory
System Center
Moteur de liaison
- BDD GLPI d'entités, de lieux...
pc4

——
e’

15.5 Collected data

Depending on data availability in the SCCM server, foreach computer we collect:

Computer: name, last connected user, UUID, user login, domain, comments, serial
Operating system: name, architecture, version, service pack

BIOS information: tag, model, type, manufacturer, serial, install date, version

CPU: description (or name), manufacturer, frequency, type (arch), nb core, nb threads
Softwares: name, version, editor, install date

Memory (RAM): capacity, decription, frequency, type, bus, serial

Graphical card: name, chipset, memory
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¢ Sound card: name, manufacturer
¢ Network card: name, MAC address, IP address (v4, v6)

* Disk part: name, mount type, total size

15.6 Automatic actions

Home Setup Automatic actions Q
+ Items seen v
Display (number of items)
\I; Actions

Name Item type
SCCMCollect SCCM
SCCMPush SCCM

Name Item type

15.6.1 SCCMCollect

Action to collect data from SCCM to XML files.

15.6.2 SCCMPush

Action to push XML file to FusionInventory plugin
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SIXTEEN

TREEVIEW

Download Sources

https://github.com/pluginsGLPI/treeview/releases  https://github.com/pluginsGLPI/treeview

16.1 Requirements for latest version

16.2 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

16.3 Features

This plugin allows you to browse through your inventory via a tree view in a panel located on the left side of the screen.

You can browse the tree of your site to see the equipment.

16.4 Install the Plugin

* Uncompress the archive.
* Move the tag directory to the <GLPI_ROOT>/plugins directory
» Navigate to the Configuration > Plugins page,

* Install and activate the plugin.
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16.5 Usage

The plugin will create required tables in the database automatically. Those tables will be updated along with the plugin.

Plugin configuration is quite simple:

You will access the create form from the Setup > Plugins > treeview.

B oo ? % & S0 &

Assistance Management. ini i =

Home  Plugins Root entity (tree structure)

Display

22z 55§ F 2

Target for all node : on clic on node, redirect to new window
Nodes can be highlighted : highlight selcted node or not
Tree is drawn with lines : display or not

Tree is drawn with icons : Display or not icon for node

Only one node within a parent can be expanded at the same time : more tthan one parent node can be expand at
same time

Item name : name or inventory number or name + inventory number or inventory number + name

Location name : short name or long name or long name + comment or long name + comment
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SEVENTEEN

TAG

Download Sources

https://github.com/pluginsGLPI/tag/releases  https://github.com/pluginsGLPI/tag

17.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud.

17.2 Install the plugin

* Go to the marketplace. Download and install the plugin “Tag”.

‘> Tag

Ajout de tags sur n'importe quel
objet de GLPI

L

El GPLv2+
2, TECLIE
13 2117
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17.3 Setting up the plugin

* From Setup > Dropdowns
* Click on Tag management

e Then Tags

Tag Management

¥ Tags

@

 Enter a name that will be visible when tags are added
* Enter a description (optional)

¢ Add a colour

* Associate one or more elements. If nothing is ticked, it will not be visible in any element by default.

u New item - Tag

Name * viP

Deseription

HTML color 1

Associated item types |

Assets l

Monitors
Software
Network devices

Devices

Al None

+ Add

17.3.1 Choose where to find the tag

You can indicate whether the tag should be at the top or bottom of the list.
¢ From Setup > General > Tag management, specify the tag location.
Bottom :

Top:
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@ Ticket

Entity

Opening date

Type

Category

Status

Request source

Urgency

Impact

Priority

Location

Contract

Total duration

Approval request

Entité racine

Incident

® New

Helpdesk

Medium

Medium

Medium

v i *
2
v|i|4
v|i|4
v i + M

Tags

17.3. Setting up the plugin
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(© Ticket

Tags i
Entity  Entité racine +
Opening date &
Type Incident v
Category  ----- +
Status @ New v
Request source  Helpdesk +
Urgency = Medium v
Impact Medium v
Priority Medium v
Location = ----- m
Contract | ----- v

Total duration

Approval request
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17.4 Adding rules

You can add business rules (tickets, computers, etc.) to add tags to particular items.
Example : Assign a VIP tag when a member of the management group writes a ticket.

 Here are the criteria to be implemented from Administration > Rules > Business rules for tickets

@ Rule - VIP Tickets © Entité racine m‘ i Actions v 1224 >  »
Rule
Tags i
Name VIP Tickets Description
Logical operator and « Active Yes
Use rule for Add [ Update ~
Comments
P
Last update on 06-12-2023 15:53
Test
7 Delete permanently B Save
Criteria n
Add a new criterion
Criteria u
Add a new criterion
F Actions
Criteria
Criterion Condition Reason
Requester in group is Direction (Entité racine)
Criterion Condition Reason
Actions n
Itis possible to affect the result of a regular expression using the string #0
Add a new action
Actions
Fields Action type Value
Add tags Assign vIP
Fields Action type Value
 After creating a ticket :
Note: Tags can, of course, be added manually if they have been set to be visible in the specified item.
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17.5 FAQ

Tags m

Entity
Opening date
Type

Category

¥ Entité racine

06-12-2023 15:54:30

Incident

Business software

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
EIGHTEEN

UNINSTALL

Download Sources

https://github.com/pluginsGLPI/uninstall/releases  https://github.com/pluginsGLPI/uninstall

18.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: This plugin is available without a GLPI-Network subscription. It is also available in Cloud

18.2 Features

This plugin, named “uninstall” or “Item Uninstallation”, allows you to remove / replace devices from the inventory by
automating certain actions on the fields.

It allows to manage the different stages of the life cycle of a hardware. It has been designed, among other things, to
handle the following cases:

* scrapping of equipment
* removal from inventory of temporary equipment due to breakdown
* Replacement of equipment under a warranty for example (See: Replacement Equipment Feature)
Once installed, the plugin includes :
* arights management directly accessible from Administration -> Profiles (in the Plugins tab -> uninstall),
* a “hardware uninstall” menu in “Configuration”,

* an “uninstall” menu in the user preferences.
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18.3 Right managment

It is possible to deny access to the plugin or to allow it by specifying the read or write option on the templates.

To do this, simply go to the menu “Administration” > “Profiles”, to select the profile you wish to modify, then in the
“Uninstallation” tab set the following options :

* No access: the plugin does not appear in the menu ‘Plugin’.
* Playback: only the use of previously created templates is possible
» Writing: Template creation is possible.

* Hardware replacement: standard hardware replacement is possible

18.4 Uninstall feature

This functionality of the plugin ‘Item Uninstallation’ adds the possibility of modifying the value of certain fields and
of removing the inventory of a computer of the OCS base or the cleaning of the FusionInventory tables.

The uninstall templates can be accessed in the “Administration > Uninstall Hardware” menu.

You can create as many uninstall templates as you want. Each template can contain different features, and be visible in
the sub-entities or not.

Uninstall equipment is a transfer of the equipment to itself. During its transfer, a certain number of actions are per-
formed, as specified in the definition of transfer.

B oo ? k & Goo O

Home Administration Item's Lifecycle Templates + Q

& < Uninstall n

Erase datas
Yes Delete the whale history Yes v

Blank Altemate usemame Yes v

Blank Domain Yes v

Blank IP & Subnet mask & Gateway & Subnet

e
e

Yes v Blank Operating system Yes v
e

e Blark Budget Yes v
e

Blank Antirus

Delete computer

e Name: the name of the uninstall template

» Sub-entities: indicates whether the template is visible in the creation entity and its sub-entities

* Model type: indicates which type of model should be used (either Uninstall or Replace)

* Comments: free fields to add details about the model

* Transfer template to be used: Indicates the transfer template to be used when uninstalling the system.
* New hardware status: indicates which status the hardware should take once uninstalled

* New group: indicates the group to which the hardware can belong once uninstalled.
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* Software History Deletion : Allows deletion of all lines in a computer’s history that are relevant to software
installations/uninstallations.

* REMOVE Name : removes the name of the hardware during uninstallation

* RAZ Contact : removes the contact reassembled by OCS during uninstallation

* Network reset: resets the “network” field of the equipment record to zero.

* RAZ OS: Removes OS information (OS, Version, Service Pack, Product Key, Product ID) when uninstalling.

* RAZ domain : removes the “domain” field from the hardware

Remove IP & Gateway & Hacker & Subnet: removes network information (except for the MAC address, which
is hardware-related) during uninstallation

Remove the machine from OCS : when uninstalling a computer in GLPI, remove from the OCS base the corre-
sponding machine

* Delete Fusionlnventory info: Delete all FusionInventory info for this material

EY o 2 K 5 Qo0 ®

Home  Administration  Rules

plugin_uninstall

Name plugin_uninstall

Last update. 2020.01:24 0809 Comments

18.5 Uninstall hardware

There are 2 possibilities to uninstall a hardware:
e from its file, in the tab “Uninstallation”.
¢ from the massive modifications list

Since a template can be recursive (visible in the sub-entities), the list of templates displayed in the massive actions
indicates all the templates available in the current entity (either those defined in this entity, or in an entity above it and
visible in the sub-entities).
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18.5.1 Change of location on uninstallation

It is possible to change the location of the hardware once it has been uninstalled. This selection is made either :
¢ in the hardware file, once the uninstallation model has been chosen.
* from the user’s preferences for uninstallation by massive modification

It should be noted that a location is declared within an entity. It is therefore possible, depending on the current entity,
to define an uninstall location.

18.6 Replace feature

This feature of the ‘Item Uninstallation’ plugin adds the possibility to replace one hardware by another.

18.6.1 Replacement Model Form
Replacement models are managed in the same way as uninstall models: They are accessible in the menu “Administration
> Uninstall hardware”. Each model can contain different characteristics, and be visible in the sub-entities or not.
In this form there are 4 tabs :
e Main: allows to display on the page only the main information of the template.
» Replacing data: displays the various actions to be performed when replacing one piece of equipment with another.

» All: displays all the tabs on the same page

B oo ? kR D00 @

Replace 1 > b

nnnnnnnnnn

Delete permanently

Here is the description of the fields of the main tab :

Name: the name of the replacement model Sub-entities: indicates whether the template is visible in the creation entity
and its sub-entities Model type: indicates what type of model should be used (here we are talking about type - Re-
placement) Comments: free fields to add details about the model New hardware status: indicates which status the old
hardware should take once it has been replaced
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18.6.2 Replacing data tab

B oo ? k & Goo O

Home Administration Item's Lifecycle Templates + Q

Replace b > >

Informations replacement - General informations.
Copy Name
Copy Inventory number

Plugin PDF is not installed, to use PDF format for

Archiving metnod of the oid material

1t - Connections with other materials

Copy Documents

Copy Financial and ad
infor

Yes
Yes
Yes
Yes
Yes

Here is the description of the fields of the actions tab.
General Information
* Copy name: allows you to define if you want to copy the name of the old hardware to the new one.

* Copy the serial number: Allows you to define if you wish to copy the serial number of the old equipment to the
new one.

* Copy the inventory number: allows you to define if you want to copy the inventory number of the old equipment
to the new one.

* Overwrite information (from the old material to the new one): this option allows you to choose the behavior to
adopt if one of the unique information (Reservation, Financial Information, Name, Serial, Otherserial, Entity. . .)
is present in the old material AND in the new material : Yes : by selecting YES, the information in the old
material will replace that in the new material. No: by selecting NO, the information of the new hardware will
NEVER be overwritten by the information of the old hardware.

Method of archiving old material
In this option, we define the behavior that the uninstall plugin must adopt with the old hardware :

* Purge + PDF / CSV: if you have the PDF plugin the old hardware will be purged from the GLPI database and its
information will be attached to the new hardware in a PDF document. If you do not have the PDF plugin, they
will be stored in CSV format.

e Deletion + Comments: the old hardware is put in the trash and a comment is added in each of the two hardware
(“This hardware has been replaced by...” and “This hardware has replaced the hardware. ..”).

Data location - Connection with other hardware
* Copy Documents: Allows you to attach documents from old equipment to new equipment.
* Copy Contracts: allows you to attach the contracts from the old equipment to the new equipment.

* Copy financial information: allows you to attach financial information from the old equipment to the new equip-
ment. Warning: if the “Overwrite information” option is activated, even if the new hardware has financial infor-
mation, it will be replaced by the old hardware.

* Copy Reservations: Allows you to attach the reservations made on the old equipment to the new equipment.
Attention: same remark as for the financial information.
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* Copy the user: allows you to pass on the user of the old equipment to the new one. Caution: same remark as for
the financial information.

* Copy group: Allows you to assign the group of the old equipment to the new equipment. Caution: same remark
as for the financial information.

* Copy the tickets: Allows you to attach the tickets of the old equipment to the new equipment.

* Copy network connections: Allows you to transfer the network connections from the old hardware to the new
hardware.

e Copy direct connections: Allows you to transfer the direct connections (Monitor, Printer, Device, Phone) from
the old hardware to the new hardware.

18.7 Replace hardware

As well as uninstalling equipment, there are two ways to replace equipment:
* from the card of this one, in the tab “Plugins -> Uninstallation”,
¢ from the massive modification list.

Since a replacement template can be recursive (visible in the sub-entities), the list of templates displayed in the massive
actions indicates all the templates available in the current entity (either those defined in this entity, or in an entity above
it and visible in the sub-entities).

Once you have selected the hardware to be replaced via the massive actions, or you use the “Uninstall” tab directly in
it :
» asummary of the selected template appears in order to show you the actions that will be performed by the plugin.

* the list of the selected hardware(s) appears and you can choose the replacement hardware in the same way as
when you choose a hardware in a Support Ticket.

B o ? kR B0 @

Home  Administration

Copy Serial number

Empty location

aaaaaaa

FF§FFF

Choices for item to replace
old item Inventory number serial number New item

N Asset1234567890 140424s46501596 B
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18.7.1 Change of location on replacement

It is possible to change the location of the equipment once it has been replaced. This selection is made either :
* in the equipment sheet, once the replacement model has been chosen,
* from the user’s preferences for massive modification replacement.

Note that a location is declared within an entity. It is therefore possible, depending on the current entity, to define a
replacement location.

18.8 FAQ

If you have any questions about using the plugin, please consult our FAQ
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NINETEEN

ADVANCED DASHBOARDS

19.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A standard licence (or higher) is required. This plugin is also available from the Cloud.

19.2 Install the plugin

* Go to the marketplace. Download and install the “Advanced dashboard” plugin.

= advanceddashboard

& TECLIB

13 1

..,
e
3 [

2|

19.3 Setup the plugin

Warning: This plugin requires a minimum knowledge of SQL in order to be able to set certain criteria for the

various queries that will appear in the dashboards. It is also recommended that you know the structure of GLPI
tables.

19.3.1 Create an SQL query

The below example gives us the number of tickets on the root entity over the last 2 years:
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SELECT YEAR(t.date_creation) as 'Year', count(*) as 'Volume of tickets'
FROM glpi_tickets t
JOIN glpi_entities e on t.entities_id = e.id
WHERE e.completename LIKE "Root entity"
AND YEAR(t.date_creation) > YEAR(CURRENT_DATE()) - 5
GROUP BY YEAR(t.date_creation)

UNION
SELECT

CONCAT('Estimated total end ', YEAR(CCURRENT_DATE())),

ROUND (
(

SELECT count(*)
FROM glpi_tickets t4
JOIN glpi_entities e4 on t4.entities_id = e4.id

WHERE e4.completename LIKE "Entité racine" (root entity)

A N

AND YEAR(t4.date_creation) = YEAR(CURRENT_DATE()) - 1

SELECT count(*)
FROM glpi_tickets t3
JOIN glpi_entities e3 on t3.entities_id = e3.id
WHERE e3.completename LIKE "Root entity"
AND YEAR(t3.date_creation) = YEAR(CURRENT_DATE())

SELECT count(*)
FROM glpi_tickets t2
JOIN glpi_entities e2 on t2.entities_id = e2.id
WHERE e2.completename LIKE "Root entity"
AND YEAR(t2.date_creation) = (YEAR(CURRENT_DATE()) - 1)
AND (
MONTH(t2.date_creation) < MONTH(CURRENT_DATE())
OR MONTH(t2.date_creation) = MONTH(CURRENT_DATE()) AND DAY(t2.

—date_creation) <= DAY(CURRENT_DATE(Q))

)
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19.3.2 Setting query-related parameters

¢ From tools > SQL for dashboards, click on add

* Name your query (the one that will be visible from the dashboards) and identify it as active.

* Click on the floppy icon to save the query and then on play icon to run the query.

In the SQL Editor tab, paste the above query, taking care to change the name of the entity if you have changed it.

& 4 ? Question - Volume per year
Question B »lrs a
SAL Editor 1 SELECT YEAR(t.date_creation) as 'Year', count(*) as "Volume of tickets' FROM g
2 JOIN glpi_entities e on t.entities_id = e.id
Historical 2 3 WHERE e.completename LIKE "Entité racine”
4 AND YEAR(t.date creation) > YEAR(CURRENT DATE()) - 2
All 5 GROUP BY YEAR(t.date_creation)
6 UNION
7 SELECT
8 COMCAT( 'Estimated total end ', YEAR{CURRENT_DATE())),
9 ROUND(
10 L
An insert at the bottom will display the result of the query:
BB View results £ Set up fields = Preview
Year Volume of tickets
2022 12
2023 59
Estimated total end 2023 59

¢ In the set up fields tab, define the label, the number and the main label (optional, this is the name your table will
have). In our case, the label will be “year”, the number will be “number of tickets” and the main label will be

“r

number of tickets per year”.

* Select the type of graph (this is for information purposes only, so that you can preview your table; you will be
asked to select the type of graph you want to appear in the tile later),

* You can limit the amount of data to be displayed.

¢ Then click on Save fields and preview.

19.3.3 Dashboard settings

¢ From Assistance > Dashboard, select the dashboard that is to receive the new tile

* Click on edit icon

* Add a new tile with plus icon

* Select the query you have just created
* Choose a colour for your tile

* You will then be asked to select the chart type

19.3. Setup the plugin
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Fields

Label Year

Number Volume of tickets

Main label Number of tickets per year

Widget to use (only for preview tab)

Pie Donut Half pie
Half donut Bars Line

ﬁ [IllII /'/

AN

Horizontal bars | Multiple numbers
— O—-
Summary numbers Data table

HELH

Limit number of data

100 «

3 Save fields and preview
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Add a card

Background color = #d9ead3

volume

Advanced GLPI dashboard plugin

e Some

dashboards may ask you to use colours and display values and labels.

* Your tile is now ready

19.4 FAQ

If you have any questions about using the plugin, please consult our FAQ

19.4. FAQ
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Widget

Use gradient palette

Display value labels on
points/bars

Limit number of data

Pie

Half pie

&

Bars

ﬂln

Horizontal bars

A

W

Donut

Half donut

(R

Line

S
/

Multiple numbers

Summary numbers

HHHH

Data table

&) Update
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2022

Number of tickets per year

2023

Estimated total end 2023

19.4. FAQ
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CHAPTER
TWENTY

20.1 Requirements (on-premise)

GLPI Version

Minimum PHP Recommended

10.0.x

8.1 8.2

ANONYMIZE

Note: A basic licence (or higher) is required. This plugin is also available from the Cloud.

20.2 Install the plugin

* Go to the marketplace. Download and install the “Anonymize” plugin.

M

o &

13 -

-% Anonymize

» TECLIE

20.3 Choice of profile

Anonymisation works by profile. There are 4 profiles already created. When you select a profile, a certain amount of
data is already set. They can, of course, be modified.

* Go to Administration > Anonymization profile and select the profile best suited to your needs:

The 4 profiles you will find are :
* Email
* Entity
e Computer

e User profile
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***** v Items seen v contains -

naME <

Courriel
Entité
Ordinateur

Utilisateur

20 rows [ page

@ Home / (2 Administration / @ Anonymization profile

TYPE
UserEmail
Entity
Computer

User

Showing 1to 4 of 4 rows

DEFAULT

Yes

Yes

Yes

Yes

20.4 Anonymisable data per profile (predefined)

Each profile has an element assigned to it. You will need to define the value of each attribute that it will be able to

anonymise (or not)

=] @® Anonymization profile - Courriel i Actions v 1 > »
Anonymization profile

Name Courriel Itemtype Emails +
Historical
Al History No action ~ Default Yes ~

Attributes

users_id Keep »

is_default Replace by a set value

email Replace by a realistic random value ~

Global searches

Attributes to search and replace in others objects

@ Delete permanently @ save

20.4.1 Email

e users_id
* is_default

e email
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20.4.2 Entity

* name
o entities_id

* comment

* level

e sons_cache

e ancestors_cache

* address

* postcode

e town

* state

* country

* website

e phonenumber

* fax

* email

* admin_email

e admin_email_name

* from_email

* from_email_name

* noreply_email

* noreply_email_name

* replyto_email

* replyto_email_name

* notification_subject_tag
* ldap_dn

* tag

* authldaps_id

e mail_domain

* entity_ldapfilter

* mailing_signature

e cartridges_alert_repeat
* consumables_alert_repeat
* use_licenses_alert

e send_licenses_alert_before_delay

* use_certificates_alert
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* send_certificates_alert_before_delay
e certificates_alert_repeat_interval
* use_contracts_alert

e send_contracts_alert_before_delay
* use_infocoms_alert

* send_infocoms_alert_before_delay
* use_reservations_alert

e use_domains_alert
 send_domains_alert_close_expiries_delay
* send_domains_alert_expired_delay
* autoclose_delay

* autopurge_delay

* notclosed_delay

* calendars_strategy

e calendars_id

* auto_assign_mode

* tickettype

* max_closedate

* inquest_config

* inquest_rate

* inquest_delay

* inquest_URL

* autofill_warranty_date

* autofill_use_date

o autofill_buy_date

o autofill_delivery_date

* autofill_order_date

* tickettemplates_strategy

e tickettemplates_id

* changetemplates_strategy

* changetemplates_id

* problemtemplates_strategy

e problemtemplates_id

* entities_strategy_software

* entities_id_software

* default_contract_alert
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* default_infocom_alert

* default_cartridges_alarm_threshold
* default_consumables_alarm_threshold
¢ delay_send_emails

* is_notif_enable_default

* inquest_duration

e date_mod

¢ date_creation

* autofill_decommission_date
* suppliers_as_private

* anonymize_support_agents
* display_users_initials

* contracts_strategy_default
* contracts_id_default

e enable_custom_css

* custom_css_code

* latitude

¢ longitude

* altitude

* transfers_strategy

* transfers_id

e agent_base_url

20.4.3 Computer

* entities_id

* name

e serial

* otherserial

* contact

* contact_num

o users_id_tech
e groups_id_tech
e comment

e date_mod

* autoupdatesystems_id

e locations_id
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networks_id
computermodels_id
computertypes_id
template_name
manufacturers_id
users_id

groups_id

states_id

ticket_tco

uuid

date_creation
last_inventory_update

last_boot

20.4.4 User

name
password
password_last_update
phone

phone2

mobile

realname

firstname

locations_id

language

use_mode

Is_active

comment

auths_id

authtype

last_login

date_mod

date_sync

profiles_id

entities_id

usertitles_id
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usercategories_id
password_forget_token
password_forget_token_date
user_dn
personal_token
personal_token_date
api_token
api_token_date
cookie_token
cookie_token_date
isd_ldap

picture

begin_date

end_date

page_layout
fold_menu
fold_search
savedsearches_pinned
timeline_order
itil_layout
richtext_layout
date_creation
groups_id
users_id_supervisor
timezone
default_central_tab
nickname
timeline_action_btn_layout
timeline_date_format

use_flat_dropdowntree_on_search_result

20.4.

Anonymisable data per profile (predefined)
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20.5 Application strategy

Several strategies are available for each element field (e.g.Last name, First name, Serial number, Location, Status, etc.):
* Keep the value
* Delete the value
* Replace with a fixed value
* Replace with a standard random value

* Replace with a realistic random value

20.6 History

Each profile allows you to choose the treatment to be applied to the history of items:
* Do nothing
¢ Clean up values
* Clean up recent values and delete the rest

¢ Delete

20.7 Global search

You can ask GLPI to anoymise an attribute in the whole database and not only in the type of element you are in. The
option attributes to search and replace in others objects is at the very bottom of your profile.

Attributes to search and replace in others objects

Note: You cannot change any values other than those linked to the type of element you are in. For example, you will
be able to modify all email addresses in the database via the Email profile, but you will not be able to modify all user
phone number via this profile.

20.8 Applying the profile

Once you have completed your profile, you need to apply it. It can be applied using 2 methods:
* Massive action via the web interface (cloud and on-premise)

* In CLI (only on-premise)
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20.8.1 Mass action (Cloud and on-premise)

In our example, we will be anonymising user data.
* Go to Administration > Users. Select the user(s) you wish to anonymise.

* Click on Actions then anonymise selected items.

Note: “To be adapted If your profile concerns entities, go to Administration > Entities and repeat the operation for
the entities concerned. Do the same for computers, email, etc.

20.8.2 Via CLI (on-premise only)

* Go to your GLPI folder (/var/www/glpi or other depending on your configuration):

* Run all default profiles on all objects:

{$ php bin/console glpi:plugin:anonymize --all

* Run profile X on all objects / on one object:

$ php bin/console glpi:plugin:anonymize --profile=X
$ php bin/console glpi:plugin:anonymize --profile=X --item-id=X

Run default profile type X on all objects / on one object :

$ php bin/console glpi:plugin:anonymize --itemtype=X
$ php bin/console glpi:plugin:anonymize --itemtype=X --item-id=X

20.9 Creating a profile

You can create a profile to anonymise other data than that mentioned above.
* Go to Administration > Anonymisation profile
* Click on Add
* Name your profile
* Choose from the list of Element types (agent, domain, etc.)
* Select the treatment of the History
* Set the parameters for each field

Click on Add

Note: Remember to refer to the profile application section to apply your changes.
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20.10 Other anonymisable data (profile creation)

20.10.1 Agents

deviceid

entities_id

name

agenttypes_id

last_contact

version

locked

itemtype

items_id

useragent

tag

port

threads_networkdiscovery
threads_networkinventory
timeout_networkdiscovery
timeout_networkinventory
remote_addr
use_module_wake_on_lan
use_module_computer_inventory
use_module_esx_remote_inventory
use_module_remote_inventory
use_module_network_inventory
use_module_network_discovery
use_module_package_deployment

use_module_collect_data

20.10.2 Appliances

entities_id
Garder

name
appliancetypes_id
comment

locations_id
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manufacturers_id
applianceenvironments_id
users_id
users_id_tech
groups_id
groups_id_tech
date_mod
date_creation
states_id
externalidentifier
serial

otherserial
is_helpdesk_visible
pictures

contact

contact_num

20.10.3 Budgets

name
entities_id
comment
begin_date
end_date

value
template_name
date_mod
date_creation
locations_id

budgettypes_id

20.10. Other anonymisable data (profile creation)
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20.10.4 Cables

name
entities_id

itemtype_endpoint_a
itemtype_endpoint_b
items_id_endpoint_a

items_id_endpoint_b

socketmodels_id_endpoint_a

socketmodels_id_endpoint_b

sockets_id_endpoint_a
sockets_id_endpoint_b
cablestrands_id

color

otherserial

states_id
users_id_tech
cabletypes_id
comment

date_mod

date_creation

20.10.5 Changes

name
entities_id

status

content

date_mod

date

solvedate

closedate
time_to_resolve
users_id_recipient
users_id_lastupdater
urgency

impact
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priority
itilcategories_id
impactcontent
controlistcontent
rolloutplancontent
backoutplancontent
checklistcontent
global_validation
validation_percent
actiontime
begin_waiting_date
waiting_duration
close_delay_stat
solve_delay_stat
date_creation

locations_id

20.10.6 Certificates

name
serial

otherserial
entities_id
comment
template_name
certificatetypes_id
dns_name
dns_suffix
users_id_tech
groups_id_tech
locations_id
manufacturers_id
contact
contact_num
users_id
groups_id

is_autosign

20.10. Other anonymisable data (profile creation)
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date_expiration
states_id
command
certificate_request
certificate_item
date_creation

date_mod

20.10.7 Clusters

entities_id
name

uuid

version
users_id_tech
groups_id_tech
states_id
comment
clustertypes_id
autoupdatesystems_id
date_mod

date_creation

20.10.8 Contacts

name

* firstname

phone
phone2

mobile

* fax

email
contacttypes_id
comment
usertitles_id
address
postcode

town
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state

country
date_mod
date_creation

pictures

20.10.9 Databases

entities_id

name

size
databaseinstances_id
is_onbackup
Is_active
date_creation
date_mod
date_update

date_lastbackup

20.10.10 Datacenters

name
entities_id
locations_id
date_mod
date_creation

pictures

20.10.11 Server rooms

name
entities_id
locations_id
vis_cols
ViS_rows
blueprint
datacenters_id

date_mod

20.10. Other anonymisable data (profile creation)
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20.10.12 Documents

date_creation

name

e filename

* filepath

documentcategories_id

mime
date_mod
comment

link

users_id
tickets_id
shalsum
is_blacklisted
tag

date_creation

20.10.13 Domains

name
entities_id
domaintypes_id
date_expiration
date_domaincreation
users_id_tech
groups_id_tech
comment
template_name
Is_active

date_mod

date_creation
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20.10.14 Enclosures

name
entities_id
locations_id

serial

otherserial
enclosuremodels_id
users_id_tech
groups_id_tech
template_name
orientation
power_supplies
states_id

comment
manufacturers_id
date_mod

date_creation

20.10.15 Groups

entities_id
name

comment
ldap_field
ldap_value
ldap_group_dn
date_mod
groups_id

level
ancestors_cache
sons_cache
is_requester
is_watcher
is_assign
is_task

is_notify

20.10. Other anonymisable data (profile creation)
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is_itemgroup
is_usergroup
is_manager

date_creation

20.10.16 Knowledge base

name
answer

is_faq
users_id

view
date_creation
date_mod
begin_date

end_date

20.10.17 ITIL Categories

entities_id

itilcategories_id

name

comment

level
knowbaseitemcategories_id
users_id

groups_id

code

ancestors_cache
sons_cache
is_helpdeskvisible
tickettemplates_id_incident
tickettemplates_id_demand
changetemplates_id
problemtemplates_id
is_incident

is_request

is_problem
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is_change
date_mod

date_creation

20.10.18 Followups

itemtype
items_id

date

users_id
users_id_editor
content
is_private
requesttypes_id
date_mod
date_creation
timeline_position
sourceitems_id

sourceof _items_id

20.10.19 Followups templates

date_creation
date_mod
entities_id
name

content
requesttypes_id
is_private

comment

20.10.20 Solutions

itemtype

Keep

items_id
solutiontypes_id

solutiontype_name

20.10. Other anonymisable data (profile creation)
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content
date_creation
date_mod
date_approval
users_id

user_name
users_id_editor
users_id_approval
user_name_approval
status

itilfollowups_id

20.10.21 Lines

name
entities_id
caller_num
caller_name
users_id
groups_id
lineoperators_id
locations_id
states_id
linetypes_id
date_creation
date_mod

comment

20.10.22 Locations

entities_id

name
locations_id
comment

level
ancestors_cache
sons_cache

address
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postcode
town

state
country
building
room
latitude
longitude
altitude
date_mod

date_creation

20.10.23 Monitors

entities_id
name

date_mod
contact
contact_num
users_id_tech
groups_id_tech
comment

serial
otherserial

size

have_micro
have_speaker
have_subd
have_bnc
have_dvi
have_pivot
have_hdmi
have_displayport
locations_id
monitortypes_id
monitormodels_id

manufacturers_id

20.10. Other anonymisable data (profile creation)
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is_global
template_name
users_id

groups_id

states_id

ticket_tco
autoupdatesystems_id
uuid

date_creation

20.10.24 Network devices

entities_id

name

ram

serial

otherserial

contact

contact_num
users_id_tech
groups_id_tech
date_mod

comment

locations_id
networks_id
networkequipmenttypes_id
networkequipmentmodels_id
manufacturers_id
template_name
users_id

groups_id

states_id

ticket_tco

uuid

date_creation
autoupdatesystems_id

sysdescr
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cpu
uptime
last_inventory_update

snmpcredentials_id

20.10.25 PDUs

name
entities_id
locations_id
serial

otherserial
pdumodels_id
users_id_tech
groups_id_tech
template_name
states_id
comment
manufacturers_id
pdutypes_id
date_mod

date_creation

20.10.26 Projects

name
code

priority
entities_id
projects_id
projectstates_id
projecttypes_id
date

date_mod
users_id
groups_id
plan_start_date

plan_end_date

20.10. Other anonymisable data (profile creation)

169



GLPI plugins Documentation

20.10.27 Projects tasks

real_start_date
real_end_date
percent_done
auto_percent_done
show_on_global_gantt
content

comment
date_creation
projecttemplates_id

template_name

uuid

name

content

comment
entities_id
projects_id
projecttasks_id
date_creation
date_mod
plan_start_date
plan_end_date
real_start_date
real_end_date
planned_duration
effective_duration
projectstates_id
projecttasktypes_id
users_id
percent_done
auto_percent_done
is_milestone
projecttasktemplates_id

template_name
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20.10.28 Devices

* entities_id

* name

e date_mod

* contact

* contact_num

e users_id_tech

e groups_id_tech

e comment

e serial

* otherserial

* locations_id

* peripheraltypes_id
e peripheralmodels_id
* brand

* manufacturers_id
e is_global

* template_name

e users_id

* groups_id

o states_id

e ticket_tco

* autoupdatesystems_id
* uuid

e date_creation

20.10.29 Phones

* entities_id

* name

e date_mod

* contact

* contact_num

e users_id_tech
e groups_id_tech

* comment
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serial

otherserial
locations_id
phonetypes_id
phonemodels_id
brand
phonepowersupplies_id
number_line
have_headset
have_hp
manufacturers_id
is_global
template_name
users_id

groups_id

states_id

ticket_tco
autoupdatesystems_id
uuid

date_creation

last_inventory_update

20.10.30 Printers

entities_id
name
date_mod
contact
contact_num
users_id_tech
groups_id_tech
serial
otherserial
have_serial
have_parallel
have_usb

have_wifi
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* have_ethernet
e comment

* memory_size

locations_id
e networks_id

e printertypes_id

printermodels_id

manufacturers_id

is_global

* template_name

* init_pages_counter
* last_pages_counter
* users_id

e groups_id

states_id

ticket_tco
e uuid

e date_creation

sysdescr

last_inventory_update

snmpcredentials_id

autoupdatesystems_id

20.10.31 Problems

* name

e entities_id

e status

* content

* date_mod

* date

* solvedate

* closedate

e time_to_resolve

* users_id_recipient
* users_id_lastupdater

* urgency
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impact

priority
itilcategories_id
impactcontent
causecontent
symptomcontent
actiontime
begin_waiting_date
waiting_duration
close_delay_stat
solve_delay_stat
date_creation

locations_id

20.10.32 Racks

name
comment
entities_id
locations_id
serial

otherserial
rackmodels_id
manufacturers_id
racktypes_id
states_id
users_id_tech
groups_id_tech
width

height

depth
number_units
template_name
dcrooms_id
room_orientation
position

bgcolor
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max_power
mesured_power
max_weight
date_mod

date_creation

20.10.33 Rules

entities_id
sub_type
ranking
name
description
match
is_active
comment
date_mod
uuid
condition

date_creation

20.10.34 Saved searches

name
type

itemtype

users_id

is_private
entities_id

query
last_execution_time
do_count
last_execution_date

counter

20.10. Other anonymisable data (profile creation)
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20.10.35 Software

entities_id

name

comment
locations_id
users_id_tech
groups_id_tech
is_update
softwares_id
manufacturers_id
template_name
date_mod

users_id

groups_id
ticket_tco
is_helpdesk_visible
softwarecategories_id
is_valid
date_creation

pictures

20.10.36 Licenses

softwares_id
softwarelicenses_id
level

entities_id

number
softwarelicensetypes_id
name

serial

otherserial

softwareversions_id_buy

softwareversions_id_use

expire

comment
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date_mod
is_valid
date_creation
locations_id
users_id_tech
users_id
groups_id_tech
groups_id
is_helpdesk_visible
template_name
states_id
manufacturers_id
contact
contact_num
allow_overquota
pictures
ancestors_cache

sons_cache

20.10.37 Solutions templates

entities_id

name

content
solutiontypes_id
comment
date_mod

date_creation

20.10.38 Solutions types

name
comment
entities_id
date_mod

date_creation

20.10. Other anonymisable data (profile creation)
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20.10.39 Suppliers

20.10.40 Task categories

entities_id

name

suppliertypes_id

address
postcode
town

state

country
website
phonenumber

comment

ofa_x

email
date_mod
date_creation
Is_active

pictures

entities_id

taskcategories_id

name
comment

level

ancestors_cache

sons_cache

Is_active

is_helpdeskvisible

date_mod

date_creation

knowbaseitemcategories_id
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20.10.41 Task templates

* entities_id

* name

* content

* taskcategories_id
* actiontime

* comment

e date_mod

* date_creation
* state

* is_private

* users_id_tech

* groups_id_tech

20.10.42 Tickets

e entities_id

* name

* date

¢ closedate

* solvedate

* takeintoaccountdate
e date_mod

* users_id_lastupdater
* status

* users_id_recipient
* requesttypes_id

* content

* urgency

e impact

* priority

* itilcategories_id

* type

e global_validation

e slas_id_ttr

e slas_id_tto
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e slalevels_id_ttr

* time_to_resolve

* fime_to_own

e begin_waiting_date

e sla_waiting_duration

* ola_waiting_duration

e olas_id_tto

e olas_id_ttr

e olalevels_id_ttr

* ola_ttr_begin_date

e internal_time_to_resolve
e internal_time_to_own

* waiting_duration

* close_delay_stat

* solve_delay_stat

* takeintoaccount_delay_stat
* actiontime

e locations_id

* validation_percent

* date_creation

* ola_tto_begin_date

20.10.43 Ticket tasks

* uuid

* tickets_id

* taskcategories_id
* date

e users_id

* users_id_editor
* content

* is_private

* actiontime

* begin

e end

* state

e users_id_tech
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e groups_id_tech
* date_mod

e date_creation

* tasktemplates_id
* timeline_position
* sourceitems_id

* sourceof _items_id

20.10.44 Ticket templates

* name
e entities_id

* comment

20.11 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
TWENTYONE

APPROVAL BY MAIL

21.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: standard license (or higher) is required. This plugin is also available from the Cloud.

21.2 Install the plugin

* Go to the marketplace. Download and install the plugin ApprovalByMail.

Q Approval by mail
[ GPL v2 .

O [W

W

21.3 Using the plugin

Once activated, there are no specific settings to be made (apart from the notification layout, if you wish, via Setup >
Notifications > Notification templates. The template is Tickets validation)

* In a new ticket, enter the name of the person or group receiving the approval request.

An email will be received with the option of Validating or Refusing the request. This contains 3 links (if no changes
have been made to the model).

* The ticket reminder
* The acceptance link

¢ The refusal link
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Urgency  Medium W
Admin
A
Impact  Medium -
Ticket will be added in entity Entité racine ~

Priority Medium -
ation | ———- i+t m

Titie Location i
Replace PC Contract  -—--- -
Description * Total duration  --—-- -
Paragraph ~ B I A A = = = @ B 4 H <> I Approval request  User -
Admin v i

request to replace the PC for Mr. Dupont

2 Actors [
Requester
File(s) (20 Mio max) i
Drag and drop your file here, or
Choisir des fichiers ~ Aucun fichier n'a été sélectionné Observer

To answer by email, write above this line

An approval request has been submitted by Admin
Request: Comments :

URL:

Status of the approval request : Waiting for approval

* When the form is validated, you are redirected to GLPI with a notification of acceptance:

Your answer has been saved

* If the form is refused, a comment will be requested to validate the refusal:

* It is not possible to reply 2 times to the validation, an error message will be displayed:

21.4 FAQ

If you have any questions about using the plugin, please consult our FAQ
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Informations of Ticket - ID 86 (Entité racine) i

Requester

Opening date 04-12-2023 16:24:10 :::|
Category

Title Replace PC

Description Request 1o replace the PC for Mr. Dupont

A Please give a reason and click on refuse

Refuse

Approval request already answered
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CHAPTER
TWENTYTWO

BRANDING

22.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic licence (or higher) is required. This plugin is also available from the Cloud.

22.2 Install the plugin

¢ Go to the marketplace. Download and install the Branding plugin.

Brndng  Branding ©
& cprL vz 3
2\ TECLIB
13 1.4.0 S

22.3 Customize your instance

* Go to administration > entities > branding tab
Here you can replace :

* the logo at top left (including folded bar)

* the logo on the login page,

¢ the background of the login page,

¢ the icon in the browser bar

187


https://services.glpi-network.com/#offers
https://glpi-network.cloud/fr/

GLPI plugins Documentation

Custom logos

Top left corner logo

File(s) (20 Mio max) 1
Drag and drop your file here, or

Choisir un fichier Aucun fichier choisi

Top left corner logo (collapsed sidebar)

File(s) (20 Mio max) 1
Drag and drop your file here, or

Choisir un fichier =~ Aucun fichier choisi

Favicon

File(s) (20 Mio max) 1
Drag and drop your file here, or

Choisir un fichier Aucun fichier choisi

Login page logo

File(s) (20 Mio max) 1
Drag and drop your file here, or

Choisir un fichier Aucun fichier choisi

Login page background

File(s) (20 Mio max) 1
Drag and drop your file here, or

Choisir un fichier Aucun fichier choisi

Save

GLPI

GLPI
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22.4 Custom by entity

You can modify certain elements by entity:
* the logo at top left (including folded bar)

¢ the icon in the browser bar

Custom logos

Top left corner logo

File(s) (20 Mio max) 1
Drag and drop your file here, or

Choisir un fichier = Aucun fichier n‘a été sélectionné

Top left corner logo (collapsed sidebar)

File(s) (20 Mio max) 1
Drag and drop your file here, or

Choisir un fichier = Aucun fichier n‘a été sélectionné

Favicon

File(s) (20 Mio max) i
Drag and drop your file here, or

Choisir un fichier = Aucun fichier n‘a été sélectionné

Save

Other customisations are common to all entities

22.5 Recommendations

* Top Left corner logo - This can be changed according to the desired entity It is the logo you see when your

GLPI page is opened and the left sidebar is expanded

Default recommended size: 100x55 pixels

* Lop Left corner logo (collapsed sidebar) - This can be changed according to the desired entity It is the logo you

see when your GLPI page is opened and the left sidebar is collapsed.

Default recommended size 40x40 pixels

» Favicon It is the logo you see next to the page title at the beginning of your browser’s the tab.

22.4. Custom by entity
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Default recommended size: 16x16 or 32x32 pixels

* Login page logo It is the logo you see before you login. It appears with the fields to fill with your username and
password

Default recommended size: 220x130 pixels
* Login page background It is the image you can add as a background at the login page.

Default recommended size: It depends on the usual size of your screens. The bigger, the better. (Make sure not to
surpass the maximum upload limit for files)

22.6 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
TWENTYTHREE

COLLABORATIVE TOOLS

23.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic licence (or higher) is required. This plugin is also available on Cloud.

23.1.1 Install the plugin

* Go to the marketplace. Download and install the plugin Collaborative tools.

f\\g Collaborative tools

% GLPI Network )
Connecteurs outils collaboratifs

Ef GPL v2+
A TECLIB'
i3 123

23.1.2 Activate webhooks

* In the tab Setup > Notifications activate Webhooks notifications
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MNotifications configuration

Enable followup

Enable followups via email

Enable followups from browser

Enable webhooks notifications

E Save

23.1.3 Mattermost

From a Mattermost administrator account, go to the menu at the top left,

Then Integrations

Select Incoming Webhooks

Then Add a new incoming webhook.

Fill in the necessary fields and select the channel that will receive the notifications
Then click on Save.

You will then be sent the link to your Webhook:

23.1.4 Telegram

From Telegram, start a new chat with the bot @BotFather and run the following command /newbot
Answer the few questions you will be asked to set up your bot

Once finished, a token will be sent to you:

If you have already created a dedicated channel to receive GLPI notifications, add your bot to it.
Otherwise, create your own channel

add the newly created bot

Send a message in the channel created to initiate a conversation and generate the various IDs we will need.
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Canaux

GJ) Channels

Channels

Integrations

Download Apps

About Mattermost

o

Incoming Webhooks

Incoming Webhooks Add Incoming Webhook

Use incoming webhooks to connect external tools to Mattermost. Build Your Own or visit the App Directory to find
self-hosted, third-party apps and integrations.

MNa incoming webhooks found

23.1. Requirements (on-premise) 193



GLPI plugins Documentation

Incoming Webhooks

Title

Description

Add

GLPI notif

rincoming webhook

Channel

-—- Select a channel -

Lock to this channel

Username

Profile Picture

f set, the incoming webhook can post only to the selected channe
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Incoming Webhooks > Add

Setup Successful

Your incoming webhook is set up. Please send data to the following URL (details at Incoming Webhooks).

| URL: https://mattermost. att3jygadw EEll

Done! Congratulations on your new bot. You will find it at

_bot. You can now add a dEwCFI[_:tIC:l'I about
section and profile picture for your bot, see /help for a list of
commands. By the way, when you've finished creating your cool
bot, ping our Bot Support if you want a better username for it.
Just make sure the bot is fully operational before you do this.

Use this token to access the HTTP API:

Keep your token secure and store it safely, it can be used by
anyone to control your bot.

For a des crlptlc:n of Tl1e Bot API, see this page:

23.1.
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* From your browser, enter the following URL:
https://api.telegram.org/botmytoken/getupdates

Replace mytoken with the value of the token generated above

Note: Telegram bot URLs take the form https://api.telegram.org/bot{mytoken}

¢ You should see a similar result:

"ok": true,
"result": [
{
"update_id": 816584684,
"my_chat_member": {
"chat": {
"id": -541684658463,
"title": "GLPI Ticket",
"type": "channel"

e

"from": {
"id": 1546610935,
"is_bot": false,
"first_name": "xxxxxxx'",
"last_name": "xxxxxxx"

B

"new_chat_member": {

"user": {

"id": 7468746847,
"is_bot": true,
"first_name": "glpi",
"username": "xxxxxx_bot"

¢ In the my_chat_member copy the ID value of the chat.

Warning: The negative sign - must also be copied

23.1.5 Teams

* From a Teams administrator account, go to the channel that will receive GLPI notifications

Click on the channel menu
e Then Manage channel

¢ In the Connectors section,
¢ click on Modify

¢ From the incoming Webhook connector
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Teams

* Your teams

[l Channel notifications
Pin
Manage channel

1 Get email address

Get link to channel

2 Workflows

+ Moderation :annel
General Channel:
@ Anyone can post messages

alert that g will noti yone (recommended for

teams)

WNErs can p

+ Connectors
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¢ click on Configure

Connectors for "General” channel in "SerenIT” team

Keep your group current with content and updates from other services.

o, All Sort by: Popularity

Connectors for your team
MAMNAGE
0

Configured \:) I_ncumlng Webhm_:rk
Send data from a service to

My Accounts your Office 365 group in real
time.

* Enter a name for your webhook and an image (optional)
* Click on Create
* You will then be sent the URL of your webhook

23.1.6 Rocket

* You need to add an application to your team (the link is present in the bottom of the left sidebar) and select
incoming-webhook

* Add a new configuration, select the channel where you want notifications and you will get the webhook url.

* You can optionally setup a name and a logo for your hook.

23.1.7 Slack

e As alogged team administrator, go to the administration menu
* click on Integrations menu item

* Click on the New integration button

* Select incoming webhooks, and define webhook parameters

* After save, you will get the url of the webhook.
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Connectors for "General” channel in "SerenIT” team

@b" Incoming Webhook

The Incoming Webhook connector enables external services to notify you about
activities that you want to track. To use this connector, you'll need to create certain
settings on the other service, which needs to support a webhook that's compatible
with the Office 365 connector format.

Fields marked with * are mandatory

To set up an Incoming Webhook, provide a name and select Create. *

GLPI

Customize the image to associate with the data from this Incoming Webhook.

Upload Image
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Connectors for "General” channel in "SerenIT" team

ég Incoming Webhook

The Incoming Webhook connector enables external services to notify you about
activities that you want to track. To use this connector, you'll need to create certain
settings on the other service, which needs to support a webhook that's compatible
with the Offic i

Fields marked with * are mandatory

Enter a name for your IncomingWebhook connection. *

GLPI

Customize the image to associate with the data from this Incoming Webhool.

Upload Image

Copy the URL below to save it to the clipboard, then select Save. You'll need this
URL when you go to the service that you want to send data to your group.

https:/ /i webhook.office.comyfv n

Url is up-to-date.
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23.1.8 Set up the webhook in GLPI

» Fill in the requested information and select the channel on which you want the notifications to be sent.

* Once registered, a link will be sent to you. Copy this link and transfer it to Setup > Notifications > Configuration
of notifications by webhooks

* Click on + and enter :
— Webhook name,
— the type,
— the URL.

ENew item - Webhook = Entité racine

Name Comments

Mattermost - Ticke

Webhook type Webhook URL

Mattermost « https:f/mattermost.

Messages language

English

+ Add

¢ Click on Add

Warning: For Telegram, you will need to re-enter the webhook and add the chat_id you selected earlier

& < B € Webhook - Telegram - Ticket = Entité racine m‘ ! Actions v ‘ 212

Webhook

Name  Telegram - Ticket Comments

Historical 2

Translations

Webhook targets Webhook type  Telegram Webhook URL  https://api.telegram.org/bot6932879(

All Messages language  Francais ~

Additionnal parameters

Telegram channel identifier (chat_id) -541684658463

@ Delete permanently H‘ B save |

* You can test how it works by selecting your webhook and clicking on Send notification
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Webhooks notifications configuration

Webhook Mattermost - Ticket v | 1

Send a test notification

23.1.9 Recipients
* You now need to determine which notifications will be affected by the sending of a Webhook and assign them a
template.
* Go to Setup > Notifications > Notifications
* Select the 1st notification concerned by Webhooks (here New ticket)
* In the Recipients tab, add your Webhook then Update.

& < @ £ Notification - New Ticket © Entité racine m| EAC(IOHSV‘ 12/20 >  »

Notification .
Recipients
Templates 2
xAdministrator  xRequester xWatcher xProfile: Admin | xWebhook: Mattermost - Ticket ‘ Update
Recipients 5 -
Historical 2

Al

23.1.10 Templates

¢ In the tab Templates click Add a template
¢ Choose Webook in the Notification method and New in the Notification template

Your Webhook is ready to use. You can customise the template by clicking on New so that it matches your

requirements.
& < B £} Notification - New Ticket = Entité racine m‘ EAC(IOHSVI 12/20 > »
Notification
Add a template

Templates 2
Recipients 5 D Template Mode
Historical 3 2 Tickets Email
o 90 Webhook

D Template Mode
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23.1.11 FAQ

If you have any questions about using the plugin, please consult our FAQ
() R
(G2 &v-nc-H |
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CHAPTER
TWENTYFOUR

24.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended

10.0.x 8.1 8.2

GDPR TOOLS

Note: A basic license (or higher) is required. This plugin is also available from the Cloud

24.2 Install the plugin

* Go to the marketplace. Download and install the GDPR Tools plugin.

;= GDPR Toolkit

U ({

|~

£\ U

24.3 Configure the plugin

¢ From Setup > General > GDPR tools
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24.3.1 Cleaning up inactive users

There are two possible ways of managing inactive users:
¢ Clearing the user’s data

* Deleting the user

24.3.2 Cleaning up user data

When the plugin is configured in Clean mode, the following actions will be performed:
* Delete all references to the user from the GLPI history
* Delete all associated emails
* Reset all user fields and profiles

* Move the user to the recycle bin

24.3.3 Delete the user

When the plugin is configured in “Delete” mode, the following actions will be performed:
* Delete all references to the user from the GLPI history
* Delete all associated emails

¢ Delete the user

Warning: Deletion is permanent, the user cannot be recovered

24.3.4 Scope restriction

The automated deletion process can be restricted to the following scopes:
¢ All inactive users
* Inactive users with no current tickets

¢ Inactive users without tickets

24.3.5 Automated action

Deletion will take place via a standard GLPI automatic action that can be configured to run as often as you like.

* Go to Setup > Automatic actions, and select the cleaninactiveuser action then configure it according to your
needs.
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@ Home | & Setup / ¥ General

General setup
Default values
Assets
Assistance

Management

GDPR - Configuration

Mode

Name after cleanup

Clean ~ 1

Deleted user

Automatic action - Auto clean inactive users

Go to action configuration

Logs purge
Mode Inactive users with no tickets -
System
Security B save
API
Impact analysis
Historical
Holidays
GDPR Toolkit
All
& Automatic action - cleaninactiveuser
Automatic action
Name Gdpr - cleaninactiveuser
HEREE Description Clean or delete inactive users according to GDPR config
Loa
0gs Run frequency Each month ~
Historical 1
Status Disabled «
All
Run mode CLl »
Run period Dv > 24+
Number of days this action logs are stored 300 ~
Max user per execution 200

24.3. Configure the plugin
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24.4 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
TWENTYFIVE

GLPI Al

25.1 Requirements

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

* Open AI API key (free or paid plan) (https://platform.openai.com/api-keys)

* Open Al organization ID (https://platform.openai.com/account/organization)

Note: A basic license (or higher) is required. This plugin is not available from the Cloud.

25.2 Install the plugin

* Go to the marketplace. Download and install the GLPI AI plugin.

6‘9&; GLPI Al
Liuj # GLPI Network

Summary tickets timeline items.

£ 3

Ef GPL va+
2\, TECLIB
13 1.0
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25.3 Create an organization

After creating an OpenAl account, your can create an organization from your account settings under the Organization
tab or by accessing the page directly at https://platform.openai.com/account/organization.

Keep the Organization ID value, as you will need to insert it in the GLPI Al plugin configuration.

Playground
Assistants
! Threads

Fine-tuning
API keys
Storage
Usage

;J Settings
Organization
Team
Limits
Billing

Pro

Organization

Details

Organization name

Human-friendly label for your organization, shown in user interfaces
GLPI

Organization ID

Identifier for this organization sometimes used in APl requests

Features and capabilities

Threads

Threads page shows messages created with the Assistants APl and Playground.
Hidden
Visible to organization owners

Visible to everyone

Usage dashboard visibility

Usage dashboard shows activity and costs for your organization.
Visible to organization owners

Visible to everyone

Save
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25.4 Create a secret

* From this URL https://platform.openai.com/api-keys

¢ Click on Create a new secret

API keys

Your secret APl keys are listed below. Please note that we do not display your secret APl keys again after you generate them.

Do not share your API key with others, or expose it in the browser or other client-side code. In order to protect the security of your

Fine-tuning account, OpenAl may also automatically disable any APl key that we've found has leaked publicly.

e Enable tracking to see usage per APl key on the

Storage
You currently do not have any APl keys
Create one using the button below to get started

+ Create new secret key

Default organization

If you belong to multiple organizations, this setting controls which organization is used by default when making requests with the APl
keys above.

Personal

ich organization to use for eacl to learn more.

* Give a name to your secret

¢ Click on Create secret key

Create new secret key

Mame Optional

My GLPI Key

Permissions

Cancel Create secret key

Copy the secret value that is generated as you will need it later to configure the plugin.

[CD) &v-tic-H |
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Save your key

Please save this secret key somewhere safe and accessible. For security
reasons, you won't be able to view it again through your OpenAl account. If
you lose this secret key, you'll need to generate a new one.

dIXnH2 M ] , P Copy

Permissions

Read and write APl resources

25.5 Set up GLPI

* In GLPI, go to Setup > General > GLPI Al
* Fill in the fields with the values copied previously

* If your configuration is correct, you will be able to see your account entries, your consumption and your prefer-
ences.

25.6 Consumption

It is possible to limit the use of the API by specifying a limit that must not be exceeded. This plugin tracks usage based
on each response from OpenAl. Therefore, you may need to utilize the “Custom usage” field in the configuration to
account for usage outside of the plugin if you want the plugin to account for that in its usage limitation.

1. To limit usage and avoid overruns, specify a value that must not be exceeded. If this limit is exceeded, the plugin
will no longer function until this value is increased.

2. Enter the custom usage if you want to account for previous usage outside of the plugin.
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& Home / & Setup / ¥ General

General setup APl secrets

Default values OpenAl API Token © |

Your secret key

Assets -
OpenAl Organisation ID @ |

Your Organization ID

Assistance
Management
Logs purge
System
Security
Performance
API

Impact analysis
GLPI Network

Historical 345

GLPI Al

All

[ save

General setup APl secrets

Default values OpenAl APl Token @

Assets _—
OpenAl Organisation ID @

Assistance .
Profile

Management

Name
Logs purge

Email
System

Security Avatar

Performance Consumption

API

Impact analysis
Usage
GLPI Network
Usage limit (in $)

Historical 350

Set custom usage (in
GLPI Al ge (in )

Al Preferences

Response model

L P R TR T TR 1

SEsssssEEEIEBNENRREERERRERES 1

GLPI K

glpi e . W

@ See usage informations

0% 0/5% i

5,00

& Configure preferences

GPT-3.5 Turbo 16K v 1

® save

25.6. Consumption
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Consumption
Usage 0% 0f5% i
o Usage limit (in $) 5,00 :

e Set custom usage (in $) 0,00 : 1

Monthly Bill mars 1

$0.00

FF5.00 limit

Increase limit

Credit Grants USD

$0.00/ $5.00

RECEIVED  STATE BALANCE EXPIRES

Mar 06, 2024 Avrailable $500 /%500 JunO7 2024

Invoices

Mo invoices found.
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25.7 Preferences

In preferences, you can set up the response model. In Free mode, you can use the GPT-3.5 Turbo 16K model.

& Configure preferences

Response model = GPT-3.5 Turbo 18K + 1

Preferences

You can find information regarding the other plans and plan limits here
By clicking on Configure preferences, you can setup a context and a role.

* The Context can be a description of your company, your mission, your job in the company. Al needs to un-
derstand your context if it is to respond as pertinently as possible (there is a context by default that you can
change).

* The Role is how the Al should respond. Does it have a teaching, advisory or expert role? The role can influence
the tone and level of detail of the response (there is a role by default that you can change).

@ Home |/ 2& My settings
y g

Main Personalization Personal View  GLPI Al

Customized instructions

Context 1 As an expert support technician, your role is crucial to the
success of our users.Your mission is to expertly manage the
tasks requested by users,providing solutions with maximum
efficiency and precision. Aim for perfection in every response.

Role 1 Your tone should be informative and solution-oriented.Answer
in a non-technical way for lambda users at first,and in a
technical way for advanced users at a later stage.

Language
Response language  English v i
“ Back to plugin configuration & save
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25.8 Example

You can see an example of what can be achieved with an exchange that includes a lot of followups. The GLPI Al plugin
summarizes all of the followups to highlight the main information.

If you want another result, you can click on Refresh.
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CHAPTER
TWENTYSIX

HOLIDAYS

26.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic license (or higher) is required. This plugin is also available from the Cloud.

26.2 Install the plugin

* Go to the marketplace. Download and install the Holiday plugin.

" Holldays

£\ U

26.3 Set up the plugin

¢ From Setup > General, in the Holiday tab, enter :

The Country concerned

The Number of years to insert

Clean all previous holidays or not

Then click on Insert holiday dates

217


https://services.glpi-network.com/#offers
https://glpi-network.cloud/fr/

GLPI plugins Documentation

General setup
Default values
Assets
Assistance
Management
Logs purge
System
Security

APl

Impact analysis
Historical
Holidays

Al

Country: UnitedKingdom -

Number of years to insert: 20 «

Clean all previous holidays 7

Insert holidays dates
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26.4 Delete a holiday date/period

The list of holiday days can be viewed and modified
¢ From Setup > Dropdowns,

« enter Closing and click on Closing times

Calendar i

@

[ Close times

The list of days appears. Let’s assume that the company considers that Easter Monday is not a day off.
¢ In the search box, enter Easter then Search
* Select all the entries
¢ Click on Actions

* Delete permanently

26.5 FAQ

If you have any questions about using the plugin, please consult our FAQ
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TWENTYSEVEN

LDAP TOOLS

27.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic licence (or higher) is required. This plugin is also available from the Cloud.

27.2 Install the plugin

* Go to the marketplace. Download and install the plugin LDAP Tools.

Outils LDAP

S

2| U

27.3 Using the plugin

From tools > LDAP Tools, if you have synchronised LDAP directories, they will appear directly.
Each directory has a number of tests which may or may not be validated depending on your configuration:
e Flux TCP
* BaseDN
* LDAP URI
* Bind Auth

e Generic search
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G LP’ @ Home / & Tools / #ILDAP Tools / 3k LDAP Test a iﬁtﬁ?n‘:lzm

Find menu

LDAP directories Flux TCP BaseDN LDAP URI Bind auth Generic search Filtered search Attributes
TEST ¢ldap.glpi-test.eu (TCP/389) s} I} 50 entries § 50 entries § Oi
TEST ¢5dcO1.teclib.labo (TCP/389) é) 4] 550 entries § €350 entries § Di
Idap.google.com ldap.google.com (TCP/636) 4] (4] 1 entries § 1 entries § ai
TEST 2 410.4.5.1 (TCP/389) 4] (4] i Search error: {cn=*) <OFix previous! Fix previous!
Projects
TEST 3 9172.28.217.6 (TCP/389) (4] [4] i Search error: {cn=*) <Fix previous! Fix previous!
Reminders
TEST 4 ldap2.glpi-labo.eu (TCP/389) 0 (4] i Search error: {cn=*) <OFix previous! <OFix previous!
RSS feed 3
Bind user / password authentication is disabled, which
Knowledge base means your LDAP server allows anonymous requests, or
authenticates with a key. If it's voluntary, don't worry.
Reservations If the following tests are in error, you should check this

authentication! Maybe it's ultimately necessary ;)

Reports

Saved searches

) LDAP Tools

Setup

e Filtered search
e Attributes

As soon as one of the tests fails, the following tests will not be performed. You must start by correcting the 1st anomaly
before the other tests are run.
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CHAPTER
TWENTYEIGHT

MORE SATISFACTION

28.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic licence (or higher) is required. This plugin is also available on Cloud.

28.2 Install the plugin

* Go to the marketplace. Download and install the plugin More satisfaction

& More satisfaction
\;?f,,

More satisfaction

£

Ef GPL v2+
& Infotel
i* 162

28.3 Create a survey

* Once installed, go to Administration > Satisfaction survey

Click on Add

* Name your survey and set it as active
* Also remember to tick the sub-entity box if you want it to be available to all child entities

e Then click on Add
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. . , - . Super-Admi
@ Home / (2 Administration / @ Satisfaction survey Q A
. New item - Satisfaction survey © Entité racine m
Name Ticket stisfaction Comments
P
Active Yes
+ Add

Warning: It is only possible to create one survey per entity. If you wish to create several for different entities,
remember to position yourself in the appropriate entity and do not tick the sub-entity box

£ Root entity 8 child entities i

28.4 Create a question

 Enter your survey and go to the Question tab

Click on Add a question
* Select the type of question Yes/No and enter the text that suits you
Then click Add

B Satisfaction survey - Ticket satisfaction © Entité racine ‘ i Actions v n

Satisfaction survey

Add a question

Questions
Are you satisfied with the way your incident was handled?

Preview

Question :
Result Comments

P

Translations

Type Yes/Ne ~ %
Reminders

Add
Historical 1
Add a question

All

No questions for this survey

28.5 Create a text field

* In the question tab, click on Add a question
¢ Select the Text type
* Enter the text to be displayed and click Add
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Satisfaction survey - Ticket satisfaction = Entité racine m‘ i Actions v n

Satisfaction survey
’ Add a question
Questions 2
Do you have any additional comments on the processing of your request?

Preview
Question :

Result Comments
4

Translations
Type Text =

Reminders

Save
Historical 3

Add a question

All

28.6 Create a note

¢ In the question tab, click on Add a question
* select the Note type

* You can select a score up to 10 and set a default value

Click on “Add” when you are happy with your settings

(5] Satisfaction survey - Ticket satisfaction = Entité racine m‘ i Actions v n

Satisfaction survey

Add a question

Questions 2
How would you rate the overall processing of your application

Preview .
Question :

Result Comments
“

Translations
Type Note -

Reminders

Note on 5v Default value 3v
Historical 3

Al —

Add a question

28.7 Preview

The preview tab allows you to see what users will receive once their ticket has been closed

Satisfaction survey - Ticket satisfaction © Entité racine ‘ i Actions v n

Satisfaction survey
Are you satisfied with the way your incident was handled? No -
Questions 3
Preview
Result Do you have any additional comments on the processing of your request?
Translations
Reminders
How would you rate the overall processing of your application? i

Historical 4

All
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28.8 Translation

You can translate each of the questions asked in the questionnaire into the language of your choice
* Go to the Translations tab
* Choose the language you want and then, question by question, write the translation

& isfaction survey - Ticket satisfact < o [CYETY( ¢ Actonsv |

Satisfaction survey

Add a new translation

Questions 3
Preview
List of translations
Result
) Language  Question Value
Translations 3
T, Frangais Are you satisfied with the way your incident was handled? Etes-vous satisfait de la maniére dont votre incident a été traité ?
Historieal 5 Frangais Do you have any additional comments on the processing of your request? Avez-vous d'autres commentaires sur le traitement de votre demande ?
English How would you rate the overall processing of your application? Comment évaluez-vous le traitement global de votre demande ?

Al

28.9 Schedule reminders

In the event of a non-response to the survey, you can send out reminders to follow-up with the user. You can create
your own reminder or select a predefined one

28.9.1 Customised reminder

¢ Go to the Reminders tab
¢ Click on Add a reminder.
e Entera:

— Name

Type of duration (day or month)
— The duration of the reminder

— Activate your reminder

B Satisfaction survey - Ticket satisfaction © Entité racine ‘ i Actions v n
Satisfaction survey 5
! Add a reminder
Questions 3
reminder every 5 days|
Preview
Name
Result Comments
4
Translations 2
Duration Type Day ~ P
Reminders
Duration 5
Historical 10
Al Active Yes ~
save
Add a reminder
Add a predefined reminder
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28.9.2 Predefined reminder

* Go to the Reminders tab
¢ Click on Add a predefined reminder

* You will have 3 options to choose from:

Choose a predefined reminder

Predefined Reminders One Week «
Add
Two Week
Add a reminder
One Month

Add a predefined reminder

1 week: reminder every 7 days,

» 2 weeks: reminder every 14 days.
* 1 month: monthly reminder.

* Select the option that suits you and click on Add

28.9.3 Limit the number of reminders

¢ In the Setup maximum number of days to send reminder section, enter a limit for the Maximum number of
days to send a reminder
Example : If a person has not responded after 3 reminders, GLPI will no longer send reminders and the satisfaction

survey will then remain unanswered

B Satisfaction survey - Ticket satisfaction © Entité racine i Actions v n
Satisfaction survey Add a reminder
Add a predefined reminder
Questions 3
Preview Setup maximum number of days to send reminder
Result Maximum number of days to send reminder
Translations 3
Save
Reminders
Historical 12 . . i
Name Duration Type Duration Active

All

reminder every 5 days Day 5 Yes

28.10 Set up the automatic action

Survey reminders are sent via an automatic action already created by the plugin. Make sure that this is activated and
set up correctly
* Go to Setup > Automatic actions

¢ Select the SatisfactionReminder action.
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Automatic action
Statistics

Logs

Historical

All

29

{# Automatic action - SatisfactionReminder

Name

Description

Run frequency
Status

Run mode
Run period

Number of days this action logs are stored

Satisfaction - SatisfactionReminder

Send automaticaly survey reminders

Each day ~

Scheduled ~

CLl»

O« —> 24~

30 -

28.11 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
TWENTYNINE

OAUTH SSO

29.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic licence (or higher) is required. This plugin is also available from the Cloud.

29.2 External Authentication

The plugin uses GLPI's External Authentication functionality and to be functional, it needs some initial Setup.
* Go to Setup > Authentication > Other authentication methods
¢ In the Other authentication transmitted in the HTTP request section
 The Storage fields for the identifier in the HT TP request field must be defined, usually HTTP_AUTH_USER.

¢ The Delete the domain from identifiers of the form identifier @domain field can be set to Yes or No.

Note: In the case of authentication via SSO, the option Delete the domain of identifiers in the form identi-
fier @domain can be set to Yes, which will allow 2 user records to be merged if they are already present in the database
(internal or LDAP(S)).

Warning: Be careful because this option is subject to identity theft. If your application is open to users other than
your own, it is possible that one user could be merged with another. For example, john.doe@mondomaine.fr has
a namesake but a different email address john.doe @unautredomaine.fr. By deleting the domain, the 2 records
will be merged and the John Does will have the same account.

The users who are going to authenticate themselves will not be known to GLPI, so it is necessary to populate certain
fields to create their record in GLPI with a minimum of information.

The fields that can be retrieved by SSO are as follows:

* Last name : givenName
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¢ First name: familyName
* Email: email

¢ Email2: email2

* Telephone number: phone

¢ Mobile: mobile

Title: title

* Language: language

Other authentication sent in the HTTP request Enabled
Field storage of the login in the HTTP request HTTP_AUTH_USER v i +
SSO logout url
Remove the domain of logins like login@domain No ~
Surname givenName
First name familyname
Comments

Administrative number

Email email
Email 2 email2
Email 3 email3
Email 4 emaild
Phone phonenumber
Phone 2 phone2

Mobile phone mobile

Title title

Category
Language language
Save

» Save your Setup
You must also activate the automatic addition of users in GLPI to create them in GLPI at the time of authentication
¢ In the Setup > Authentication > Setup menu

* The Automatically add users from external authentication sources field must be changed to Yes

Authentication

Automatically add users from an external authentication source Yes ~ Add a user without accreditation from a LDAP directory Yes ~
Action when a user is deleted from the LDAP directory Preserve v Action when a user is restored in the LDAP directory Do nothing +
GLPI server time zone GMT ~

Save
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29.3 Fetch information from user profile option

You can choose if you want to retrieve informations from the user profile. In setup > Qauth SSO applications select
yes or no as required.

Important: If OAuth SSO is your only source of authentication AND provisioning, we recommend that you set
the Fetch information from user profile option to Yes so that user information can be fetched. Please note that claims
must also be set correctly on the provider side.

If you are using an external provisioning source such as SCIM, we recommend that you set the Fetch information
from user profile option to No so that user information is not overwritten and replaced by that of the OAuth SSO
plugin.

29.4 Entra

29.4.1 Register your application in Entra
First, register your application with your Entra Active Directory (Entra AD) client. This will provide you with an
application ID for your application and allow it to receive tokens.

* Connect to the Entra portal

* Choose your Entra AD tenant by selecting your account in the top right corner of the page. Then select the
Change directory navigation bar, then the desired tenant

* Skip this step if you only have one Entra AD tenant under your account or if you have already selected one

teclibgroup Se déconnecter

LR i

Afficher le compte

Changer de répertoire

| "Q"+ | Seconnecter avec un autre compte

¢ In the Entra Portal, search for and select Entra Active Directory
¢ From the left-hand Active Directory menu

¢ select Application Registrations
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e Then New Registration.

A Home
X Favorites

»  Azure Active Directory
@  overiew
R users
"B Groups
& Devices

B Applications

Enterprise applications

Home >

App registrations  # X

@ endpoints ¢? Troubleshooting () Refresh - Download [ Preview features 87 Got feadback?

@ Sterting June 30th, 2020 we will no longer add any new features to Azure A
longer provide feature updates. Applications will ned to be upgraded t

ry Authentication Li
hentication Library

{ADAL) and Azure AD Graph. We will confinue to provide technical support and security updates but we will no
and Microsoft Graph. Learn more

All applications ~ Owned applications  Deleted applications

 start typing a display name or application (dlient) ID o filter these r... ¢ Add filters

2 applications found

Display name T Application (client) ID Created on Ty Certificates & secrets

2/27/2023 @ current
6/6/2023 @ current

B Protect & secure ~
2} identity Governance ~
HB  External Identities v

- Show more v

* Enter web in the redirect URI and paste the return URL of your GLPI instance:

29.4.2 Secret and certificate

* In the certificates and secrets tab, create a new secret that will need to be transferred to your Oauth SSO appli-
cation on the GLPI side:

Warning: When you click on add, the secret will only be available once. As soon as you leave this page, the
secret will be hidden and we will no longer be able to access it. Remember to store it in a safe place as we will
need it later

Certificates () Client secrets (1) Federated credentials (0}

A secret string that the application uses to prove its identity when requesting a token. Also can be referred to as application password.

Mew client secret

Description Expires Value OO Secret ID

Oauth 550 7/4/2025 1t08Q r . [ | 9daldcds-3c2a-4fea- ]

29.4.3 Claims

Warning: If you are using SSO V2, an additional step is required. The claims on the Entra side must be entered
manually and should preferably be of type ID.

¢ In the Token configuration tab
* Click on Add an optional claim

¢ Add the 4 claims below:
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*Mame

Home > App registrations >

Register an application

The user-facing display name for this application (this can be changed later).

Cauth S50 - Azure V2

Supported account types

Help me choose..

Redirect URI (optional)

O Personal Microsoft accounts only

Who can use this application or access this API?

@ Accounts in this organizational directory only (T only - Single tenant)

O Accounts in any organizational directory (Any Azure AD directory - Multitenant)

O Accounts in any organizational directory (Any Azure AD directory - Multitenant) and personal Microsoft accounts (e.g. Skype, Xbox)

‘We'll return the authentication response to this URI after successfully authenticating the user. Providing this now is optional and it can be
changed later, but 2 value is required for most authentication scenarios.

|| web

v |I|| e.g. https://example.com/auth

0

iy proceeding, you agree to the Microsoft Platform Policies =

m New item - Oauth SSO application

Name

Active
leon on login page
Client secret ® W

Fetch information from user profile ?

Callback url

https://)

glpi-network. c\oud/mavkelp\zce/oau'l|¢—°

Comments.

Qauth provider

Client 1D

Field used as login 7

Show debug informations on failure

No ~

+ Add

29.4. Entra
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Home > App registrations > Oauth SSO - Azure V2

Oauth SSO - Azure V2 | Certificates & secrets =

A Search

i# overview
& Quickstart
7 Integration assistant
Manage
B2 Branding & properties

3 Authentication

Certificates & secrets

ill Token configuration
2 API permissions
& Expose an API

% App roles

&b Owners

&k, Roles and administrators

H Manifest
Support + Troubleshooting

f Troubleshooting

& New support request

LU Got feedback?

Credentials enable confidential applications to identify themselves to the aut
scheme). For a higher level of assurance, we recommend using a certificate (i

@ Application registration certificates, secrets and federated credentials can b

Certificates (0) Client secrets (0) Federated credentials (0)

A secret string that the application uses to prove its identity when requestir

Description Expires Va

No client secrets have been created for this application.

Add a client secret

Description

Expires

[ Oauth S5O I

[ 730 days (24 months) ~ I

B overview

Quickstart

| & PT‘" Got feedback?

Optional claims

Optional claims are used to configure additional information

o - -
# Integration assistant

Manage

3) Authentication

0 Some of the optional claims that you have configured are

Microsoft accounts.

Branding & properties

 Add optional claim =7

Certificates & secrets

I Token configuration

= AP| permissions

&b Expose an AP

App roles

A Owners

&t Roles and administrators

Manifest

Claim T

email

upn

family_name

given_name

Add groups claim
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29.4.4 API authorisations

GLPI must be able to read user information in order to use it for connection - In API permissions - Click on the API
already present (Microsoft Graph for our example)

Add a permission  ~ Grant admin consent for TECLIE

APl / Permissions name Type Description

~ Microsoft Graph (4)

emai Delegated  Wiew users' email address
offline_access Delegated  Maintain access to data you have given it access to
profile Delegated  Wiew users' basic profile
User.Read Delegated  Sign in and read user profile
Permission Admin consent required

~ Openld permissions (3)

- email )
No

View users' email address

offline_access ()
o i ) No
Maintain access to data you have given it access to

openid @

D . . Mo

Sign users in

- profile @

| o No
View users' basic profile

Select :
¢ email
* offline_access
e profile
¢ user.read

* Then remember to save your changes.
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29.4.5 Setup GLPI

* Entra AD provides a description with the essential information you need:

Home » App registrations >

g8 Oauth SSO - Azure V2 =

| L Search | & j Delete 6%'.9 Endpoints (2] Preview features
B o =
veniew ﬂ Got a second? We would love your feedback on Microsoft identity platform (previously Azure AD for developer). —
Quickstart
#" Integration assistant A Essentials
Manage Display name Cller“'..c.recler" 3
Oauth 550 - Azure V2 0 certificate,_1 secret

Branding & properties Application (client) ID

Redirect URIs
395dd420-9214-4110-84cc-5f02061f1881 1

1 0 spa, 0 public client

D Authentication

Object 1D Application ID URI

Certificates & secrets 94h6239-7631-4168-8d78-89f210d30903 Add an Application 1D URI

! on in local directory

Token configuration Managed app

Oauth S5O e V2
2 AP| permissions
& Expose an AP
 Specify an application name visible to end users.

E New item - Oauth SSO application

Name My account Comments

5
Active Yes ~ Oauth Prﬂv‘.der == Azure v
Icon onlogin page  Swindows - ClientID  395dd420-9a14-4110-84cc-5f0206111881

Client secret @® M sssesessssssssssrsnsasaransnsasasnnsnses Field used as login 2 User Principal Name (upn) -

TenantID ? 3c2ae83b-7e79-4bc8-8d80-5baf0f272030 Endpoint version ? v2.0 -

Fetch information from user profile 2 Yes ~ Show debug informations on failure  No

Callback url https:/[testing.with18.glpi-network.cloud/marketplace/oautlily

+ Add

Copy the values from the fields above:
* Application ID
* The holder ID

* The value of the secret copied in the previous step

Warning: Please check that the value of the secret is filled in correctly.If the ID of the secret is copied, your
application will fall into error.
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29.4.6 Explanation of ID field

¢ 3 values are available in this insert:

Field used as login ? User Principal Name (upn) a

Endpoint version ?
Azure user ID (oid)

informations on failure
) Email address (email), with fallback to "upn” if empty

1) User Principal Name (UPN): this option will show the full username of the user logging in
(nom.prenom @mondomaine.com for example). If you want only the username to be visible (without the @mon-
domaine.com, see the XXXXXXXXXX paragraph).

2) Entra user ID (OID): this option takes the object ID from the Entra AD. This ID will be used for the user login

User principal name collecteur-mail@ com [ Group membe... 3
Object ID d9zd
: D Applications
Created date time Oict 28, 2022, 3:45 PM
Assigned roles 0
User type Member
Identities Assigned licen... 0

3) Email address: This option specifies the user’s email address. This field will be used for the login. If it is empty,
the UPN will be used.

If you need to find your application in the Entra portal, select Application subscriptions, then Display all applications.

29.5 Google

29.5.1 Creating a project

* From your Google console (administrator access is required)
* Go to your organisation then new project

* Enter the name of your project

* Click on Create

* Return to your organisation,

* Select your project
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Project name *
[GAuthGLPI (7] ]

Project 1D: oauth-glpi-407811. It cannot be changed later. EDIT

Organization *
Select an organization to attach it to a project. This selection can't be changed later.
Location *
[ B i BROWSE ]

Parent organization or folder

CREATE CANCEL

Select a resource NEW PROJECT

D
oauth-glpi-407811
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29.5.2 Setup Oauth access

¢ From the menu, click on APIs & Services

¢ Then OAuth consent screen

L]
L]

1! Cloud overview >
=m Products & solutions >
PINNED PRODUCTS

Google Cloud Setup &

API  APIs & Services a >
B4 Billing a

© 1AM & Admin [ S
W Marketplace a

Enabled APIs & services
Library

Credentials

OAuth consent screen

Fage usage agreements

* Select the type of access that will be granted to the application (internal or external users)

¢ Then click on Create.

 Enter (as a minimum) a name for the application, an email address for application support and the developer’s

email address (this information is compulsory).
¢ Click on Save and continue.
¢ In the Scope section

¢ Click on Add or remove application fields

* Add auth/userinfo.email auth/userinfo.profile and openid

¢ Click on Update

¢ Then Save and continue

29.5. Google
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Choose how you want to configure and register your app, including your
target users. You can only associate one app with your project.

User Type
@® Internal @

Only available to users within your organization. You will not need to
submit your app for verification. Learn more about user type 2

() External @

Available to any test user with a Google Account. Your app will start in
testing mode and will only be available to users you add to the list of test
users. Once your app is ready to push to production, you may need to
verify your app. Learn more about user type[@

Let us know what you think about our QAuth experience
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X Update selected scopes

Only scopes for enabled APls are listed below. To add a missing scope to this screen, find and enable the
APl in the Google API Library or use the Pasted Scopes text box below. Refresh the page to see any new
APIs you enable from the Library.

= Filter Enter property name or value [ 7]
APL T Scope User-facing description
...fauth/userinfo See your primary Google Account email address
.email
...fauth/userinfo See your personal info, including any persenal info you've made
.profile publicly available
openid Associate you with your personal info on Google

Manually add scopes

If the scopes you would like to add do not appear in the table above, you can enter them here. Each scope should be on a
new line or separated by commas. Please provide the full scope string (beginning with "hittps://*). When you are finished,
click "Add to table”.

ADD TO TABLE

UPDATE
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29.5.3 ID settings

¢ From the Credentials menu
¢ Click on Create credentials

¢ Then Oauth client ID.

= Google Cloud e* OAuthGLPI w ‘ ‘ Search (/) for resources, docs, products, an

API APIs & Services Credentials |+ CREATE CREDENTIALS | B DELETE x~ RESTORE DELETED CREDENTIALS

APl key

«»  Enabled APIs & services i
M Create credentials to ac  |dentifies your project using a simple API key to check quota and access

o Library OAuth client ID
API Keys Requests user consent so your app can access the user's data
O+  Credentials -
O Name Service account
i OAuth consent screen No AP keys to displa Enables server-to-server, app-level authentication using robot accounts
S Page usage agreements Help me choose
OAuth 2.0 Client |  Asks a few questions to help you decide which type of credential to use
q P} yp
[J Name Creation date

No OAuth clients to display

Service Accounts

O Email Name

No service accounts to display

Select the type of application Web application

 Enter an application name

In the Authorized redirect URISs section

Enter the GLPI Callback URL

Tip: Where can I find my callback URL?

¢ Click on Create

* A page appears with the identifier values. Keep this information as it will be requested in GLPI.
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Services

OAuth client created

The client ID and secret can always be accessed from Credentials in APls &

OAuth access is restricted to users within your organization
unless the OAuth consent screen is published and verified

Client ID

Client secret

Creation date

Status

¥ DOWNLOAD JSON

aktnjkgOk1gse37.apps.go

ogleusercontent.com

Z2gqL3x7yNV
December 11, 2023 at 12:55:33 PM
GMT+1

& Enabled

0

O

0K

29.5. Google
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29.5.4 Setup GLPI

¢ From Setup > Oauth SSO applications

* Click on Add

* Select Google in the Oauth provider field

 Select the icon that will be visible on the home page

* Enter the Client ID (number 1 on the previous screenshot)

* Enter the Client secret (numbered 2 on the previous screenshot)

« Enter the field user ID'

m New item - Oauth SSO application

Name  Google SSO Comments
n
Active  Yes ~ Oauth provider (G Google ~
Icon on login page (3 google - o Client ID r13f3vakinjkgOKk1gse37.apps.goog
e Client secret @ Nl sesessrasesarasasssasssrasncasesnce Field used as login ? Email address (email) v
Fetch information from user profile ? Yes ~ Show debug infermations on failure  No  ~
Callback url  https://! glpi-network.cloud/marketplace/oauth”

+ Add

¢ Click on Add

From the home page, the new Oauth SSO login option will be visible:

GLPI

Connexion avec un fournisseur externe

Google S50

Connexion standard

GLPI Copyright (C) 2015-2023 Teclib' and contributors

! the identifier field will be the user’s login. Google user Id represents the unique value for each user generated when the user is created.
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Note: The first time a user logs on, they will be asked to accept access authorisations for their profile

(cc) R

29.6 OKTA

29.6.1 Create application

* First, go to GLPI and download the Oauthsso plugin
* Navigate to the Setup > Oauth SSO applications
* Click on Add

2 Home |/ & Setup / *) Oauth SSO applications | Q, Search || &, Setup

» Keep this window active and retain the callback URL :

m New item - Qauth SSO application

Name Comments
4
Active No Oauth provider === +
Icon on login page ~ ----- - Client ID
Client secret @ W Field used as login ?
Fetch information from user profile ? No ~ Show debug informations on failure No ~
Callback url | https:// .glpi-network. c\uum.’markclp\sccicaul\i

+ Add

* In your OKTA interface, go to Applications

¢ Create App Integration

¢ Select option OIDC — OpenID Connect in the 1st insert and Web Application in the second
* Click on Next

 Enter an application name and check the box Client credentials

* Enter the return URL, retrieved above, in Sign-in redirect URIs.
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okta
Dashboard -
Directary -
Customizations b
Applications -~
Applications
Salf Service
Socurity w
Workflow -
Raperts -
Sattings b

Q Search... @ BE

Applications

Create App Integration Browse App Catalog | Asslgn Users to App

Search
STATUS @ Okta Admin Consols
ACTIVE o
INACTIVE o @ Oicta Browser Plugin

| More =

fikna Dashboard

Create a new app integration

Sign-in method

Learn More 3

Application type

What kind of application are you trying to integrate
with Okta?

Specifying an application type customizes your

and sample recommendations.

OIDC - OpeniD Connect
Token-based OAuth 2.0 authentication for Single Sign-On (S50) through API
endpoints. Recommended if you intend to build a custom app integration with

the Okta Sign-In Widget.

SAML 2.0
XML-based open standard for SSO. Use if the Identity Provider for your
application only supports SAML.

SWA - Secure Web Authentication
Okta-specific 550 method. Use if your application doesn't support OIDC or
SAML.

API Services
Interact with Okta APls using the scoped OAuth 2.0 access tokens for
machine-to-machine authentication.

Web Application
Server-side applications where authentication and tokens are handled on the
server (for example, Go, Java, ASP.Net, Node.js, PHP)

experience and provides the best configuration, SDK,

Single-Page Application
Single-page web applications that run in the browser where the client receives

tokens (for example, Javascript, Angular, React, Vue)

Mative Application
Desktop or mobile applications that run natively on a device and redirect users

to a non-HTTP callback (for example, 105, Android, React Native)

Cancel MNext
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1 New Web App Integration

General Settings

App integration name GLPI
Logoe (Optiona [E] |?|
Grant type Client acting on behalf of itself

Clignt Credentials

Learn More 3

Client acting on behalf of a user
zat
Refresh Token

Implicit (hybrid)

Sign-in redirect URIs Allow wildcard * in sign-in URI redirect.

https:/f _ glpi-network.cloud/marketplace/oauthsso/fran ‘ x

Learn More 2 + Add URI
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29.6.2 Assignments

* In the last box, select the option that suits you best (here we authorize all users present in OKTA)

* Finally, click on Save

Assignments

Controlled access I © Allow everyone in your organization to access

Limit access to selected groups

Skip group assignment far now

29.6.3 Setup GLPI

* In GLPI, go back to the Oauth SSO plugin configuration window and enter your OKTA tenant information :

m New item - Oauth SSO application

Name | OKTA |o Comments
Active o Oauth provider e
Icon on login page  d~openid - ClientID | Ooa3x4utfrxDuLRrq697 | o
Client secret ® Ty | .............................. | e Field used as login ? | Email address (email) ,| °
Okta organization root URL | https:// -admin.okta.com/ | e Fetch information from user profile 2 No +
Callback url  https:/testing.withl

Show debug informations on failure  Yes

+ Add

1. Give your provider a name, which will appear on the login page.

2. Indicate this as active
3. Enter OKTA as provider Oauth
4. Enter the application ID found in the application previously created in OKTA
Client Credentials Edit
Client ID ODoa3x4utfrxDul Rrq697 B ‘
Public identifier for the client that is required for all QAuth

1. Specify the ID field to be mapped with OKTA
2. Specify the customer secret available in OKTA in the previously created application

7. Enter the name of your OKTA instance (https://XXXXXXXXX.okta.com), available in the account creation
confirmation e-mail.
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Generate new secret

Creation date Secret Status

Jan 23, 2023 PR R R RN E RN R E R o> =

¢ Click on Add

¢ In the plugin, you will see the approval message:

Veérification des données du fournisseur

v Adresse du document de déecouverte OpeniD
v Obtention des clés de signature

Now that the configuration is complete, you can test it with a user.

29.7 Keycloak

29.7.1 Create a REALM

* After installing keycloak, go to the admin console:
http://XXXXXXXXXX:8080/admin or https://XXXXXXXXXX:8080/admin

* Create your realm by clicking on master at the top left of your screen

* Then create Realm

* Give it a name that suits you

¢ Click on Create

29.7.2 Create user

* Then go to the Users tab

* Then Create new user (we’ll use a local user, but you can synchronize your LDAP if necessary)
 Create your user according to your needs, remembering to check the Email verified box

* Click on Create once you’'ve entered your details.

* Stay in your user file and click on Credentials
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GLPI

Connexion a votre compte Connexion avec un fournisseur externe
Identifiant
Mot de passe Mot de passe oublié ? LA

Source de connexion

Base interne GLPI -

Se souvenir de moi

Se connecter
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okta okta

ok e ke ok
Se connecter

Nom d'utilisateur Viérifier a I'aide de votre mot de passe

Mot de passe

Vérifier
Suivant

Maet Populsr Guertions

]

Rwcent Enérias

L]

Lant Upsated Entrien

@
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master

master

Create Realm

No users found

Change your search criteria or add a user

| Create new user
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Users > Create user

Create user

Username * Igor

Email igor@mondomaine.fr

Email verified © o© o

First name Igor

Last name | Rogi

Required user actions Select action -
@

Groups @ Join Groups

Create Cancel

¢ Then Set pasword

Users » User details

igor

Details Attributes - Role mapping Groups Consents Identity provider links Sessions

No credentials

This user does not have any credentials. You can set password for this user.

Set password ]

Credential Reset

 Configure the user password, taking care to indicate that the password is not temporary

¢ Click on save then Save password
You can check that your configuration is correct by logging on to the user account console:
http://XXXXXXXXXXX/realms/GLPI/account/#/ or https://XXXXXXXXXXX/realms/GLPI/account/#/
(Remember to adapt the realm name if you haven’t named it GLPI).

You will then be able to connect to the record of the previously created user or one of your LDAP users.
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Set password for igor X
Password * vens ®
Password confirmation ~* ®
Temporary © Off

Save Cancel

29.7.3 Create client

Now we can register our GLPI application with Keycloak
* Go to Clients

¢ Create client

Clients
Clients are applications and services that can request authentication of a user. Learn more [

Manage

) Clients list Initial access token
Clients

Client scopes Q, Search for client > I Create client Import client

* Give your application a client ID, which you’ll need to pass on to your GLPI Oauth SSO configuration

¢ Click on next and make sure on the next page that the standard flow and client authentication options are active
¢ Click on Save

Keep this page active, we’ll come back to it later.

254 Chapter 29. OAuth SSO



GLPI plugins Documentation

Client type @ OpenlD Connect
ClientIlD * @ glpi
Mame (&

Description (@

Always display in a Off

console (@

29.7.4 Setup GLPI

* Go to GLPI
¢ In Setup > Oauth SSO applications click on add (at the top of your screen)

& Accueil | & Configuration / =) Applications Oauth SSO ‘ Q, Rechercher H €\, Configuration

* Start by retrieving the return URL and pasting it into Keycloak’s valid redirect URISs field
* Back in GLPI’s Oauth SSO plugin configuration, fill in the required fields:

1. Give your provider a name, which will appear on the login page for users

Activate this plugin so that it is visible and usable on the login page

Choose Keycloak as your Oauth provider

Enter the client name set above

Retrieve client secret from Keycloak (client, client_name, credentials)

AN

Enter the discovery URL: http://mondomaine/realms/monrealms/.well-known/openid-configuration.
* Click on Add
In the plugin, to see the approval message:

Now that configuration is complete, you can test the connection with the user you created earlier, or with your LDAP
user.
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Mam

Actif Mon

lcone sur la page d'accueil  ----- .

Secret client

Récupérer les informations depuis le profil  Non -
utilisateur ?

Url de retour http:/192.168.1.50/marketplace/oauthssoffro nt.'autharizmid‘*
[

General Settings
ClientlD * @ glpi
Name (&

Description (3

Always display in 0 Of

console @

Access settings

Root URL @
Home URL @
Valid redirect URIs @ I httpf192.168.1.50/marketplace/oauthsso/front/autheorization.callback php ] -]
© Add valid redirect URIs
Heven
| Hom | Wayeiomt | 1
2 [ roomcssuronms - sovtok cpmcomect- @] 3
Ieone sar la page daccuall | 10 apphoaticn |client) gl
Saciet ellant | 3 Champ de Ndentitlae *  Adresss emal (e
OpaniD Endpoint Configuration UAL 7 e | B pdvur 1os intormations depuls o profl e
LElls Al
Wil los informations de ddbogage an cas  Non - Urlda retour  hitpu/I92.168.1 Shimarkeiplace/oauthesoontfauthodzatidlly
At
+ Mener
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Clients » Client details

gjpi OpenlD Connect

Clients are applications and services that can request authentication of a user.

Settings Keys Credentials Roles Client scopes Sessions Advanced
Client Authenticator Client Id and Secret hd
Save

Client secret e @ L] Regenerate

Verification des données du fournisseur

v/ Adresse du document de découverte OpeniD
v Obtention des clés de signature
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Connexion a votre compte Connexion avec un fournisseur externe
Identifiant
Mot de passe Mot de passe oublié ? Keycloak

Source de connexion

Base interne GLPI -

Se souvenir de moi

Se connecter

Sign in to your account

Username or email

igor

Password
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29.8 Rules for assigning authorisations

Remember that Oauth SSO authentication allows only authentication, in the sense that no user management is carried

out following authentication.

In most cases, it will therefore be necessary to establish rules for assigning authorisations to your users (to give them

a profile, for example).

¢ To do this, go to Administration > Rules > Rules for assigning authorisations to a user.

There are no ‘mandatory’ rules, it’s up to you to create the rule(s) that you feel best suit your needs according to your

available criteria.

For example, a very simple rule

* A very simple rule -> I want my users with SSO authentication to obtain the Self-Service profile.

So I set my criteria and my action :

Criteria n

Add a new criterion

Criteria

Criterion Condition

Reason

| Authentication type

Other

Criterion Condition

Actions n

It is possible to affect the result of a regular expression using the string #0

Add a new action

Actions

Fields Action type

Reason

Value

Profiles Assign Self-Service

Fields Action type

Value

29.8. Rules for assigning authorisations
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29.9 Forcing SSO authentication

Using the Oauth SSO application configuration, you can mask the internal database connection field to force the con-
nection with your SSO application

(setup > Oauth SSO applications > setup)

 Home / @ Setup / %) Oauth SSO applications [ EHIRl | Q Search || & setup

OAuthSSO configuration

Hide standard login form

GLPI

Connect with an external provider

Wt

29.10 Resources

* Documentation Oauth SSO client for GLPI
e Documentation Microsoft Configure your App Service Or Entra Functions app to use Entra AD login
* Documentation OKTA Configure single Sign-On options

* Documentation Keycloak Managing OpenlD connect Clients
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29.11 FAQ

If you have any questions about using the plugin, please consult our FAQ
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RENAME STRINGS

30.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic licence (or higher) is required. This plugin is also available from the Cloud

30.2 Download the plugin

* Go to Marketplace. Download and install the plugin Rename GLPI strings

Rename GLPI strings
A | % I ?

GPL V3 &
2\ TECLIB
2 117 %

2 @

30.3 Creating an override

* Go to Setup > Rename GLPI strings

* Click on Add and select the appropriate language.

¢ In the Override tab, click on New override.

* Select the value you wish to change from the drop-down list. You can search directly.
We are going to change the value Computer to PC

¢ Select computer and enter the singular and plural of the word to be changed in the corresponding fields.

¢ Click on Save
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@ Home | & Set~ ! PR Danama 10t ctrinee | BT & oo 11 & ticee

Add a new override

Language Computer »
Overrides
o Original string Override
Historical
one
All
Computer PC
other
Computers PCs

30.4 Show the change

You may not see the change immediately. To make it appear, log out and then log back in.

Before :
@ Assets
® Dashboard
0 Computers
After :

@ Assets

® Dashboard

0O PCs

30.5 FAQ

If you have any questions about using the plugin, please consult our FAQ
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SCIM

31.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic licence (or higher) is required. This plugin is also available from the Cloud.

SCIM

This plugin let you provision your users and groups from an external identity provider using the SCIM protocol. The
update from the directory to GLPI is done “just in time”. Each modification is done on the fly, without any cron. GLPI
is the service provider, and the directory is the identity provider.

Warning, the SCIM API endpoint provided by the plugin must be accessible from the identity provider. If we
talk about Azure or Okta, this particular url should be available from the internet. We suggest strongly to limit the ip
addresses that can access this url (in addition of adding a strong authentication method).

31.2 Setup

You must declare an identity server in the plugin configuration (You can add any number). Go to Setup > SCIM
Identity servers menu and click the [+ Add] button on top of the page.

Fill at least:
* The name of the server,
* the user applied on GLPI when receiving a request (this will identify the user in th GLPI logs),
¢ check the “Active” field,

¢ and submit by clicking the [+ Add] button at the bottom of the form.
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, Y. ) Super-Admin .
G LPI  Home / @ Setup / &* SCIM Identity servers B [ESEp T
= Find menu = S+ SCIM Identity server - test okta n
Assets .
SCIM Identity server
Assistance > SCIM configuration
Historical 430
Management I
Identity server name *  testokta Active
Tools
e e . Admin account used when  Delaunay Alexandre v i Save requests in logs *
updating GLPI data *
Setup
Default server

& Dropdowns
< Components PR

Notifications

Method *  Basic ~

Service levels

General Username  test

Fields Uniqueness Password @ I sees

Automatic actions

Authentication
SCIM APIURL
Receivers Paste it in your identity provider

External links http://[::1]/glpi/18.0.git/plugins/scin/index. php/

Plugins

SCIM Identity

.
servers B Delete Permanently Bsave

Created on 16-02-2023 09:59 Last update on 16-02-2023 14:11

You’ll be given an API url you may paste into your identity provider configuration. Check specific provider documen-
tation for more details.

You may set some optional parameters :
 Save requests in logs: if checked, all requests will be saved in the “Historical” tab of your declared server.
* Default server: if checked, this server will be used by default without providing it’s id in the API Utl.

¢ Security: a dropdown of available security methods. Currently implemented:

None: no security, anyone can access the APL.

Basic: HTTP Basic authentication. You must provide a username and a password.

Digest: HTTP Digest authentication. You must provide a username and a password.

Bearer: HTTP Bearer authentication. A long lived (10years) jwt token will be generated.

OAuth2: OAuth?2 authentication. You must provide at least a valid redirection uri. We support the following
flows:

* Authorization code.
* Client credentials.

Your SCIM server is now ready to receive requests from your identity provider.

31.3 Providers

e Azure

¢ Okta
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< C

JSON Données brutes

B https://5cac-88-167-232-29.eu.ngrokio/glpi/10.0.git/plugins/scim/index.php/Users

En-tétes

Enregistrer Copier Tout réduire Tout développer 7 Filtrer |2 JSOMN

w schemas:
a:
itemsPerrage:
startIndex:
totalresult:
totalresults:
¥ Resources:
v a:
w schemas:
:H
id:
externalid:
useriame:
displayMame:
v name:
familyName:
givenlame:
formatted:
active:
locale:
w profileurl:
title:
w emails:
L& :H
value:
primary:
phonetumbers:
v meta:
resourceType:
created:
lastmModified:
w lpcation:
v groups:
v a:
value:
display:
w gref:
w* 1:
w schemas:

a:

"urn:ietf:params:scim:api:messages:2.8:ListResponse”
lgg

1

128

934

"urn:ietf:params:scim:schemas:core:2,.8:User”
"353b2222-4f45-C04a5-888e-26417cTfd2ga”

-3

"crawfords4”

"volkman violet"

"volkman"
"violet"
"volkman violet"
true

"en_GB"

“http://[::1]/glpif1e.2.git/front/user.form. php?id=6"

"test@teclib.com”

true

[1

"user”
"2@15-@9-15 12:58:47"
"2@23-@2-18 15:18:85"

"http://[:i1]/glpisie.e.git/plugins/scim/index. php/Users /36300222 -4f46-54a6- 200 - 26417 7fd294"

"ge@dfele-2388-511f-8853-df fbf2fasvaa”

"erp_TousUtilisateurs™

“http://[::1]/glpi/fi@.@.git/plugins/scim/index. php/Groups/seadfele-2388-511f -8@53-df fof2faga7aa”

“urn:ietf:params:scim:schemas:core:2.2:User”

w2

31.3. Providers
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31.4 A Note about passwords sync

Although it’s mentioned in the SCIM specifications, password sync is not always available depending on the provider:
e Azure: not available

e QOkta: available

31.5 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
THIRTYTWO

SPLITCAT

32.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic licence (or higher) is required. This plugin is also available from the Cloud.

32.2 Download the plugin

* From the marketplace (Setup > Plugins), download the Splitcat plugin

@i Split categories

©
Ef GpL v2+ &
4 TECLIB'

1% 1.5.3

32.3 Settings

There are no special settings to be made for this plugin. You can see the effect of the plugin directly when you open a
new ticket.
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32.3.1 Before

32.3.2 After

32.4 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
THIRTYTHREE

TRANSLATE

33.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic licence (or higher) is required. This plugin is also available from the Cloud.

33.2 Introduction

The Translate plugin for GLPI is a handy tool designed to enhance multilingual communication within your GLPL
Leveraging DeepL’s translation technology, this plugin provides a simple and effective solution for translating elements
in the ticket timeline, fostering seamless collaboration within international teams.

Whether you’re managing projects with teams scattered worldwide or simply aiming to facilitate communication with
users in different languages, the Translate plugin streamlines the translation process within your GLPI instance.

33.3 Features

¢ Translate individual timeline elements

* Translate the entire ticket timeline

¢ Translate a follow-up during composition

 Restrict translation to specific languages

* Restrict translation to specific types of timeline elements
» API usage notification

* Translation rights management
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33.4 Requirements

* GLPI version 10.0.10 or higher
e DeepL API token

33.5 Operation

33.5.1 Translating an Element

Translation of a ticket element is done by activating the translation button located at the top right of the element. The
target language will correspond to the user’s preferred language.

- Created: (© 1 minutes ago by A glpi T

Connaisez-vous GLPI (Gestionnaire Libre de Parc Informatique) ?

Ipi

GLPI (sigle de Gestionnaire Libre de Parc Informatique)? est un logiciel libre de gestion des services informatiques
(ITSM) et de gestion des services d'assistance (issue tracking system et ServiceDesk). Cette solution libre est
éditée en PHP et distribuée sous licence GPL.

If the translation button does not appear, it may be due to various reasons:
* the plugin is not configured
* you do not have the right to translate
* your preferred language is not allowed in the configuration

* the element you want to translate is not allowed in the configuration
33.5.2 Undo Translation / Display Original Version
Once an element is translated, it will remain so until you request to undo the translation and display the original version.

Displaying the original version is done through the same button used to translate an element, located at the top right of
the element.
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. Created: @ 1 minutes ago by A glpi &

Do you know GLPI (Gestionnaire Libre de Parc Informatique)?

Glpi

GLPI(which stands for Gestionnaire Libre de Parc Informatique'? is an open-source software package for managing
IT services (ITSM) and support services(issue tracking system and ServiceDesk). This open-source solution is
written in PHP and distributed under the GPL licence.

33.5.3 Translate Entire Timeline

It is possible to translate the entire timeline at once. To do this, display the additional options menu at the bottom right,
next to the “Save” button. Then, click on “Translate all elements.”

Approval Not subject to approval

( Clone
. ¥ Merge as Followup -
ester + Add anitem
% gipi 0 @ Approval request §
@ Link project task
'rver
2d Add contract "
@ Link knowledgebase article
jned to

&\ Link to a problem
A glpi Q t
© Addadocument

%y Translate all elements
me M

5 @] : & Save
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33.5.4 Undo Translations / Display Original Versions of Entire Timeline

If all timeline elements are translated and you want to display their original versions, display the additional options
menu at the bottom right, next to the “Save” button. Then, click on “Undo translation of all elements.”

Approval Not subject to approval

(? Clone
tors €D ¥ Merge as Followup -
ester + Add anitem
% gipi 0 @ Approval request 4
@ Link project task
[rver
2d Add contract ‘
@ Link knowledgebase article
jned to

/N Link to a problem
A glpi O t

© Add adocument

% Untranslate all elements
me M

g @] : & Save

33.5.5 Translating a Follow-up during Writing

It is possible to translate a follow-up before it is sent. To do this, write your follow-up and click on the drop-down menu
at the top right of the follow-up editing window. Finally, select the language in which the follow-up’s content should

be translated.

Once your follow-up is translated, you can revert to the original text by selecting the “Original” option in the previous

language selection menu.

This feature is also available for tasks, validation requests, and solutions.
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Paragraph v B I A v # v aee

As a free technology, anyone can run, modify or develop the code,
which is free. As a result, contributors can participate in the evolution
of the software by submitting free and open source additional
modules on github.

GLPl is a web application that helps companies manage their
information systems. Among its features, this solution is capable of
building an inventory of all the company's resources and managing
administrative and financial tasks. The functionalities of this solution
help IT administrators to create a database of technical and
management resources, as well as a history of maintenance actions.
The helpdesk functionality provides users with a service enabling
them to report incidents or create asset or non-asset based requests
by creating a helpdesk "%,

File(s) (2 Mio max) 1
Drag and drop your file here, or

Parcourir... Aucun fichi...électionné.

+ Add

) Original
iy
Luau g
Suomi (FI)
&

Magyar (HU)
B Bahasa Indonesia (ID)
Italiano (IT)

Bz (JA)

If the translation menu does not appear, it may be due to various reasons:

¢ the plugin is not configured

* you do not have the right to translate

* the element you want to translate is not allowed in the configuration

33.5.6 Persistence of Translations

If an element is modified, old translations will be considered obsolete. When a user requests a translation,

a new translation will be performed for that element.

To reduce character consumption and improve plugin performance, translations are saved in the database. This approach
allows sharing translations among all users, avoiding the need to translate the same element multiple times in the same
language.

Translation requests from a user for an element are also saved, automatically displaying the translated version when
returning to a ticket’s timeline.

33.5. Operation
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33.6 DeepL API Key

The Translate plugin uses the DeepL translation service. For this, a DeepL. API key is required. DeepL offers two API
plans, a free plan (limited to 500,000 characters per month) and a paid plan (at €4.99/month + €0.00002/character).
Both plans are supported by the plugin.

33.6.1 Obtaining the API Key

1. Visit the DeepL website, “API” section (https://www.deepl.com/pro-api)
v

e Deepl Translator ,  DeepLPro  ForBusiness v Why DeepL? v APl Plansandpricing  Apps

Translate with DeepL API

Integrate the world's best machine translation technology directly into your own
products and platiorms.

== <>

Everything you need for translation in one place

©) © &

2. Select a plan

Best-in-class quality

Bild your products and applications with
DeepL's unbeatable translation accuracy
and qualiy.

A
Language detection

Benefit from DeepL API's language

e DeepL Translator n,  Deepl Pro

DeepL API Free

Get access to our Deepl REST API for FREE

without any risk

Free

Your current plan

DeepL API Free includes:
+ Access to all features

+ Access to the DeeplL REST API
/500,000 character limit/ month
1,000 glossaries (for specific languages)

+ Upgrade to Pro anytime

3. Log in or create an account

Document translation

Translate entire Word (.docx), PowerPoint
(:pptx), PDF (paf), text (xt), and HTML

Advanced data security (3

Enjoy world-leading data protection
standards and deletion of your texts

Formality

Choose the tone of your translations for
languages with formal/informal pronouns.

(-htm) files.

<>
Monthly cost control [EZ8 Handling XML

Easily imit your maximum monthly usage- Simply translate text that contains XML

immediately after translation.

APl documentation

Access our AP documentation at any time

For Business v Why DeepL? v APl Plansandpricing ~ Apps

v
Find the right plan for you

Can'tfind the right plan or have more questions?
Contact our Sales team or check out our Help Center.

. .
DeepL API Pro

DeeplL API for Business

Use our API without limits For large-scale, long-term API projects

€4.99 /month

+ Usage based price

Custom pricing available

Cancellable monthly

DeepL API Pro includes: Everything in DeepL API Pro, plus:

+ Maximum data security e}

<

Custom pricing available

' Access to the DeepL. REST API

<

Payment by invoice

+ No volume restrictions

<

Eligible for a Customer Success Manager

® 1,000 glossaries (for specific languages)  ©®

<

Eligible for onboarding planning and support
+ Cost control settings

v Pay as you go (€20.00 per 1,000,000

charactara)
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DeepL outperforms competitors
Create a new DeepL account

Already have an account? Please log in. ®
Email address

Password — —

Deep. translations are proven to be four times better
than the compeition, according to biind tests done by
professional translators.

/| Stay loggedin 2

By continuing, you create a Deepl account and agree 1o our Terms and Conditons. Find more
information on the right of withdrawal for consumers here and on the processing of your data here,

I addiion, we are allowed to email you about similar Deepl products and services. You can

unsubscribe at any time.

Privacy policy + Terms & Conditions

4. Enter your personal informations

Your selected plan

Address
DeepL API Free

Country

France Subscription fee
Max. 500,000 free
charactersimonth
Subscribing for a company?
First name Last name Deepl API Free allows you to translate up to 500,000

characters per month. If you want o translate more
you can upgrade to DeepL API Pro at any time.

Address line 1

DeepL outperforms competitors

Address line 2 (optional)

@

Postal code city

L
DeepL translations are proven to be four times better

Identity verification than the competition, according to blind tests done by

professional translators.
We need your credit card information in order to prevent misuse of our free API, in

particular to prevent fraudulent multiple registrations. Your credit card won't be charged
unless you manually upgrade to DeepL API Pro.

@ Credit card

Card number

Expiry date cve

Privacy policy + Terms & Conditions

5. Accept the terms of use and complete the registration

33.6. DeepL API Key
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®

2. Details

DeepL API Free
Conditions of your plan

Your subscription to DeepL API Free is completely free.
You can translate up to 500,000 characters per month

You can upgrade to Deepl. API Pro at any time.
Features of your plan

Access to Deepl REST API
Deepl translation quality

| laccept the Terms & Conditions, Service Specification, and confirm that | have read
and understood my Right of Withdrawal as a consumer.

/| Lwill not use DeepL Pro for the purpose of operating critical infrastructure (as outlined
in the Terms & Conditions) and acknowledge that, due o its nature, machine
translation may be imprecise. | agree that any integration of the DeepL AP will take
into account the potentiality of service interruption.

I'd like to receive email updates with helpful information such as Deepl best

practices, personalized content, and news items. It's possible to unsubscribe at any
time.

Back Sign up for free

Privacy policy + Terms & Conditions

6. Click on “Account management” to retrieve your API key

©

DeepL outperforms competitors

@

2 u
DeepL translations are proven to be four times better

than the competition, according to blind tests done by
professional translators.

Getting started with DeepL API Free

Retrieve your
Authentication Key
Account
management

Your DeepL API Free subscription is now active.

You will receive a confirnation email shortly. Please keep the following subscription

number for future reference.

Your subscription number: XXXXXXX

@ Englishv

9 DeeplL

Resources Product Download Company
Help Center Free translator DeepL for Android Contact Sales
Blog Features DeepL for ChromeOS Press

API documentation DeepL Pro DeepL for iPhone Careers
Accessibility Translation API Deepl for iPad Publisher
Data security Deepl Write DeepL for Mac

Privacy policy Deepl for Windows

Terms & Conditions

Deepl Chrome extension

Deepl Edge extension

yYOomoOE©

7. In the “Account” tab, retrieve your API key at the bottom of the page, in the “Authentication Key for DeepL API”

section
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e DeeplL Translator \, ~ DeepLPro  ForBusinessv  WhyDeepL? v APl Plansandpricing ~ Apps

Your DeepL account @

Plan Account Translation settings Usage

Account details

Login details and name Address
Email
Change
Change
Password
sscscsee
Change Language
French &
Change
Display / Team name
Not specified
Change
Identity verification
Change
Authentication Key for DeepL API
Use your Authentication Key to allow your applications to access the Deepl API. Please
make sure to keep your Key confidential.
XXXXXXXX-XXKX-XXXX-XXXX-XXXKKXXXXXXX:fx 0}
Create new Authentication Key
(1) Please make sure to use the right API domain: api-tree deepl.com
You can access the API Documentation here.
@ Englshv
e DeeplL Resources Product Download Company
Help Genter Free translator Deepl. for Android Contact Sales
Blog Features Deepl. for ChromeOS Press
API documentation Deepl Pro Deepl for iPhone Careers
Accessibilty Translation API Deepl. for iPad Publisher
Data security Deepl. Write Deepl. for Mac
Privacy policy Deepl for Windows
Terms & Conditions Deepl Chrome extension

Deepl. Edge extension

yomoE

33.7 Configuration

33.7.1 Initial Configuration

After installing the plugin, it is necessary to enter a DeepL API key.
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@ Home / @ Setup | 1 General Q

General setup Configuration Deepl

Default values Deepl API Token  XXXXXXXX-XXXXXOXXX-XXX-XO00KXKXXKE 1

Assets
® Save
Assistance
Management
Logs purge
System
Security

Performance

API

B Service I

Impact analysis
# General

GLPI Network
Historical

Translate
& Authentication
All

& Recel

33.7.2 Consumption Configuration

Some configuration options are only available if the API key is linked to the paid plan.

Usage

This progress bar allows you to monitor character consumption at the API level.

Allow Exceeding Limit

Allows setting or not setting a monthly limit on character consumption.
> This option is limited to the paid DeepL API plan.
Usage Limit
Allows setting the type of limitation:

* Characters: Limits usage to the number of characters

* Cost: Limits usage to cost

This option is limited to the paid DeepL API plan.
Per Characters / Per Cost
Allows setting the consumption limit corresponding to the type defined above.
For usage limited by cost, monthly subscription fees are not included.

This option is limited to the paid DeepL. API plan.

e structure) .

Super-Admin
Root entity (iree struc
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Maximum Number of Characters Translated per Translation

Allows setting a maximum number of characters translated at once. This configuration is important and filters out
overly large and resource-consuming elements for the API.

33.7.3 Notification Configuration

Enable API Usage Notifications

Allows enabling API usage notifications. Once enabled, alert thresholds are configurable using the “Usage Threshold”
fields. Default value: Yes

Usage Threshold

This option allows setting usage alert thresholds. Requires enabling the “Enable API Usage Notifications” option.
Default values: 25%, 50%, 75%, 100%

33.7.4 User Configuration

Allowed Target Languages for All Users

Defines the languages in which elements can be translated by all users.
Default values: Languages proposed by DeepL.

Allowed Translatable Elements for All Users

Defines the elements that can be translated by all users.
Default values: Ticket, Follow-up, Ticket Task, Solution, Validation Request

33.8 Rights

33.8.1 Allow translation of displayed elements (language configured in prefer-
ences)

This right defines whether a profile can translate timeline elements of a ticket (Ticket, Follow-up, Task, Solution,
Validation Request).
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33.8.2 Allow translation while writing

This right defines whether a profile can translate the content of a follow-up before sending.

33.9 FAQ

If you have any questions about using the plugin, please consult our FAQ
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CHAPTER
THIRTYFOUR

UNREAD MESSAGES

34.1 Requirements (on-premise)

GLPI Version Minimum PHP Recommended
10.0.x 8.1 8.2

Note: A basic licence (or higher) is required. This plugin is also available on Cloud.

34.2 Install the plugin

* Go to the marketplace. Download and install the plugin Unread messages.

Q Unread messages ©

# GLPI Network 5
Unread messages GLPI plugin. &)

El cpL v2+
A TECLIB'
i* 100

34.3 Setting up the plugin

¢ Go to Administration > Entities, unread messages tab

There are 3 possible settings:

283


https://services.glpi-network.com/#offers
https://glpi-network.cloud/fr/

GLPI plugins Documentation

Operation Effect

Disabled The plugin will remain inactive

Per user Users with the self-service profile will be notified of tickets for which they are the requestor.

helpdesk;share Technicians, for their part, will share the notifications. If a notification is read, it will be marked

central as read for all other technicians

Per user Each user will have access to their own queue of notifications, including those for their group and
their individual assignments

34.4 Display notifications

34.4.1 Header

When a new activity has not yet been viewed, a bell icon appears:

© Home / 63 Assistance | @ Tickets  [JEIRG | Q: Search |[ ¥ Lists ][ &2 Templates || 0 Global Kanban || @ Tickets waiting for your approva | Q SuR e . AD
35 °g N 2 820 = 2 7 . o @
Tickets Incoming tickets. Pending tickets Assigned tickets Solved tickets Closed tickets
8 v Characteristics - Status ~ is b Not solved ~
@ global rule Ssearch | %+ ©
o oa a0
D TITLE ENTITY STATUS LAST UPDATE ¥ 'OPENING DATE PRIORITY e EEE s CATEGORY U
ReQUESTER TeCHNICIAN ResoLve
2023022225 Phprinter * Raot entity O Processing (assigned) 19-12-2023 15554 19-12-2023 15:53 Medium  lgor i admin i Logiciel -
Métiers

34.4.2 Listed

Unread messages on a ticket highlight the ticket concerned and a red indicator :

© Home / 63 Assistance | @ Tickets  [JEIRG | O Search |[ ¥ Lists ][ & Templates || @ Global Kanban || @ Tickets waiting for your approval | Q Qe SURerAd e [AD

]
(©]
&

35 °H 8 2 8 20 = 2 N7

Tickets Incoming tickets Pending tickets Assigned tickets Solved tickets Closed tickets

B . Characteristics - Status  is +  Not solved -

mea) o 0

B ©a & B

0 TITLE ENTITY STATUS LAST UPDATE ¥ OPENING DATE PRIORITY LIRS ASSIGNEDTO - TmETo

CATEGORY
REQUESTER TECHNICIAN RESOLVE

2023022 225 Root entity O Processing (assigned) 19-12-2023 15:54  19-12-2023 15:53 Medium  Igor i admin Logiciel -
Métiers
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34.4.3 Ticket timeline

New messages will be identified by a banner New messages.

(=] O Pb printer (2023022225)
Ticket 1
AD Created: ® 12 minutes ago by & admin  Last updste:® 11 minutes aga by 2 Igor

Statistics

Pb printer
Approvals
Knowledge base Hello,
Items The printer in my office no longer works. An error message is displayed (ERR_01)
Costs Thanks for you help
Projects Best regards

Project tasks

Problems
MESSAGE
Changes
Contracts IG Created: ® 11 minutes ago by 2 Igor
Historical 7 a reboot changed nothing
statut D Helpdesk
Al

© Ticket

Entity
Opening date
Type

Category
Status

Request source
Urgency
Impact

Priority
Location

Approval

2 Actors (B

Requester

® Slgor & 5

» Root entity
19-12-2023 15:53:00
Incident

Logiciel - Métiers

O Processing (assigned)
Helpdesk

Medium

Medium

Medium

Not subject to approval

Y20 > »
~
]
v|il4
v|il4
i+ m
~
+

34.4.4 Management by entity

Management by entity is possible to manage the counting of notifications by entity.

* Go to Administration > Entities, and select the desired entity.

* In the Unread messages tab, select the option that suits you so that unread messages behave differently to the

parent entity.

34.5 FAQ

If you have any questions about using the plugin, please consult our FAQ

34.5. FAQ
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& < o < Entity - Client 1
Entity " "
Unread messages configuration
Entities
Unread messages mode ?
Address

Advanced information
Notifications

Assistance

Assets

Ul customization

Users 1
Rules

Documents

Notes

Knowledge base

Historical 2

Unread messages

All

Inheritance of the parent entity - 1 Peruser

Save
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